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Introduction to mikroC PRO for PIC The mikroC PRO for PIC is a powerful, feature-rich development tool for PIC microcontrollers. It is designed to provide the programmer with the easiest possible solution to developing applications for embedded systems, without compromising performance or control.
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mikroC PRO for PIC IDE PIC and C fit together well: PIC is the most popular 8-bit chip in the world, used in a wide variety of applications, and C, prized for its efficiency, is the natural choice for developing embedded systems. mikroC PRO for PIC provides a successful match featuring highly advanced IDE, ANSI compliant compiler, broad set of hardware libraries, comprehensive documentation, and plenty of ready-to-run examples.



Features mikroC PRO for PIC allows you to quickly develop and deploy complex applications:  Write your C source code using the built-in Code Editor (Code and Parameter Assistants, Code Folding, Syntax Highlighting, Auto Correct, Code Templates, and more.)  Use included mikroC PRO for PIC libraries to dramatically speed up the devel opment: data acquisition, memory, displays, conversions, communication etc.  Monitor your program structure, variables, and functions in the Code Explorer.  Generate commented, human-readable assembly, and standard HEX compati ble with all programmers.  Use the integrated mikroICD (In-Circuit Debugger) Real-Time debugging tool to
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monitor program execution on the hardware level.  Inspect program flow and debug executable logic with the integrated Software Simulator.  Get detailed reports and graphs: RAM and ROM map, code statistics, assembly listing, calling tree, and more.  mikroC PRO for PIC provides plenty of examples to expand, develop, and use as building bricks in your projects. Copy them entirely if you deem fit – that’s why we included them with the compiler.



Where to Start  In case that you’re a beginner in programming PIC microcontrollers, read care fully the PIC Specifics chapter. It might give you some useful pointers on PIC constraints, code portability, and good programming practices.  If you are experienced in C programming, you will probably want to consult mikroC PRO for PIC Specifics first. For language issues, you can always refer to the comprehensive Language Reference. A complete list of included libraries is available at mikroC PRO for PIC Libraries.  If you are not very experienced in C programming, don’t panic! mikroC PRO for PIC provides plenty of examples making it easy for you to go quickly. We sug gest that you first consult Projects and Source Files, and then start browsing the examples that you're the most interested in.
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MIKROELEKTRONIKA ASSOCIATES LICENSE STATEMENT AND LIMITED WARRANTY IMPORTANT - READ CAREFULLY This license statement and limited warranty constitute a legal agreement (“License Agreement”) between you (either as an individual or a single entity) and mikroElektronika (“mikroElektronika Associates”) for software product (“Software”) identified above, including any software, media, and accompanying on-line or printed documentation. BY INSTALLING, COPYING, OR OTHERWISE USING SOFTWARE, YOU AGREE TO BE BOUND BY ALL TERMS AND CONDITIONS OF THE LICENSE AGREEMENT. Upon your acceptance of the terms and conditions of the License Agreement, mikroElektronika Associates grants you the right to use Software in a way provided below. This Software is owned by mikroElektronika Associates and is protected by copyright law and international copyright treaty. Therefore, you must treat this Software like any other copyright material (e.g., a book). You may transfer Software and documentation on a permanent basis provided. You retain no copies and the recipient agrees to the terms of the License Agreement. Except as provided in the License Agreement, you may not transfer, rent, lease, lend, copy, modify, translate, sublicense, time-share or electronically transmit or receive Software, media or documentation. You acknowledge that Software in the source code form remains a confidential trade secret of mikroElektronika Associates and therefore you agree not to modify Software or attempt to reverse engineer, decompile, or disassemble it, except and only to the extent that such activity is expressly permitted by applicable law notwithstanding this limitation. If you have purchased an upgrade version of Software, it constitutes a single product with the mikroElektronika Associates software that you upgraded. You may use the upgrade version of Software only in accordance with the License Agreement.
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LIMITED WARRANTY Respectfully excepting the Redistributables, which are provided “as is”, without warranty of any kind, mikroElektronika Associates warrants that Software, once updated and properly used, will perform substantially in accordance with the accompanying documentation, and Software media will be free from defects in materials and workmanship, for a period of ninety (90) days from the date of receipt. Any implied warranties on Software are limited to ninety (90) days. mikroElektronika Associates’ and its suppliers’ entire liability and your exclusive remedy shall be, at mikroElektronika Associates’ option, either (a) return of the price paid, or (b) repair or replacement of Software that does not meet mikroElektronika Associates’ Limited Warranty and which is returned to mikroElektronika Associates with a copy of your receipt. DO NOT RETURN ANY PRODUCT UNTIL YOU HAVE CALLED MIKROELEKTRONIKA ASSOCIATES FIRST AND OBTAINED A RETURN AUTHORIZATION NUMBER. This Limited Warranty is void if failure of Software has resulted from an accident, abuse, or misapplication. Any replacement of Software will be warranted for the rest of the original warranty period or thirty (30) days, whichever is longer. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, MIKROELEKTRONIKA ASSOCIATES AND ITS SUPPLIERS DISCLAIM ALL OTHER WARRANTIES AND CONDITIONS, EITHER EXPRESSED OR IMPLIED, INCLUDED, BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE, AND NON-INFRINGEMENT, WITH REGARD TO SOFTWARE, AND THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT SERVICES. IN NO EVENT SHALL MIKROELEKTRONIKA ASSOCIATES OR ITS SUPPLIERS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS AND BUSINESS INFORMATION, BUSINESS INTERRUPTION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE SOFTWARE PRODUCT OR THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT SERVICES, EVEN IF MIKROELEKTRONIKA ASSOCIATES HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, MIKROELEKTRONIKA ASSOCIATES’ ENTIRE LIABILITY UNDER ANY PROVISION OF THIS LICENSE AGREEMENT SHALL BE LIMITED TO THE AMOUNT ACTUALLY PAID BY YOU FOR SOFTWARE PRODUCT PROVIDED, HOWEVER, IF YOU HAVE ENTERED INTO A MIKROELEKTRONIKA ASSOCIATES SUPPORT SERVICES AGREEMENT, MIKROELEKTRONIKA ASSOCIATES’ ENTIRE LIABILITY REGARDING SUPPORT SERVICES SHALL BE GOVERNED BY THE TERMS OF THAT AGREEMENT. MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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Software is not fault-tolerant and is not designed, manufactured or intended for use or resale as on-line control equipment in hazardous environments requiring fail-safe performance, such as in the operation of nuclear facilities, aircraft navigation or communication systems, air traffic control, direct life support machines, or weapons systems, in which the failure of Software could lead directly to death, personal injury, or severe physical or environmental damage (“High Risk Activities”). mikroElektronika Associates and its suppliers specifically disclaim any expressed or implied warranty of fitness for High Risk Activities.



GENERAL PROVISIONS This statement may only be modified in writing signed by you and an authorised officer of mikroElektronika Associates. If any provision of this statement is found void or unenforceable, the remainder will remain valid and enforceable according to its terms. If any remedy provided is determined to have failed for its essential purpose, all limitations of liability and exclusions of damages set forth in the Limited Warranty shall remain in effect. This statement gives you specific legal rights; you may have others, which vary, from country to country. mikroElektronika Associates reserves all rights not specifically granted in this statement. mikroElektronika Visegradska 1A, 11000 Belgrade, Europe. Phone: + 381 11 36 28 830 Fax: +381 11 36 28 831 Web: www.mikroe.com E-mail: [email protected]
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TECHNICAL SUPPORT In case you encounter any problem, you are welcome to our support forums at www.mikroe.com/forum/. Here, you may also find helpful information, hardware tips, and practical code snippets. Your comments and suggestions on future development of the mikroC PRO for PIC are always appreciated — feel free to drop a note or two on our Wishlist. In our Knowledge Base www.mikroe.com/en/kb/ you can find the answers to Frequently Asked Questions and solutions to known problems. If you can not find the solution to your problem in Knowledge Base then report it to Support Desk www.mikroe.com/en/support/. In this way, we can record and track down bugs more efficiently, which is in our mutual interest. We respond to every bug report and question in a suitable manner, ever improving our technical support.
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The latest version of the mikroC PRO for PIC is always available for downloading from our website. It is a fully functional software libraries, examples, and comprehensive help included. The only limitation of the free version is that it cannot generate hex output over 2 KB. Although it might sound restrictive, this margin allows you to develop practical, working applications with no thinking of demo limit. If you intend to develop really complex projects in the mikroC PRO for PIC, then you should consider the possibility of purchasing the license key.



Who Gets the License Key Buyers of the mikroC PRO for PIC are entitled to the license key. After you have completed the payment procedure, you have an option of registering your mikroC PRO. In this way you can generate hex output without any limitations.



How to Get License Key After you have completed the payment procedure, start the program. Select Help › How to Register from the drop-down menu or click the How To Register Icon . Fill out the registration form (figure below), select your distributor, and click the Send button.
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This will start your e-mail client with message ready for sending. Review the information you have entered, and add the comment if you deem it necessary. Please, do not modify the subject line. Upon receiving and verifying your request, we will send the license key to the e-mail address you specified in the form.
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The license key comes as a small autoextracting file – just start it anywhere on your computer in order to activate your copy of compiler and remove the demo limit. You do not need to restart your computer or install any additional components. Also, there is no need to run the mikroC PRO for PIC at the time of activation. Notes:  The license key is valid until you format your hard disk. In case you need to for mat the hard disk, you should request a new activation key.  Please keep the activation program in a safe place. Every time you upgrade the compiler you should start this program again in order to reactivate the license.
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mikroC PRO for PIC Environment The mikroC PRO for PIC is an user-friendly and intuitive environment.
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 The Code Editor features adjustable Syntax Highlighting, Code Folding, Code Assistant, Parameters Assistant, Auto Correct for common typos and Code Tem plates (Auto Complete).  The Code Explorer is at your disposal for easier project management.  The Project Manager alows multiple project management  General project settings can be made in the Project Settings window Library manager enables simple handling libraries being used in a project  The Error Window displays all errors detected during compiling and linking.  The source-level Software Simulator lets you debug executable logic step-bystep by watching the program flow.  The New Project Wizard is a fast, reliable, and easy way to create a project.  Help files are syntax and context sensitive.  Like in any modern Windows application, you may customize the layout of mikroC PRO for PIC to suit your needs best.  Spell checker underlines identifiers which are unknown to the project. In this way it helps the programmer to spot potential problems early, much before the proj ect is compiled.  Spell checker can be disabled by choosing the option in the Preferences dialog (F12).
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MAIN MENU OPTIONS Available Main Menu options are:



Related topics: Keyboard shortcuts
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The File menu is the main entry point for manipulation with the source files.



File



Description Open a new editor window. Open source file for editing or image file for viewing. Reopen recently used file. Save changes for active editor. Save the active source file with the different name or change the file type. Close active source file. Print Preview. Exit IDE.



Related topics: Keyboard shortcuts, File Toolbar, Managing Source Files
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EDIT MENU OPTIONS



Edit



Description Undo last change. Redo last change. Cut selected text to clipboard. Copy selected text to clipboard. Paste text from clipboard. Delete selected text. Select all text in active editor. Find text in active editor. Find next occurence of text in active editor. Find previous occurence of text in active editor. Replace text in active editor. Find text in current file, in all opened files, or in files from desired folder. Goto to the desired line in active editor. Advanced Code Editor options
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Description Comment selected code or put single line comment if there is no selection. Uncomment selected code or remove single line comment if there is no selection. Indent selected code. Outdent selected code. Changes selected text case to lowercase. Changes selected text case to uppercase. Changes selected text case to titlercase.



Find Text Dialog box for searching the document for the specified text. The search is performed in the direction specified. If the string is not found a message is displayed.
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Replace Text Dialog box for searching for a text string in file and replacing it with another text string.



Find In Files Dialog box for searching for a text string in current file, all opened files, or in files on a disk. The string to search for is specified in the Text to find field. If Search in directories option is selected, The files to search are specified in the Files mask and Path fields.
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Dialog box that allows the user to specify the line number at which the cursor should be positioned.



Regular expressions option By checking this box, you will be able to advance your search, through Regular expressions.



Related topics: Keyboard shortcuts, Edit Toolbar, Advanced Edit Toolbar
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VIEW MENU OPTIONS



File



Description Show/Hide toolbars. Show/Hide debug windows. Show/Hide Routine List in active editor. Show/Hide Project Settings window. Show/Hide Code Explorer window. Show/Hide Project Manager window. Show/Hide Library Manager window. Show/Hide Bookmarks window. Show/Hide Error Messages window. Show/Hide Macro Editor window. Show Window List window.
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File Toolbar is a standard toolbar with following options: Icon



Description Opens a new editor window. Open source file for editing or image file for viewing. Save changes for active window. Save changes in all opened windows. Close current editor. Close all editors. Print Preview.



Edit Toolbar



Edit Toolbar is a standard toolbar with following options: Icon



Description Undo last change. Redo last change. Cut selected text to clipboard. Copy selected text to clipboard. Paste text from clipboard.
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Advanced Edit Toolbar



Advanced Edit Toolbar comes with following options: Icon



Description Comment selected code or put single line comment if there is no selection Uncomment selected code or remove single line comment if there is no selection. Select text from starting delimiter to ending delimiter. Go to ending delimiter. Go to line. Indent selected code lines. Outdent selected code lines. Generate HTML code suitable for publishing current source code on the web.



Find/Replace Toolbar



Find/Replace Toolbar is a standard toolbar with following options: Icon



Description Find text in current editor. Find next occurence. Find previous occurence. Replace text. Find text in files.
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Environment Project Toolbar Project Toolbar comes with following options: Icon



Description New project Open Project Save Project Close current project. Edit project settings. Add existing project to project group. Remove existing project from project group. Add File To Project Remove File From Project



Build Toolbar Build Toolbar comes with the following options: Icon



Description Build current project. Build all opened projects. Build and program active project. Start programmer and load current HEX file. Open assembly code in editor. Open lisitng file in editor. View statistics for current project.
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Debugger Debugger Toolbar comes with following options: Icon



Description Start Software Simulator or mikroICD (In-Circuit Debugger). Run/Pause debugger. Stop debugger. Step into. Step over. Step out. Run to cursor. Toggle breakpoint. Toggle breakpoints. Clear breakpoints. View watch window View stopwatch window



Styles Toolbar



Styles toolbar allows you to easily customize your workspace.
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Tools Toolbar comes with following default options: Icon



Description Run USART Terminal EEPROM ASCII Chart Seven segment decoder tool. Options menu



The Tools toolbar can easily be customized by adding new tools in Options (F12) window. Related topics: Keyboard shortcuts, Integrated Tools, Debugger Windows



24



MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 2 mikroC PRO for PIC



Environment



PROJECT MENU OPTIONS
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Description Build active project. Build all projects. Build and program active project. View Assembly. Edit search paths. Clean Project Folder Add file to project. Remove file from project. Import projects from previous versions of mikroC. Open New Project Wizard Open existing project. Save current project. Edit project settings Open project group. Close project group. Save active project file with the different name. Open recently used project. Close active project.



Related topics: Keyboard shortcuts, Project Toolbar, Creating New Project, Project Manager, Project Settings
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RUN MENU OPTIONS



Run



Description Start Software Simulator or mikroICD (InCircuit Debugger). Stop debugger. Pause Debugger. Step Into. Step Over. Step Out. Jump to interrupt in current project. Toggle Breakpoint. Breakpoints. Clear Breakpoints. Show/Hide Watch Window Show/Hide Stopwatch Window Toggle between Pascal source and disassembly.



Related topics: Keyboard shortcuts, Debug Toolbar MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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Tools



Description Run mikroElektronika Programmer Run USART Terminal Run EEPROM Editor Run ASCII Chart Run 7 Segment Display Converter Generate HTML code suitable for publishing source code on the web. Run Lcd custom character. Run Glcd bitmap editor. Run HID Terminal. Run UDP communication terminal. Run mikroBootloader. Open Options window.



Related topics: Keyboard shortcuts, Tools Toolbar
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HELP MENU OPTIONS



Help



Description Open Help File. Open Code Migration Document. Check if new compiler version is available. Open mikroElektronika Support Forums in a default browser. Open mikroElektronika Web Page in a default browser. Information on how to register Open About window.



Related topics: Keyboard shortcuts
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Below is a complete list of keyboard shortcuts available in mikroC PRO for PIC IDE.
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IDE Shortcuts



Ctrl+Shift+S



Save All



F1



Help



Ctrl+V



Paste



Ctrl+N



New Unit



Ctrl+X



Cut



Ctrl+O



Open



Ctrl+Y



Delete entire line



Ctrl+Shift+O Open Project



Ctrl+Z



Undo



Ctrl+Shift+N New Project



Ctrl+Shift+Z



Redo



Advanced Editor Shortcuts



Ctrl+K



Close Project



Ctrl+F4



Close Unit



Ctrl+Space



Code Assistant



Ctr+Shift+E



Edit Project



Ctrl+Shift+Space



Parameters Assistant



Ctrl+F9



Build



Ctrl+D



Find declaration



Shift+F9



Build All



Ctrl+E



Incremental Search



Ctrl+F11



Build And Program



Ctrl+L



Routine List



Shift+F4



View Breakpoints



Ctrl+G



Goto line



Ctrl+Shift+F5 Clear Breakpoints



Ctrl+J



Insert Code Template



F11



Ctrl+Shift+.



Comment Code



Ctrl+Shift+F1 Project Manager



Ctrl+Shift+,



Uncomment Code



F12



Options



Ctrl+number



Goto bookmark



Alt+X



Close mikroC PRO for PIC



Ctrl+Shift+number Set bookmark



Start mE Programmer



Basic Editor Shortcuts



Ctrl+Shift+I



Indent selection



F3



Find, Find Next



Ctrl+Shift+U



Unindent selection



Shift+F3



Find Previous



TAB



Indent selection



Alt+F3



Grep Search, Find in Files



Shift+TAB



Unindent selection



Ctrl+A



Select All



Alt+Select



Select columns



Ctrl+C



Copy



Ctrl+Alt+Select



Select columns



Ctrl+F



Find



Ctrl+R



Replace



Ctrl+P



Print



Ctrl+Alt+U



Ctrl+S



Save unit



Ctrl+Alt+T



Ctrl+Alt+L



Convert selection to lowercase Convert selection to uppercase Convert to Titlecase
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F2



Jump to Interrupt



F4



Run to Cursor



F5



Toggle Breakpoint



F6



Run/Pause Debugger



F7



Step into



F8



Step over



F9



Debug



Ctrl+F2



Stop Debugger



Ctrl+F5



Add to Watch List



Ctrl+F8



Step out



Alt+D



Dissasembly View



Shift+F5



Open Watch Window



Ctrl+Shift+A



Show Advanced Breakpoints
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The mikroC PRO for PIC is an user-friendly and intuitive environment:



 The Code Editor features adjustable Syntax Highlighting, Code Folding, Code Assistant, Parameters Assistant, Auto Correct for common typos and Code Tem plates (Auto Complete).  The Code Explorer is at your disposal for easier project management.  The Project Manager alows multiple project management  General project settings can be made in the Project Settings window  Library manager enables simple handling libraries being used in a project  The Error Window displays all errors detected during compiling and linking.  The source-level Software Simulator lets you debug executable logic step-bystep by watching the program flow.  The New Project Wizard is a fast, reliable, and easy way to create a project.  Help files are syntax and context sensitive.  Like in any modern Windows application, you may customize the layout of mikroC PRO for PIC to suit your needs best.  Spell checker underlines identifiers which are unknown to the project. In this way it helps the programmer to spot potential problems early, much before the project is compiled. Spell checker can be disabled by choosing the option in the Preferences dialog (F12).
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CUSTOMIZING IDE LAYOUT Docking Windows You can increase the viewing and editing space for code, depending on how you arrange the windows in the IDE. Step 1: Click the window you want to dock, to give it focus.



Step 2: Drag the tool window from its current location. A guide diamond appears. The four arrows of the diamond point towards the four edges of the IDE.
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Step 3: Move the pointer over the corresponding portion of the guide diamond. An outline of the window appears in the designated area.



Step 4: To dock the window in the position indicated, release the mouse button. Tip: To move a dockable window without snapping it into place, press CTRL while dragging it.



Saving Layout Once you have a window layout that you like, you can save the layout by typing the name for the layout and pressing the Save Layout Icon



.



To set the layout select the desired layout from the layout drop-down list and click the Set Layout Icon



.



To remove the layout from the drop-down list, select the desired layout from the list and click the Delete Layout Icon
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Auto Hide Auto Hide enables you to see more of your code at one time by minimizing tool windows along the edges of the IDE when not in use. Click the window you want to keep visible to give it focus. Click the Pushpin Icon



on the title bar of the window.



.



When an auto-hidden window loses focus, it automatically slides back to its tab on the edge of the IDE. While a window is auto-hidden, its name and icon are visible on a tab at the edge of the IDE. To display an auto-hidden window, move your pointer over the tab. The window slides back into view and is ready for use.
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The Code Editor is advanced text editor fashioned to satisfy needs of professionals. General code editing is the same as working with any standard text-editor, including familiar Copy, Paste and Undo actions, common for Windows environment.



Advanced Editor Features         



Adjustable Syntax Highlighting Code Assistant Code Folding Parameter Assistant Code Templates (Auto Complete) Auto Correct for common typos Spell Checker Bookmarks and Goto Line Comment / Uncomment



You can configure the Syntax Highlighting, Code Templates and Auto Correct from the Editor Settings dialog. To access the Settings, click Tools › Options from the drop-down menu, click the Show Options Icon or press F12 key.
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Code Assistant If you type the first few letters of a word and then press Ctrl+Space, all valid identifiers matching the letters you have typed will be prompted in a floating panel (see the image below). Now you can keep typing to narrow the choice, or you can select one from the list using the keyboard arrows and Enter.



Code Folding Code folding is IDE feature which allows users to selectively hide and display sections of a source file. In this way it is easier to manage large regions of code within one window, while still viewing only those subsections of the code that are relevant during a particular editing session. While typing, the code folding symbol ( - and + ) appear automatically. Use the folding symbols to hide/unhide the code subsections.



If you place a mouse cursor over the tooltip box, the collapsed text will be shown in a tooltip style box.
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Parameter Assistant The Parameter Assistant will be automatically invoked when you open parenthesis “(” or press Shift+Ctrl+Space. If the name of a valid function precedes the parenthesis, then the expected parameters will be displayed in a floating panel. As you type the actual parameter, the next expected parameter will become bold.



Code Templates (Auto Complete) You can insert the Code Template by typing the name of the template (for instance, whiles), then press Ctrl+J and the Code Editor will automatically generate a code.



You can add your own templates to the list. Select Tools › Options from the drop-down menu, or click the Show Options Icon and then select the Auto Complete Tab. Here you can enter the appropriate keyword, description and code of your template. Autocomplete macros can retreive system and project information: -
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%DATE% - current system date %TIME% - current system time %DEVICE% - device(MCU) name as specified in project settings %DEVICE_CLOCK% - clock as specified in project settings %COMPILER% - current compiler version
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These macros can be used in template code, see template ptemplate provided with mikroC PRO for PIC installation.



Auto Correct The Auto Correct feature corrects common typing mistakes. To access the list of recognized typos, select Tools › Options from the drop-down menu, or click the Show Options Icon



and then select the Auto Correct Tab. You can also add your own



preferences to the list. Also, the Code Editor has a feature to comment or uncomment the selected code by simple click of a mouse, using the Comment Icon



and Uncomment Icon



from



the Code Toolbar.



Spell Checker The Spell Checker underlines unknown objects in the code, so they can be easily noticed and corrected before compiling your project. Select Tools › Options from the drop-down menu, or click the Show Options Icon and then select the Spell Checker Tab.



Bookmarks Bookmarks make navigation through a large code easier. To set a bookmark, use Ctrl+Shift+number. To jump to a bookmark, use Ctrl+number.



Goto Line The Goto Line option makes navigation through a large code easier. Use the shortcut Ctrl+G to activate this option.



Comment / Uncomment Also, the Code Editor has a feature to comment or uncomment the selected code by simple click of a mouse, using the Comment Icon ment Icon



and Uncom-



from the Code Toolbar.
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The Code Explorer gives clear view of each item declared inside the source code. You can jump to a declaration of any item by right clicking it. Also, besides the list of defined and declared objects, code explorer displays message about first error and it's location in code.



Following options are available in the Code Explorer: Icon



Description Expand/Collapse all nodes in tree. Locate declaration in code.
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ROUTINE LIST Routine list diplays list of routines, and enables filtering routines by name. Routine list window can be accessed by pressing Ctrl+L. You can jump to a desired routine by double clicking on it.
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Project Manager is IDE feature which allows users to manage multiple projects. Several projects which together make project group may be open at the same time. Only one of them may be active at the moment. Setting project in active mode is performed by double click on the desired project in the Project Manager.



Following options are available in the Project Manager:
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Icon



Description Save project Group. Open project group. Close the active project. Close project group. Add project to the project group. Remove project from the project group. Add file to the active project. Remove selected file from the project. Build the active project. Run mikroElektronika's Flash programmer.



For details about adding and removing files from project see Add/Remove Files from Project. Related topics: Project Settings, Project Menu Options, File Menu Options, Project Toolbar, Build Toolbar, Add/Remove Files from Project
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Environment PROJECT SETTINGS WINDOW Following options are available in the Project Settings Window:



 Device - select the appropriate device from the device drop-down list.  Oscillator - enter the oscillator frequency value.  Build/Debugger Type - choose debugger type.



Related topics: Edit Project, Customizing Projects
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LIBRARY MANAGER Library Manager enables simple handling libraries being used in a project. Library Manager window lists all libraries (extencion .mcl) which are instantly stored in the compiler Uses folder. The desirable library is added to the project by selecting check box next to the library name. In order to have all library functions accessible, simply press the button Check All and all libraries will be selected. In case none library is needed in a project, press the button Clear All



and all libraries will be cleared from the project.



Only the selected libraries will be linked.
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Description Refresh Library by scanning files in "Uses" folder. Useful when new libraries are added by copying files to "Uses" folder. Rebuild all available libraries. Useful when library sources are available and need refreshing. Include all available libraries in current project. No libraries from the list will be included in current project. Restore library to the state just before last project saving.



Related topics: mikroC PRO for PIC Libraries, Creating New Library
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ERROR WINDOW In case that errors were encountered during compiling, the compiler will report them and won’t generate a hex file. The Error Window will be prompted at the bottom of the main window by default. The Error Window is located under message tab, and displays location and type of errors the compiler has encountered. The compiler also reports warnings, but these do not affect the output; only errors can interefere with the generation of hex.



Double click the message line in the Error Window to highlight the line where the error was encountered. Related topics: Error Messages
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After successful compilation, you can review statistics of your code. Click the Statistics Icon .



Memory Usage Windows Provides overview of RAM and ROM usage in the various forms.



RAM Memory Usage Displays RAM memory usage in a pie-like form.
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Used RAM Locations Displays used RAM memory locations and their names.



SFR Locations Displays list of used SFR locations.
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Environment ROM Memory Usage Displays ROM memory space usage in a pie-like form.



ROM Memory Constants Displays ROM memory constants and their addresses.



50



MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 2 mikroC PRO for PIC



Environment



Function Sorted by Name Sorts and displays functions by their addresses, symbolic names, and unique assembler names.



Functions Sorted by Size Sorts and displays functions by their size, in the ascending order.
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Sorts and displays functions by their addresses, in the ascending order.



Functions Sorted by Name Chart Sorts and displays functions by their names in a chart-like form.
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Functions Sorted by Size Chart Sorts and displays functions by their sizes in a chart-like form.



Functions sorted by Address Chart Sorts and displays functions by their addresses in a chart-like form.
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Memory Summary Displays summary of RAM and ROM memory in a pie-like form.
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MACRO EDITOR A macro is a series of keystrokes that have been 'recorded' in the order performed. A macro allows you to 'record' a series of keystrokes and then 'playback', or repeat, the recorded keystrokes.



The Macro offers the following commands: Icon



Description Starts 'recording' keystrokes for later playback. Stops capturing keystrokesthat was started when the Start Recordig command was selected. Allows a macro that has been recorded to be replayed. New macro. Delete macro.



Related topics: Advanced Code Editor, Code Templates
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The mikroC PRO for PIC includes the USART communication terminal for RS232 communication. You can launch it from the drop-down menu Tools › USART Terminal or by clicking the USART Terminal Icon
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from Tools toolbar.
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EEPROM Editor The EEPROM Editor is used for manipulating MCU's EEPROM memory. You can launch it from the drop-down menu Tools › EEPROM Editor. When Use this EEPROM definition is checked compiler will generate Intel hex file project_name.ihex that contains data from EEPROM editor. When you run mikroElektronika programmer software from mikroC PRO for PIC IDE - project_name.hex file will be loaded automatically while ihex file must be loaded manually.
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The ASCII Chart is a handy tool, particularly useful when working with Lcd display. You can launch it from the drop-down menu Tools › ASCII chart or by clicking the View ASCII Chart Icon
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from Tools toolbar.
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Seven Segment Converter The Seven Segment Convertor is a convenient visual panel which returns decimal/hex value for any viable combination you would like to display on 7seg. Click on the parts of 7 segment image to get the requested value in the edit boxes. You can launch it from the drop-down menu Tools › 7 Segment Convertor or by clicking the Seven Segment Convertor Icon



from Tools toolbar.



LCD Custom Character mikroC PRO for PIC includes the Lcd Custom Character. Output is mikroC PRO for PIC compatible code. You can launch it from the drop-down menu Tools › Lcd Custom Character.
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The mikroC PRO for PIC includes the Graphic Lcd Bitmap Editor. Output is the mikroC PRO for PIC compatible code. You can launch it from the drop-down menu Tools › Glcd Bitmap Editor.
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HID Terminal The mikroC PRO for PIC includes the HID communication terminal for USB communication. You can launch it from the drop-down menu Tools › HID Terminal.
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The mikroC PRO for PIC includes the UDP Terminal. You can launch it from the drop-down menu Tools › UDP Terminal.
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mikroBootloader (From Microchip’s document AN732) The PIC16F87X family of microcontrollers has the ability to write to their own program memory. This feature allows a small bootloader program to receive and write new firmware into memory. In its most simple form, the bootloader starts the user code running, unless it finds that new firmware should be downloaded. If there is new firmware to be downloaded, it gets the data and writes it into program memory. There are many variations and additional features that can be added to improve reliability and simplify the use of the bootloader. Note: mikroBootloader can be used only with PIC MCUs that support flash write.



How to use mikroBootloader? 1. Load the PIC with the appropriate hex file using the conventional programming techniques (e.g. for PIC16F877A use p16f877a.hex). 2. Start mikroBootloader from the drop-down menu Tools › Bootoader. 3. Click on Setup Port and select the COM port that will be used. Make sure that BAUD is set to 9600 Kpbs. 4. Click on Open File and select the HEX file you would like to upload. 5. Since the bootcode in the PIC only gives the computer 4-5 sec to connect, you should reset the PIC and then click on the Connect button within 4-5 seconds. 6. The last line in then history window should now read “Connected”. 7. To start the upload, just click on the Start Bootloader button. 8. Your program will written to the PIC flash. Bootloader will report an errors that may occur. 9. Reset your PIC and start to execute.
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The boot code gives the computer 5 seconds to get connected to it. If not, it starts running the existing user code. If there is a new user code to be downloaded, the boot code receives and writes the data into program memory. The more common features a bootloader may have are listed below:      



Code at the Reset location. Code elsewhere in a small area of memory. Checks to see if the user wants new user code to be loaded. Starts execution of the user code if no new user code is to be loaded. Receives new user code via a communication channel if code is to be loaded. Programs the new user code into memory.



Integrating User Code and Boot Code The boot code almost always uses the Reset location and some additional program memory. It is a simple piece of code that does not need to use interrupts; therefore, the user code can use the normal interrupt vector at 0x0004. The boot code must avoid using the interrupt vector, so it should have a program branch in the address range 0x0000 to 0x0003. The boot code must be programmed into memory using conventional programming techniques, and the configuration bits must be programmed at this time. The boot code is unable to access the configuration bits, since they are not mapped into the program memory space.
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OPTIONS Options menu consists of three tabs: Code Editor, Tools and Output settings.



Code editor The Code Editor is advanced text editor fashioned to satisfy needs of professionals.



Tools The mikroC PRO for PIC includes the Tools tab, which enables the use of shortcuts to external programs, like Calculator or Notepad. You can set up to 10 different shortcuts, by editing Tool0 - Tool9.
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By modifying Output Settings, user can configure the content of the output files. You can enable or disable, for example, generation of ASM and List file. Also, user can choose optimization level, and compiler specific settings, which include case sensitivity, dynamic link for string literals setting (described in mikroC PRO for PIC specifics). Build all files as library enables user to use compiled library (*.mcl) on any PIC MCU (when this box is checked), or for a selected PIC MCU (when this box is left unchecked). For more information on creating new libraries, see Creating New Library.
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REGULAR EXPRESSIONS Introduction Regular Expressions are a widely-used method of specifying patterns of text to search for. Special metacharacters allow you to specify, for instance, that a particular string you are looking for, occurs at the beginning, or end of a line, or contains n recurrences of a certain character.



Simple matches Any single character matches itself, unless it is a metacharacter with a special meaning described below. A series of characters matches that series of characters in the target string, so the pattern "short" would match "short" in the target string. You can cause characters that normally function as metacharacters or escape sequences to be interpreted by preceding them with a backslash "\". For instance, metacharacter "^" matches beginning of string, but "\^" matches character "^", and "\\" matches "\", etc. Examples: unsigned matches string 'unsigned' \^unsigned matches string '^unsigned'



Escape sequences Characters may be specified using a escape sequences: "\n" matches a newline, "\t" a tab, etc. More generally, \xnn, where nn is a string of hexadecimal digits, matches the character whose ASCII value is nn. If you need wide (Unicode) character code, you can use '\x{nnnn}', where 'nnnn' - one or more hexadecimal digits. \xnn - char with hex code nn \x{nnnn)- char with hex code nnnn (one byte for plain text and two bytes for Unicode)



\t - tab (HT/TAB), same as \x09 \n - newline (NL), same as \x0a \r - car.return (CR), same as \x0d \f - form feed (FF), same as \x0c \a - alarm (bell) (BEL), same as \x07 \e - escape (ESC) , same as \x1b
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unsigned\x20int matches 'unsigned int' (note space in the middle) \tunsigned matches 'unsigned' (predecessed by tab)



Character classes You can specify a character class, by enclosing a list of characters in [], which will match any of the characters from the list. If the first character after the "[" is "^", the class matches any character not in the list. Examples: count[aeiou]r finds strings 'countar', 'counter', etc. but not 'countbr', 'countcr', etc. count[^aeiou]r finds strings 'countbr', 'countcr', etc. but not 'countar', 'counter', etc.



Within a list, the "-" character is used to specify a range, so that a-z represents all characters between "a" and "z", inclusive.



If you want "-" itself to be a member of a class, put it at the start or end of the list, or precede it with a backslash. If you want ']', you may place it at the start of list or precede it with a backslash. Examples: [-az] matches 'a', 'z' and '-' [az-] matches 'a', 'z' and '-' [a\-z] matches 'a', 'z' and '-' [a-z] matches all twenty six small characters from 'a' to 'z' [\n-\x0D] matches any of #10,#11,#12,#13. [\d-t] matches any digit, '-' or 't'. []-a] matches any char from ']'..'a'.



Metacharacters Metacharacters are special characters which are the essence of regular expressions. There are different types of metacharacters, described below.
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Metacharacters - Line separators ^ - start of line $ - end of line \A - start of text \Z - end of text . - any character in line Examples: ^PORTA - matches string ' PORTA ' only if it's at the beginning of line PORTA$ - matches string ' PORTA ' only if it's at the end of line ^PORTA$ - matches string ' PORTA ' only if it's the only string in line PORT.r - matches strings like 'PORTA', 'PORTB', 'PORT1' and so on The "^" metacharacter by default is only guaranteed to match beginning of the input string/text, and the "$" metacharacter only at the end. Embedded line separators will not be matched by ^" or "$". You may, however, wish to treat a string as a multi-line buffer, such that the "^" will match after any line separator within the string, and "$" will match before any line separator. Regular expressions works with line separators as recommended at http://www.unicode.org/unicode/reports/tr18/



Metacharacters - Predefined classes \w - an alphanumeric character (including "_") \W - a nonalphanumeric character \d - a numeric character \D - a non-numeric character \s - any space (same as [\t\n\r\f]) \S - a non space You may use \w, \d and \s within custom character classes.



Example: routi\de - matches strings like 'routi1e', 'routi6e' and so on, but not 'routine', 'routime' and so on.
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A word boundary ("\b") is a spot between two characters that has an alphanumeric character ("\w") on one side, and a nonalphanumeric character ("\W") on the other side (in either order), counting the imaginary characters off the beginning and end of the string as matching a "\W". \b - match a word boundary) \B - match a non-(word boundary)



Metacharacters - Iterators Any item of a regular expression may be followed by another type of metacharacters - iterators. Using this metacharacters,you can specify number of occurences of previous character, metacharacter or subexpression. * - zero or more ("greedy"), similar to {0,} + - one or more ("greedy"), similar to {1,} ? - zero or one ("greedy"), similar to {0,1} {n} - exactly n times ("greedy") {n,} - at least n times ("greedy") {n,m} - at least n but not more than m times ("greedy") *? - zero or more ("non-greedy"), similar to {0,}? +? - one or more ("non-greedy"), similar to {1,}? ?? - zero or one ("non-greedy"), similar to {0,1}? {n}? - exactly n times ("non-greedy") {n,}? - at least n times ("non-greedy") {n,m}? - at least n but not more than m times ("non-greedy") So, digits in curly brackets of the form, {n,m}, specify the minimum number of times to match the item n and the maximum m. The form {n} is equivalent to {n,n} and matches exactly n times. The form {n,} matches n or more times. There is no limit to the size of n or m, but large numbers will chew up more memory and slow down execution. So, digits in curly brackets of the form, {n,m}, specify the minimum number of times to match the item n and the maximum m. The form {n} is equivalent to {n,n} and matches exactly n times. The form {n,} matches n or more times. There is no limit to the size of n or m, but large numbers will chew up more memory and slow down execution. If a curly bracket occurs in any other context, it is treated as a regular character.
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Examples: count.*r ß- matches strings like 'counter', 'countelkjdflkj9r' and 'countr' count.+r - matches strings like 'counter', 'countelkjdflkj9r' but not 'countr' count.?r - matches strings like 'counter', 'countar' and 'countr' but not 'countelkj9r' counte{2}r - matches string 'counteer' counte{2,}r - matches strings like 'counteer', 'counteeer', 'counteeer' etc. counte{2,3}r - matches strings like 'counteer', or 'counteeer' but not 'counteeeer'



A little explanation about "greediness". "Greedy" takes as many as possible, "nongreedy" takes as few as possible. For example, 'b+' and 'b*' applied to string 'abbbbc' return 'bbbb', 'b+?' returns 'b', 'b*?' returns empty string, 'b{2,3}?' returns 'bb', 'b{2,3}' returns 'bbb'.



Metacharacters - Alternatives You can specify a series of alternatives for a pattern using "|" to separate them, so that bit|bat|bot will match any of "bit", "bat", or "bot" in the target string as would "b(i|a|o)t)". The first alternative includes everything from the last pattern delimiter ("(", "[", or the beginning of the pattern) up to the first "|", and the last alternative contains everything from the last "|" to the next pattern delimiter. For this reason, it's common practice to include alternatives in parentheses, to minimize confusion about where they start and end. Alternatives are tried from left to right, so the first alternative found for which the entire expression matches, is the one that is chosen. This means that alternatives are not necessarily greedy. For example: when matching rou|rout against "routine", only the "rou" part will match, as that is the first alternative tried, and it successfuly matches the target string (this might not seem important, but it is important when you are capturing matched text using parentheses). Also remember that "|" is interpreted as a literal within square brackets, so if you write [bit|bat|bot], you're really only matching [biao|].



Examples: rou(tine|te) - matches strings 'routine' or 'route'.
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The bracketing construct ( ... ) may also be used for define regular subexpressions. Subexpressions are numbered based on the left to right order of their opening parenthesis. First subexpression has number '1'.



Examples: (int){8,10} matches strings which contain 8, 9 or 10 instances of the 'int' routi([0-9]|a+)e matches 'routi0e', 'routi1e' , 'routine', 'routinne', 'routinnne' etc.



Metacharacters - Backreferences Metacharacters \1 through \9 are interpreted as backreferences. \ matches previously matched subexpression #.



Examples: (.)\1+ matches 'aaaa' and 'cc'. (.+)\1+ matches 'abab' and '123123' (['"]?)(\d+)\1 matches "13" (in double quotes), or '4' (in single quotes) or 77 (without quotes) etc.
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mikroC PRO for PIC COMMAND LINE OPTIONS Usage: mikroCPIC1618.exe [- [-]] [ [-]] []] Infile can be of *.c, *.mcl and *.pld type. The following parameters and some more (see manual) are valid: - P: MCU for which compilation will be done. - FO: Set oscillator [in MHz]. - SP: Add directory to the search path list. - IF: Add directory to the #include search list. - N: Output files generated to file path specified by filename. - B: Save compiled binary files (*.mcl) to 'directory'. - O: Miscellaneous output options. - DBG: Generate debug info. - L: Check and rebuild new libraries. - D: Build all files as libraries. - Y: Dynamic link for string literals. - C: Turn on case sensitivity. - UCD: ICD build type. Example: mikroCPIC1618.exe -MSF -DBG -p16F887 -ES -C -O11111114 -fo8 N"C:\Lcd\Lcd.mcppi" -SP"C:\Program Files\Mikroelektronika\mikroC PRO for PIC\Defs\" -SP"C:\Program Files\Mikroelektronika\mikroC PRO for PIC\Uses\P16\" -SP"C:\Lcd\" "Lcd.c" "__Lib_Math.mcl" "__Lib_MathDouble.mcl" "__Lib_System.mcl" "__Lib_Delays.mcl" "__Lib_LcdConsts.mcl" "__Lib_Lcd.mcl"



Parameters used in the example: - MSF: Short Message Format; used for internal purposes by IDE. - DBG: Generate debug info. - p16F887: MCU 16F887 selected. - C: Turn on case sensitivity. - O11111114: Miscellaneous output options. - fo10: Set oscillator frequency [in MHz]. - N"C:\Lcd\Lcd.mcppi" -SP"C:\Program Files\Mikroelektronika\mikroC PRO for PIC\defs\": Output files generated to file path specified by filename. - -SP"C:\Program Files\Mikroelektronika\mikroC PRO for PIC\ defs\": Add directory to the search path list. - SP"C:\Program Files\Mikroelektronika\mikroC PRO for PIC \uses\": Add directory to the search path list. - -SP"C:\Lcd\": Add directory to the search path list. - "Lcd.c" "__Lib_Math.mcl" "__Lib_MathDouble.mcl" "__Lib_System.mcl" "__Lib_Delays.mcl" "__Lib_LcdConsts.mcl" "__Lib_Lcd.mcl": Specify input files. MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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The mikroC PRO for PIC organizes applications into projects, consisting of a single project file (extension .mcppi) and one or more source files (extension ). mikroC PRO for PIC IDE allows you to manage multiple projects (see Project Manager). Source files can be compiled only if they are part of a project. The project file contains the following information: -



project name and optional description, target device, device flags (config word), device clock, list of the project source files with paths, header files (*.h), binary files (*.mcl), image files, other files.



Note that the project does not include files in the same way as preprocessor does, see Add/Remove Files from Project.



New Project The easiest way to create a project is by means of the New Project Wizard, dropdown menu Project › New Project or by clicking the New Project Icon from Project Toolbar.
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New Project Wizard Steps Start creating your New project, by clicking Next button:



Step One - Select the device from the device drop-down list.
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Step Three - Specify the location where your project will be saved.
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Step Four - Add project file to the project if they are avaiable at this point. You can always add project files later using Project Manager.



Step Five - Click Finish button to create your New Project.



Related topics: Project Manager, Project Settings MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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The mikroC PRO for PIC organizes applications into projects, consisting of a single project file (extension .mcppi) and one or more source files (extension). mikroC PRO for PIC IDE allows you to manage multiple projects (see Project Manager). Source files can be compiled only if they are part of a project. The project file contains the following information: -



project name and optional description, target device, device flags (config word), device clock, list of the project source files with paths, header files (*.h), binary files (*.mcl), image files, other files.



Note that the project does not include files in the same way as preprocessor does, see Add/Remove Files from Project.



New Project The easiest way to create a project is by means of the New Project Wizard, dropdown menu Project › New Project or by clicking the New Project Icon from Project Toolbar.
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New Project Wizard Steps Start creating your New project, by clicking Next button:



Step One - Select the device from the device drop-down list.
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Step Three - Specify the location where your project will be saved.
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Step Four - Add project file to the project if they are avaiable at this point. You can always add project files later using Project Manager.



Step Five - Click Finish button to create your New Project:
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You can change basic project settings in the Project Settings window. You can change chip, and oscillator frequency. Any change in the Project Setting Window affects currently active project only, so in case more than one project is open, you have to ensure that exactly the desired project is set as active one in the Project Manager. Also, you can change configuration bits of the selected chip in the Edit Project window.



Managing Project Group mikroC PRO for PIC IDE provides covenient option which enables several projects to be open simultaneously. If you have several projects being connected in some way, you can create a project group. The project group may be saved by clicking the Save Project Group Icon from the Project Manager window. The project group may be reopend by clicking the Open Project Group Icon . All relevant data about the project group is stored in the project group file (extension .mpgroup)



Add/Remove Files from Project The project can contain the following file types: -



source files .h header files .mcl binary files pld project level defines files



image files .hex, .asm and .lst files, see output files. These files can not be added or



removed from project. - other files
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The list of relevant source files is stored in the project file (extension .mcppi). To add source file to the project, click the Add File to Project Icon . Each added source file must be self-contained, i.e. it must have all necessary definitions after preprocessing. To remove file(s) from the project, click the Remove File from Project Icon .



Project Level Defines: Project Level Defines (.pld) files can also be added to project. Project level define files enable you to have defines that are visible in all source files in the project. A file must contain one definition per line in the following form: [=[]] [=[]]



Define a macro named symbol. To specify a value, use =. If = is omitted, 1 is assumed. Do not enter white-space characters immediately before the "=". If a white-space character is entered immediately after the "=", the macro is defined as zero token. This option can be specified repeatedly. Each appearance of symbol will be replaced by the value before compilation. There are two predefined project level defines. See predefined project level defines Note: For inclusion of the header files (extension .h), use the preprocessor directive #include. See File Inclusion for more information. Related topics: Project Manager, Project Settings, Edit Project MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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Source files containing C code should have the extension . The list of source files relevant to the application is stored in project file with extension .mcppi, along with other project information. You can compile source files only if they are part of the project. Use the preprocessor directive #include to include header files with the extension .h. Do not rely on the preprocessor to include source files other than headers — see Add/Remove Files from Project for more information.



Managing Source Files Creating new source file To create a new source file, do the following: 1. Select File › New Unit from the drop-down menu, or press Ctrl+N, or click the New File Icon



from the File Toolbar.



2. A new tab will be opened. This is a new source file. Select File › Save from the drop-down menu, or press Ctrl+S, or click the Save File Icon



from the File



Toolbar and name it as you want. If you use the New Project Wizard, an empty source file, named after the project with extension, will be created automatically. The mikroC PRO for PIC does not require you to have a source file named the same as the project, it’s just a matter of convenience.



Opening an existing file 1. Select File › Open from the drop-down menu, or press Ctrl+O, or click the Open File Icon



from the File Toolbar. In Open Dialog browse to the location of the



file that you want to open, select it and click the Open button. 2. The selected file is displayed in its own tab. If the selected file is already open, its current Editor tab will become active.



Printing an open file 1. Make sure that the window containing the file that you want to print is active. 2. Select File › Print from the drop-down menu, or press Ctrl+P. 3. In the Print Preview Window, set a desired layout of the document and click the OK button. The file will be printed on the selected printer.
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Saving file 1. Make sure that the window containing the file that you want to save is active. 2. Select File › Save from the drop-down menu, or press Ctrl+S, or click the Save File Icon



from the File Toolbar.



Saving file under a different name 1. Make sure that the window containing the file that you want to save is active. 2. Select File › Save As from the drop-down menu. The New File Name dialog will be displayed. 3. In the dialog, browse to the folder where you want to save the file. 4. In the File Name field, modify the name of the file you want to save. 5. Click the Save button.



Closing file 1. Make sure that the tab containing the file that you want to close is the active tab. 2. Select File › Close from the drop-down menu, or right click the tab of the file that you want to close and select Close option from the context menu. 3. If the file has been changed since it was last saved, you will be prompted to save your changes. Related topics:File Menu, File Toolbar, Project Manager, Project Settings,
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This menu gives you option to choose which files from your current project you want to delete. Files marked in bold can be easily recreated by building a project. Other files should be marked for deletion only with a great care, because IDE cannot recover them.



Related topics: Customizing Projects
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COMPILATION When you have created the project and written the source code, it's time to compile it. Select Project › Build from the drop-down menu, or click the Build Icon



from



the Project Toolbar. If more more than one project is open you can compile all open projects by selecting Project › Build All from the drop-down menu, or click the Build All Icon



from the Project Toolbar.



Progress bar will appear to inform you about the status of compiling. If there are some errors, you will be notified in the Error Window. If no errors are encountered, the mikroC PRO for PIC will generate output files.



Output Files Upon successful compilation, the mikroC PRO for PIC will generate output files in the project folder (folder which contains the project file .mcppi). Output files are summarized in the table below: Format



Description



File Type



Intel HEX



Intel style hex records. Use this file to program PIC MCU.



.hex



Binary



mikro Compiled Library. Binary distribution of application that can be included in other projects.



.mcl



List File



Overview of PIC memory allotment: instruction addresses, registers, routines and labels.



.lst



Assembler File



Human readable assembly with symbolic names, extracted from the List File.



.asm



Assembly View After compiling the program in the mikroC PRO for PIC, you can click the View Assembly icon



or select Project › View Assembly from the drop-down menu



to review the generated assembly code (.asm file) in a new tab window. Assembly is human-readable with symbolic names. Related topics: Project Menu, Project Toolbar, Error Window, Project Manager, Project Settings
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Environment ERROR MESSAGES Compiler Error Messages: - Syntax error: Expected [%s] but [%s] found - Array element cannot be function - Function cannot return array - Inconsistent storage class - Inconsistent type - [%s] tag redefined [%s] - Illegal typecast [%s] [%s] - "%s" is not valid identifier - Invalid statement - Constant expression required - Internal error [%s] - Too many actual parameters - Not enough parameters. - Invalid expression - Identifier expected, but [%s] found - Operator [%s] is not applicable to these operands [%s] - Assigning to non-lvalue [%s]



- Cannot cast [%s] to [%s] - Cannot assign [%s] to [%s] - Lvalue required - Pointer required - Argument is out of range - Undeclared identifier [%s] in expression - Too many initializers - Cannot establish this baud rate at [%s] MHz clock - Stack overflow - Invalid operator [%s] - Expected variable, but constant [%s] found - Expected constant, but [%s] found - [%s] cannot be used outside a loop - Unknown type [%s] - Variable [%s] is redeclared - Undeclared identifier [%s] - Output limit has raised 2K words - [%s] has already been declared [%s] - Type mismatch: expected [%s], but [%s] found - File [%s] not found [%s] - There is not enough RAM space for all variables - There is not enough ROM space - Invalid type in Array - Division by zero - Incompatible types: [%s] [%s] - Too many characters
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- Assembler instruction [%s] was not found - Project name must be specified - Unknown command line Option: [%s] - File extension missing: [%s] - Bad FO argument: [%s] - Preprocessor exited with error code [%s] - Bad absolute address [%s] - Recursion or cross-calling of [%s] - Reentrancy is not allowed: function[%s] called from two threads - no files specified - Device parameter missing (for example -P16F...) - Invalid parameter string - Project name must be set - Specifier needed - [%s] not found [%s] - Index out of bounds - Array dimension must be greater than 0 - Const expression expected - Integer const expected - Recursion in definition - Array corrupted - Arguments cannot be of void type - Arguments cannot have explicit memory specificator - Bad storage class - Pointer to function required - Function required - Illegal pointer conversion to double - Integer type needed - Members cannot have memory specifier - Members cannot be of bit or sbit type - Too many initializers - Too many initializers of subaggregate - Already used [%s] - Illegal expression with void - Address must be greater than 0 - [%s] Identifier redefined - User abort - Expression must be greater than 0 - Invalid declarator expected "(" or identifier - typdef name redefined: [%s] - Declarator error - Specifer/qualifier list expected - [%s] already used - ILevel can be used only with interrupt service routines - ; expected, but [%s] found MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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Environment - Expected "{" - [%s] Identifier redefined - "(" expected, but [%s] found - ")" expected, but [%s] found - "case" out of switch - ":" expected, but [%s] found - "default" label out of switch - switch expression must evaluate to integral type - while expected, but [%s] found - void func cannot return values - "continue" outside of loop - Unreachable code - Label redefined - void type in expression - Too many chars - Unresolved type - Arrays of objects containing zero-size arrays are illegal - Invalid enumerator - ILevel can be used only with interrupt service routines - ILevel value must be integral constant - ILevel out of range "0..4" - "}" expected [%s] found - ")" expected, but [%s] found - "break" outside of loop or switch - Empty char - Nonexistent field [%s] - Illegal char representation: [%s] - Initializer syntax error: multidimensional array missing subscript - Too many initializers of subaggregate - At least one Search Path must be specified - Not enough RAM for call stack - Demo Limit - Parameter [%s] must not be of bit or sbit type - Function must not have return value of bit or sbit type
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Compiler Warning Messages: -



Bad or missing fosc parameter. Default value 8MHz used Specified search path does not exist: [%s] Specified include path does not exist: [%s] Result is not defined in function: [%s] Initialization of extern object [%s] Suspicious pointer conversion Implicit conversion of pointer to int Unknown pragma line ignored: [%s] Implicit conversion of int to ptr Generated baud rate is [%s] bps (error = [%s] percent) Unknown memory model [%s], small memory model used instead IRP bit must be set manually for indirect access to [%s] variable Variable [%s] has been declared, but not used' Illegal file type: [%s]



Linker Error Messages: -



Redefinition of [%s] already defined in [%s] main function is not defined System routine is not found for initialization of: [%s] Bad aggregate definition [%s] Unresolved extern [%s] Bad function absolute address [%s] Not enough RAM [%s]
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The Source-level Software Simulator is an integral component of the mikroC PRO for PIC environment. It is designed to simulate operations of the PIC MCUs and assist the users in debugging C code written for these devices. Upon completion of writing your program, choose Release build Type in the Project Settings window:



After you have successfuly compiled your project, you can run the Software Simulator by selecting Run › Start Debugger from the drop-down menu, or by clicking the Start Debugger Icon



from the Debugger Toolbar. Starting the Software Sim-



ulator makes more options available: Step Into, Step Over, Step Out, Run to Cursor, etc. Line that is to be executed is color highlighted (blue by default). Note: The Software Simulator simulates the program flow and execution of instruction lines, but it cannot fully emulate PIC device behavior, i.e. it doesn’t update timers, interrupt flags, etc.
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Breakpoints Window The Breakpoints window manages the list of currently set breakpoints in the project. Doubleclicking the desired breakpoint will cause cursor to navigate to the corresponding location in source code.



Watch Window The Software Simulator Watch Window is the main Software Simulator window which allows you to monitor program items while simulating your program. To show the Watch Window, select View › Debug Windows › Watch from the drop-down menu. The Watch Window displays variables and registers of the MCU, along with their addresses and values. There are two ways of adding variable/register to the watch list:  by its real name (variable's name in "C" code). Just select desired variable/register from Select variable from list drop-down menu and click the Add Button .  by its name ID (assembly variable name). Simply type name ID of they variable/register you want to display into Search the variable by assemby name box and click the Add Button



.
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Variables can also be removed from the Watch window, just select the variable that you want to remove and then click the Remove Button . Add All Button Remove All Button



adds all variables. removes all variables.



You can also expand/collapse complex variables, i.e. struct type variables, strings... Values are updated as you go through the simulation. Recently changed items are colored red.



Double clicking a variable or clicking the Properties Button opens the Edit Value window in which you can assign a new value to the selected variable/register. Also, you can choose the format of variable/register representation between decimal, hexadecimal, binary, float or character. All representations except float are unsigned by default. For signed representation click the check box next to the Signed label.



94



MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 2 mikroC PRO for PIC



Environment



An item's value can be also changed by double clicking item's value field and typing the new value directly. .



View RAM Window Debugger View RAM Window is available from the drop-down menu, View › Debug Windows › View RAM. The View RAM Window displays the map of PIC’s RAM, with recently changed items colored red.
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The Software Simulator Stopwatch Window is available from the drop-down menu, View › Debug Windows › Stopwatch. The Stopwatch Window displays a current count of cycles/time since the last Software Simulator action. Stopwatch measures the execution time (number of cycles) from the moment Software Simulator has started and can be reset at any time. Delta represents the number of cycles between the lines where Software Simulator action has started and ended. Note: The user can change the clock in the Stopwatch Window, which will recalculate values for the latest specified frequency. Changing the clock in the Stopwatch Window does not affect actual project settings – it only provides a simulation.
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SOFTWARE SIMULATOR OPTIONS Name Start Debugger Run/Pause Debugger Stop Debugger



Description



Function Toolbar Key Icon



Start Software Simulator.



[F9]



Run or pause Software Simulator.



[F6]



Stop Software Simulator.



[Ctrl+F2]



Toggle Breakpoints



Toggle breakpoint at the current cursor position. To view all breakpoints, select Run > View Breakpoints from the drop–down menu. Double clicking an item in the Breakpoints Window List locates the breakpoint.



[F5]



Run to cursor



Execute all instructions between the current instruction and cursor position.



[F4]



Step Into



Execute the current C (single or multi–cycle) instruction, then halt. If the instruction is a routine call, enter the routine and halt at the first instruction following the call.



[F7]



Step Over



Execute the current C (single or multi–cycle) instruction, then halt.



[F8]



Step Out



Execute all remaining instructions in the current routine, return and then halt.



[Ctrl+F8]



Related topics: Run Menu, Debug Toolbar
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mikroC PRO for PIC allows you to create your own libraries. In order to create a library in mikroC PRO for PIC follow the steps bellow: 1. Create a new C source file, see Managing Source Files 2. Save the file in one of the subfolders of the compiler's Uses folder: DriveName:\Program Files\Mikroelektronika\mikroC PRO for PIC\Uses\P16\ DriveName:\Program Files\Mikroelektronika\mikroC PRO for PIC\Uses\P18\



If you are creating library for PIC16 MCU family the file should be saved in P16 folder. If you are creating library for PIC18 MCU family the file should be saved in P18 fodler. If you are creating library for PIC16 and PIC18 MCU families the file should be saved in both folders. 3. Write a code for your library and save it. 4. Add __Lib_Example file in some project, see Project Manager. Recompile the project. If you wish to use this library for all MCUs, then you should go to Tools › Options › Output settings, and check Build all files as library box. This will build libraries in a common form which will work with all MCUs. If this box is not checked, then library will be built for selected MCU. Bear in mind that compiler will report an error if a library built for specific MCU is used for another one. 5. Compiled file __Lib_Example.mcl should appear in ...\mikroC PRO for PIC\Uses\ folder. 6. Open the definition file for the MCU that you want to use. This file is placed in the compiler's Defs folder: DriveName:\Program Files\Mikroelektronika\mikroC PRO for PIC\Defs\



and it is named MCU_NAME.mlk, for example 16F887.mlk 7. Add the the following segment of code to node of the definition file (definition file is in XML format): Example_Library __Lib_Example REGULAR
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8. Add Library to mlk file for each MCU that you want to use with your library. 9. Click Refresh button in Library Manager 10. Example_Library should appear in the Library manager window.



Multiple Library Versions Library Alias represents unique name that is linked to corresponding Library .mcl file. For example UART library for 16F887 is different from UART library for 18F4520 MCU. Therefore, two different UART Library versions were made, see mlk files for these two MCUs. Note that these two libraries have the same Library Alias (UART) in both mlk files. This approach enables you to have identical representation of UART library for both MCUs in Library Manager. Related topics: Library Manager, Project Manager, Managing Source Files
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MIKROICD (IN-CIRCUIT DEBUGGER) mikroICD is highly effective tool for Real-Time debugging on hardware level. ICD debugger enables you to execute a mikroC PRO for PIC program on a host PIC microcontroller and view variable values, Special Function Registers (SFR), memory and EEPROM as the program is running.
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If you have appropriate hardware and software for using mikroICD, then, upon completion of writing your program, you will have to choose ICD Debug build type.



Step No. 2 You can run the mikroICD by selecting Run › Debug from the drop-down menu, or by clicking Debug Icon



. Starting the Debugger makes more options available:



Step Into, Step Over, Run to Cursor, etc. Line that is to be executed is color highlighted (blue by default). There is also notification about program execution and it can be found on Watch Window (yellow status bar). Note that some functions take time to execute, so running of program is indicated on Watch Window.
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Description



Function Key



Debug



Start Debugger.



[F9]



Run/Pause Debugger



Run or pause Debugger.



[F6]



Toggle Breakpoints



Toggle breakpoint at the current cursor position. To view all breakpoints, select Run > View Breakpoints from the drop–down menu. Double clicking an item in the Breakpoints Window List locates the breakpoint.



[F5]



Run to cursor



Execute all instructions between the current instruction and cursor position.



[F4]



Step Into



Execute the current C (single or multi–cycle) instruction, then halt. If the instruction is a routine call, enter the routine and halt at the first instruction following the call.



[F7]



Step Over



Execute the current C (single or multi–cycle) instruction, then halt. If the instruction is a routine call, skip it and halt at the first instruction following the call.



[F8]



Flush RAM



Flush current PIC RAM. All variable values will be changed according to values from watch window.



N/A



Disassembly View



Toggle between disassembly and C source view.



[Alt+D]



MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 3 mikroC PRO for PIC



mikroICD



mikroICD Debugger Examples Here is a step by step mikroICD Debugger Example. Step No.1 First you have to write a program. We will show how mikroICD works using this example: // LCD module connections sbit LCD_RS at RB4_bit; sbit LCD_EN at RB5_bit; sbit LCD_D4 at RB0_bit; sbit LCD_D5 at RB1_bit; sbit LCD_D6 at RB2_bit; sbit LCD_D7 at RB3_bit; sbit LCD_RS_Direction at TRISB4_bit; sbit LCD_EN_Direction at TRISB5_bit; sbit LCD_D4_Direction at TRISB0_bit; sbit LCD_D5_Direction at TRISB1_bit; sbit LCD_D6_Direction at TRISB2_bit; sbit LCD_D7_Direction at TRISB3_bit; // End LCD module connections char text[17] = "mikroElektronika"; char i; void main(){ PORTB = 0; TRISB = 0; ANSEL = 0; ANSELH = 0; Lcd_Init(); Lcd_Cmd(_LCD_CLEAR); Lcd_Cmd(_LCD_CURSOR_OFF); for(i = 1; i < 17; i++) { Lcd_Chr(1, i, text[i-1]); } }
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After successful compilation and PIC programming press F9 for starting mikroICD. After mikroICD initialization blue active line should appear:



Step No. 3 We will debug program line by line. Pressing F8 we are executing code line by line. It is recommended that user does not use Step Into [F7] and Step Over [F8] over Delays routines and routines containing delays. Instead use Run to cursor [F4] and Breakpoints functions. All changes are read from PIC and loaded into Watch Window. Note that PORTB, TRISB, ANSEL and ANSELH changed its values. 255 to 0.
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Step No. 4 Step Into [F7] and Step Over [F8] are mikroICD debugger functions that are used in stepping mode. There is also Real-Time mode supported by mikroICD. Functions that are used in Real-Time mode are Run/ Pause Debugger [F6] and Run to cursor [F4]. Pressing F4 goes to line selected by user. User just have to select line with cursor and press F4, and code will be executed until selected line is reached.



Step No. 5 Run(Pause) Debugger [F6] and Toggle Breakpoints [F5] are mikroICD debugger functions that are used in Real-Time mode. Pressing F5 marks line selected by user for breakpoint. F6 executes code until breakpoint is reached. After reaching breakpoint Debugger halts. Here at our example we will use breakpoints for writing "mikroElektronika" on Lcd char by char. Breakpoint is set on Lcd_Chr and program will stop everytime this function is reached. After reaching breakpoint we must press F6 again for continuing program execution.
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mikroC PRO for PIC Breakpoints has been separated into two groups. There are hardware and software break points. Hardware breakpoints are placed in PIC and they provide fastest debug. Number of hardware breakpoints is limited (1 for P16 and 1 or 3 for P18). If all hardware brekpoints are used, next breakpoints that will be used are software breakpoint. Those breakpoints are placed inside mikroICD, and they simulate hardware breakpoints. Software breakpoints are much slower than hardware breakpoints. This differences between hardware and software differences are not visible in mikroICD software but their different timings are quite notable, so it is important to know that there is two types of breakpoints.
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mikroICD (In-Circuit Debugger) Overview Breakpoints Window The Breakpoints window manages the list of currently set breakpoints in the project. Doubleclicking the desired breakpoint will cause cursor to navigate to the corresponding location in source code.
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Debugger Watch Window is the main Debugger window which allows you to monitor program items while running your program. To show the Watch Window, select View › Debug Windows › Watch Window from the drop-down menu. The Watch Window displays variables and registers of PIC, with their addresses and values. Values are updated as you go through the simulation. Use the drop-down menu to add and remove the items that you want to monitor. Recently changed items are colored red.
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Double clicking an item opens the Edit Value window in which you can assign a new value to the selected variable/register. Also, you can change view to binary, hex, char, or decimal for the selected item.



EEPROM Watch Window mikroICD EEPROM Watch Window is available from the drop-down menu, View › Debug Windows › View EEPROM. The EEPROM Watch window shows current values written into PIC internal EEPROM memory. There are two action buttons concerning EEPROM Watch window - Write EEPROM and Read EEPROM. Write EEPROM writes data from EEPROM Watch window into PIC internal EEPROM memory. Read EEPROM reads data from PIC internal EEPROM memory and loads it up in EEPROM window.
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mikroICD Code Watch Window is available from the drop-down menu, View › Debug Windows › View Code. The Code Watch window shows code (hex code) written into PIC. There is action button concerning Code Watch window - Read Code. Read Code reads code from PIC and loads it up in View Code Window. Also, you can set an address scope in which hex code will be read.
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View RAM Memory Debugger View RAM Window is available from the drop-down menu, View › Debug Windows › View RAM. The View RAM Window displays the map of PIC’s RAM, with recently changed items colored red.



Common Errors  Trying to program PIC while mikroICD is active.  Trying to debug Release build Type version of program.  Trying to debug changed program code which hasn't been compiled and pro grammed into PIC.  Trying to select line that is empty for Run to cursor [F4] and Toggle Breakpoints [F5] functions.  Trying to debug PIC with mikroICD while Watch Dog Timer is enabled.  Trying to debug PIC with mikroICD while Power Up Timer is enabled.  It is not possible to force Code Protect while trying to debug PIC with mikroICD.  Trying to debug PIC with mikroICD with pull-up resistors set to ON on RB6 and RB7.  For correct mikroICD debugging do not use pull-ups.
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mikroICD provides the possibility to use the Advanced Breakpoints. Advanced Breakpoints can be used with PIC18 and PIC18FJ MCUs. To enable Advanced Breakpoints set the Advanced Breakpoints checkbox inside Watch window:



To configure Advanced Breakpoints, start mikroICD [F9] and select View › Debug Windows › Advanced Breakpoints option from the drop-down menu or use [Ctrl+Shift+A] shortcut.



Note: When Advanced Breakpoints are enabled mikroICD operates in Real-Time mode, so it will support only the following set of commands: Start Debugger [F9], Run/Pause Debugger [F6] and Stop Debugger [Ctrl+F2]. Once the Advanced Breakpoint is reached, the Advanced Breakpoints feature can be disabled and mikroICD debugging can be continued with full set of commands. If needed, Advanced Breakepoints can be re-enabled without restarting mikroICD. Note: Number of Advanced Breakpoints is equal to number of Hardware breakpoints and it depends on used MCU.
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mikroICD



Program Memory Break Program Memory Break is used to set the Advanced Breakpoint to the specific address in program memory. Because of PIC pipelining mechanism program execution may stop one or two instructions after the address entered in the Address field. Value entered in the Address field must be in hex format. Note: Program Memory Break can use the Passcount option. The program execution will stop when the specified program address is reached for the N-th time, where N is the number entered in the Passcount field. When some Advanced Breakpoint stops the program execution, passcount counters for all Advanced Breakpoints will be cleared.



Program Memory Break Program Memory Break is used to set the Advanced Breakpoint to the specific address in program memory. Because of PIC pipelining mechanism program execution may stop one or two instructions after the address entered in the Address field. Value entered in the Address field must be in hex format. Note: Program Memory Break can use the Passcount option. The program execution will stop when the specified program address is reached for the N-th time, where N is the number entered in the Passcount field. When some Advanced Breakpoint stops the program execution, passcount counters for all Advanced Breakpoints will be cleared.



File Register Break File Register Break can be used to stop the code execution when read/write access to the specific data memory location occurs. If Read Access is selected, the File Register Equal option can be used to set the matching value. The program execution will be stopped when the value read from the specified data memory location is equal to the number written in the Value field. Values entered in the Address and Value fields must be in hex format. Note: File Register Break can also use the Passcount option in the same way as Program Memory Break.
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 Break on Stack Overflow/Underflow: not implemented.  Break on Watchdog Timer: not implemented.  Break on SLEEP: break on SLEEP instruction. SLEEP instruction will not be executed. If you choose to continue the mikroICD debugging [F6] then the program execution will start from the first instruction following the SLEEP instruction. Stopwatch Stopwatch uses Breakpoint#2 and Breakpoint#3 as a Start and Stop conditions. To use the Stopwatch define these two Breakpoints and check the Enable Stopwatch checkbox. Stopwatch options: Halt on Start Condition  Halt on Start Condition (Breakpoint#2): when checked, the program execution will stop on Breakpoint#2. Otherwise, Breakpoint#2 will be used only to start the Stopwatch.  Halt on Stop Condition (Breakpoint#3): when checked, the program execution will stop on Breakpoint#3. Otherwise, Breakpoint#3 will be used only to stop the Stopwatch.  Reset Stopwatch on Run: when checked, the Stopwatch will be cleared before continuing program execution and the next counting will start from zero. Otherwise, the next counting will start from the previous Stopwatch value
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mikroC PRO for PIC Specifics The following topics cover the specifics of mikroC PRO for PIC compiler: - ANSI Standard Issues - Predefined Globals and Constants - Accessing Individual Bits - Interrupts - PIC Pointers - Linker Directives - Built-in Routines - Code Optimization - Memory Type Specifiers
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Specifics ANSI Standard Issues Divergence from the ANSI C Standard - Tentative declarations are not supported.



C Language Exstensions mikroC PRO for PIC has additional set of keywords that do not belong to the ANSI standard C language keywords: -



code data rx at sbit bit sfr



Related topics: Keywords, PIC Specific



Predefined Globals and Constants To facilitate programming of PIC compliant MCUs, the mikroC PRO for PIC implements a number of predefined globals and constants. All PIC SFR registers and their bits are implicitly declared as global variables. These identifiers have an external linkage, and are visible in the entire project. When creating a project, the mikroC PRO for PIC will include an appropriate (*) file from defs folder, containing declarations of available SFR registers and constants. For a complete set of predefined globals and constants, look for “Defs” in the mikroC PRO for PIC installation folder, or probe the Code Assistant for specific letters (Ctrl+Space in the Code Editor).
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Predefined project level defines There are four predefined project level defines for any project you make. These defines are based on values that you have entered/edited in the current project: -



First one is equal to the name of selected device for the project i.e. if 16F887 is selected device, then 16F887 token will be defined as 1, so it can be used for conditional compilation: #ifdef P16F887 ... #endif



-



The second one is __FOSC__ value of frequency (in Khz) for which the project is built. Third one is for identifying mikroC PRO for PIC compiler: #ifdef __MIKROC_PRO_FOR_PIC__ ... #endif



-



Fourth one is for identifying the build version. For instance, if a desired build ver sion is 142, user should put this in his code: #if __MIKROC_PRO_FOR_PIC_BUILD__ == 142 ... #endif



User can define custom project level defines.



Accessing Individual Bits The mikroC PRO for PIC allows you to access individual bits of 8-bit variables. It also supports sbit and bit data types



Accessing Individual Bits Of Variables If you are familiar with a particular MCU, you can access bits by name: // Clear Global Interrupt Bit (GIE) GIE_bit = 0;



Also, you can simply use the direct member selector (.) with a variable, followed by one of identifiers B0, B1, … , B7, or F0, F1, … F7, with F7 being the most significant bit: // Clear bit 0 in INTCON register INTCON.B0 = 0; // Set bit 5 in ADCON0 register ADCON0.F5 = 1;
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There is no need of any special declarations. This kind of selective access is an intrinsic feature of mikroC PRO for PIC and can be used anywhere in the code. Identifiers B0–B7 are not case sensitive and have a specific namespace. You may override them with your own members B0–B7 within any given structure. See Predefined Globals and Constants for more information on register/bit names. Note: If aiming at portability, avoid this style of accessing individual bits, use the bit fields instead.



sbit type The mikroC PRO for PIC compiler has sbit data type which provides access to bitaddressable SFRs. You can access them in the following manner: sbit LEDA at PORTA.B0; sbit bit_name at sfr-name.B; sbit LEDB at PORTB.F0; sbit bit_name at sfr-name.F; // If you are familiar with a particular MCU and its ports and direction registers (TRIS), you can access bits by their names: sbit LEDC at RC0_bit; sbit bit_name at R_bit; sbit TRISC0 at TRISC0_bit; sbit bit_name at TRIS_bit;



bit type The mikroC PRO for PIC compiler provides a bit data type that may be used for variable declarations. It can not be used for argument lists, and function-return values. bit bf;



// bit variable



There are no pointers to bit variables: bit *ptr;



// invalid



An array of type bit is not valid: bit arr [5];
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// invalid
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Note: - Bit variables can not be initialized. - Bit variables can not be members of structures and unions. - Bit variables do not have addresses, therefore unary operator & (address of) is not applicable to these variables. Related topics: Bit fields, Predefined globals and constants



Interrupts Interrupts can be easily handled by means of reserved word interrupt. mikroC PRO for PIC implictly declares function interrupt which cannot be redeclared. Its prototype is: void interrupt(void);



For P18 low priorty interrupts reserved word is interrupt_low: void interrupt_low(void);



You are expected to write your own definition (function body) to handle interrupts in your application. mikroC PRO for PIC saves the following SFR on stack when entering interrupt and pops them back upon return: - PIC12 family: W, STATUS, FSR, PCLATH - PIC16 family: W, STATUS, FSR, PCLATH - PIC18 family: FSR (fast context is used to save WREG, STATUS, BSR) Use the #pragma disablecontexsaving to instruct the compiler not to automatically perform context-switching. This means that no regiser will be saved/restored by the compiler on entrance/exit from interrupt service routine. This enables the user to manually write code for saving registers upon entrance and to restore them before exit from interrupt.
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Specifics P18 priority interrupts



Note: For the P18 family both low and high interrupts are supported. 1. function with name interrupt will be linked as ISR (interrupt service routine) for high level interrupt 2. function with name interrupt_low will be linked as ISR for low level inter rupt_low If interrupt priority feature is to be used then the user should set the appropriate SFR bits to enable it. For more information refer to datasheet for specific device.



Function Calls from Interrupt Calling functions from within the interrupt() routine is now possible. The compiler takes care about the registers being used, both in "interrupt" and in "main" thread, and performs "smart" context-switching between the two, saving only the registers that have been used in both threads.Check functions reentrancy.



Interrupt Examples Here is a simple example of handling the interrupts from TMR0 (if no other interrupts are allowed): void interrupt() { counter++; TMR0 = 96; INTCON = $20; }



In case of multiple interrupts enabled, you need to test which of the interrupts occurred and then proceed with the appropriate code (interrupt handling): void interrupt() { if (INTCON.TMR0IF) { counter++; TMR0 = 96; INTCON.TMR0F = 0; } else if (INTCON.RBIF) { counter++; TMR0 = 96; INTCON.RBIF = 0; } }
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Linker Directives The mikroC PRO uses an internal algorithm to distribute objects within memory. If you need to have a variable or routine at specific predefined address, use the linker directives absolute and org.



Directive absolute Directive absolute specifies the starting address in RAM for a variable. If the variable is multi-byte, higher bytes will be stored at the consecutive locations. Directive absolute is appended to declaration of a variable: short x absolute 0x22; // Variable x will occupy 1 byte at address 0x22 int y absolute 0x23; // Variable y will occupy 2 bytes at addresses 0x23 and 0x24



Be careful when using the absolute directive, as you may overlap two variables by accident. For example: char i absolute 0x33; // Variable i will occupy 1 byte at address 0x33 long jjjj absolute 0x30; // Variable will occupy 4 bytes at 0x30, 0x31, 0x32, 0x33; thus, // changing i changes jjjj highest byte at the same time, and vice versa



Directive org Directive org specifies a starting address of a routine in ROM. Directive org is appended to the function definition. Directives applied to non-defining declarations will be ignored, with an appropriate warning issued by the linker. Here is a simple example: void func(int par) org 0x200 { // Function will start at address 0x200 asm nop; }



It is possible to use org directive with functions that are defined externally (such as library functions). Simply add org directive to function declaration: MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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Specifics void UART_Write1(char data) org 0x200;



Note: Directive org can be applied to any routine except for interrupt.



Directive orgall If the user wants to place his routines, constants, etc, above a specified address in ROM, #pragma orgall directive should be used: #pragma orgall 0x200



Directive funcorg You can use the #pragma funcorg directive to specify the starting address of a routine in ROM using routine name only: #pragma funcorg 







Related topics: Indirect Function Calls



Indirect Function Calls If the linker encounters an indirect function call (by a pointer to function), it assumes that any of the functions addresses of which were taken anywhere in the program, can be called at that point. Use the #pragma funcall directive to instruct the linker which functions can be called indirectly from the current function: #pragma funcall [, ,...]



A corresponding pragma must be placed in the source module where the function func_name is implemented. This module must also include declarations of all functions listed in the called_func list. These functions will be linked if the function func_name is called in the code no matter whether any of them was called or not. Note: The #pragma funcall directive can help the linker to optimize function frame allocation in the compiled stack. Related topics: Linker Directives
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Built-in Routines mikroC PRO for PIC compiler provides a set of useful built-in utility functions. Built-in functions do not require any header files to be included; you can use them in any part of your project. Built-in routines are implemented as “inline”; i.e. code is generated in the place of the call, so the call doesn’t count against the nested call limit. The only exceptions are Vdelay_ms, Delay_Cyc and Get_Fosc_kHz which are actual C routines. Note: Lo, Hi, Higher and Highest functions are not implemented in compiler any more. If you want to use these functions you must include built_in.h into your project. -



Lo Hi Higher Highest Delay_us Delay_ms Vdelay_ms Delay_Cyc Clock_Khz Clock_Mhz Get_Fosc_kHz



Lo Prototype



unsigned short Lo(long number);



Returns



Returns the lowest 8 bits (byte) of number, bits 0..7. Function returns the lowest byte of number. Function does not interpret bit patterns of number – it merely returns 8 bits as found in register.



Description This is an “inline” routine; code is generated in the place of the call, so the call doesn’t count against the nested call limit. Requires



Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).



Example



d = 0x1AC30F4; tmp = Lo(d); // Equals 0xF4
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Specifics Hi Prototype



unsigned short Hi(long number);



Returns



Returns next to the lowest byte of number, bits 8..15. Function returns next to the highest byte of number. Function does not interpret bit patterns of number – it merely returns 8 bits as found in register.



Description This is an “inline” routine; code is generated in the place of the call, so the call doesn’t count against the nested call limit. Requires



Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).



Example



d = 0x1AC30F4; tmp = Hi(d); // Equals 0x30



Higher Prototype



unsigned short Higher(long number);



Returns



Returns next to the highest byte of number, bits 16..23. Function returns the highest byte of number. Function does not interpret bit patterns of number – it merely returns 8 bits as found in register.



Description This is an “inline” routine; code is generated in the place of the call, so the call doesn’t count against the nested call limit.
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Requires



Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).



Example



d = 0x1AC30F4; tmp = Higher(d);



// Equals 0xAC
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Highest Prototype



unsigned short Highest(long number);



Returns



Returns the highest byte of number, bits 24..31. Function returns next to the highest byte of number. Function does not interpret bit patterns of number – it merely returns 8 bits as found in register.



Description This is an “inline” routine; code is generated in the place of the call, so the call doesn’t count against the nested call limit. Requires



Arguments must be variable of scalar type (i.e. Arithmetic Types and Pointers).



Example



d = 0x1AC30F4; tmp = Highest(d);



// Equals 0x01



Delay_us Prototype



void Delay_us(const time_in_us);



Returns



Nothing. Creates a software delay in duration of time_in_us microseconds (a constant). Range of applicable constants depends on the oscillator frequency.



Description This is an “inline” routine; code is generated in the place of the call, so the call doesn’t count against the nested call limit. This routine generates nested loops using registers R13, R12, R11 and R10. The number of used registers varies from 0 to 4, depending on requested time_in_us. Requires



Nothing.



Example



Delay_us(10);



/* Ten microseconds pause */
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Specifics Delay_ms Prototype



void Delay_ms(const time_in_ms);



Returns



Nothing. Creates a software delay in duration of time_in_ms milliseconds (a constant). Range of applicable constants depends on the oscillator frequency.



Description This is an “inline” routine; code is generated in the place of the call, so the call doesn’t count against the nested call limit. This routine generates nested loops using registers R13, R12, R11 and R10. The number of used registers varies from 0 to 4, depending on requested time_in_ms. Requires



Nothing.



Example



Delay_ms(1000);



/* One second pause */



Vdelay_ms Prototype



void Vdelay_ms(unsigned time_in_ms);



Returns



Nothing. Creates a software delay in duration of time_in_ms milliseconds (a variable). Generated delay is not as precise as the delay created by Delay_ms.



Description Note that Vdelay_ms is library function rather than a built-in routine; it is presented in this topic for the sake of convenience.
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Requires



Nothing.



Example



pause = 1000; // ... Vdelay_ms(pause);



// ~ one second pause
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Delay_Cyc Prototype



void Delay_Cyc(char Cycles_div_by_10);



Returns



Nothing. Creates a delay based on MCU clock. Delay lasts for 10 times the input parameter in MCU cycles.



Description



Note that Delay_Cyc is library function rather than a built-in routine; it is presented in this topic for the sake of convenience. There are limitations for Cycles_div_by_10 value. Value Cycles_div_by_10 must be between 3 and 255.



Requires



Nothing.



Example



Delay_Cyc(10);



/* Hundred MCU cycles pause */



Clock_Khz Prototype



unsigned Clock_Khz(void);



Returns



Device clock in KHz, rounded to the nearest integer. Function returns device clock in KHz, rounded to the nearest integer.



Description



This is an “inline” routine; code is generated in the place of the call, so the call doesn’t count against the nested call limit.



Requires



Nothing.



Example



clk = Clock_Khz();
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Specifics Clock_Mhz Prototype



unsigned short Clock_Mhz(void);



Returns



Device clock in MHz, rounded to the nearest integer. Function returns device clock in MHz, rounded to the nearest integer.



Description



This is an “inline” routine; code is generated in the place of the call, so the call doesn’t count against the nested call limit.



Requires



Nothing.



Example



clk = Clock_Mhz();



Get_Fosc_kHz Prototype



unsigned long Get_Fosc_kHz(void);



Returns



Device clock in KHz, rounded to the nearest integer. Function returns device clock in KHz, rounded to the nearest integer.



Description



Note that Get_Fosc_kHz is library function rather than a built-in routine; it is presented in this topic for the sake of convenience.



Requires



Nothing.



Example



clk = Clock_Khz();



Code Optimization Optimizer has been added to extend the compiler usability, cut down the amount of code generated and speed-up its execution. The main features are:



Constant folding All expressions that can be evaluated in the compile time (i.e. are constant) are being replaced by their results. (3 + 5 -> 8);



Constant propagation When a constant value is being assigned to a certain variable, the compiler recognizes this and replaces the use of the variable by constant in the code that follows, as long as the value of a variable remains unchanged.
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Copy propagation The compiler recognizes that two variables have the same value and eliminates one of them further in the code.



Value numbering The compiler "recognizes" if two expressions yield the same result and can therefore eliminate the entire computation for one of them.



"Dead code" elimination The code snippets that are not being used elsewhere in the programme do not affect the final result of the application. They are automatically removed.



Stack allocation Temporary registers ("Stacks") are being used more rationally, allowing VERY complex expressions to be evaluated with a minimum stack consumption.



Local vars optimization No local variables are being used if their result does not affect some of the global or volatile variables.



Better code generation and local optimization Code generation is more consistent and more attention is payed to implement specific solutions for the code "building bricks" that further reduce output code size. Related topics: PIC specifics, mikroC PRO for PIC specifics, Memory type specifiers
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PIC SPECIFICS In order to get the most from your mikroC PRO for PIC compiler, you should be familiar with certain aspects of PIC MCU. This knowledge is not essential, but it can provide you a better understanding of PICs’ capabilities and limitations, and their impact on the code writing.
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PIC Specifics Types Efficiency



First of all, you should know that PIC’s ALU, which performs arithmetic operations, is optimized for working with bytes. Although mikroC PRO for PIC is capable of handling very complex data types, PIC may choke on them, especially if you are working on some of the older models. This can dramatically increase the time needed for performing even simple operations. Universal advice is to use the smallest possible type in every situation. It applies to all programming in general, and doubly so with microcontrollers. Get to know your tool. When it comes down to calculus, not all PIC MCUs are of equal performance. For example, PIC16 family lacks hardware resources to multiply two bytes, so it is compensated by a software algorithm. On the other hand, PIC18 family has HW multiplier, and as a result, multiplication works considerably faster.



Nested Calls Limitations Nested call represents a function call within function body, either to itself (recursive calls) or to another function. Recursive function calls are supported by mikroC PRO for PIC but with limitations. Recursive function calls can't contain any function parameters and local variables due to the PIC’s stack and memory limitations. mikroC PRO for PIC limits the number of non-recursive nested calls to: - 8 calls for PIC12 family, - 8 calls for PIC16 family, - 31 calls for PIC18 family.



Note that some of the built-in routines do not count against this limit, due to their “inline” implementation. Number of the allowed nested calls decreases by one if you use any of the following operators in the code: * / %. It further decreases if you use interrupts in the program. Number of decreases is specified by number of functions called from interrupt. Check functions reentrancy. If the allowed number of nested calls is exceeded, the compiler will report a stack overflow error.
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PIC18FxxJxx Specifics Shared Address SFRs mikroC PRO for PIC does not provide auto setting of bit for acessing alternate register. This is new feature added to pic18fxxjxx family and will be supported in future. In several locations in the SFR bank, a single address is used to access two different hardware registers. In these cases, a “legacy” register of the standard PIC18 SFR set (such as OSCCON, T1CON, etc.) shares its address with an alternate register. These alternate registers are associated with enhanced configuration options for peripherals, or with new device features not included in the standard PIC18 SFR map. A complete list of shared register addresses and the registers associated with them is provided in datasheet.



PIC16 Specifics Breaking Through Pages In applications targeted at PIC16, no single routine should exceed one page (2,000 instructions). If routine does not fit within one page, linker will report an error. When confront with this problem, maybe you should rethink the design of your application – try breaking the particular routine into several chunks, etc.



Limits of Indirect Approach Through FSR Pointers with PIC16 are “near”: they carry only the lower 8 bits of the address. Compiler will automatically clear the 9th bit upon startup, so that pointers will refer to banks 0 and 1. To access the objects in banks 2 or 3 via pointer, user should manually set the IRP, and restore it to zero after the operation. The stated rules apply to any indirect approach: arrays, structures and unions assignments, etc.



Note: It is very important to take care of the IRP properly, if you plan to follow this approach. If you find this method to be inappropriate with too many variables, you might consider upgrading to PIC18. Note: If you have many variables in the code, try rearranging them with the linker directive absolute. Variables that are approached only directly should be moved to banks 3 and 4 for increased efficiency. Related topics: mikroC PRO for PIC specifics
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PIC Specifics MEMORY TYPE SPECIFIERS



The mikroC PRO for PIC supports usage of all memory areas. Each variable may be explicitly assigned to a specific memory space by including a memory type specifier in the declaration, or implicitly assigned. The following memory type specifiers can be used: -



code data rx sfr



Memory type specifiers can be included in variable declaration. For example: char data data_buffer; // puts data_buffer in data ram const char code txt[] = "ENTER PARAMETER:"; // puts text in program memory



code Description The code memory type may be used for allocating constants in program memory. Example



// puts txt in program memory const char code txt[] = "ENTER PARAMETER:";



data Description This memory specifier is used when storing variable to the internal data SRAM. Example



// puts PORTG in data ram sfr data unsigned short PORTG absolute 0x65;



rx This memory specifier allows variable to be stored in the Rx space (Register file). Description



Example
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Note: In most of the cases, there will be enough space left for the user variables in the Rx space. However, since compiler uses Rx space for storing temporary variables, it might happen that user variables will be stored in the internal data SRAM, when writing complex programs. // puts y in Rx space sfr char rx y;
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sfr This memory specifier in combination with (rx, data) allows user to access speDescription cial function registers. It also instructs compiler to maintain same identifier in C and assembly. Example



sfr rx char y;



Note: If none of the memory specifiers are used when declaring a variable, data specifier will be set as default by the compiler. Related topics: Accessing individual bits, SFRs, Constants, Functions
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mikroC PRO for PIC Language Reference The mikroC PRO for PIC Language Reference describes the syntax, semantics and implementation of the mikroC PRO for PIC language. The aim of this reference guide is to provide a more understandable description of the mikroC PRO for PIC language to the user.
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- Lexical Elements Whitespace Comments Tokens Constants Constants Overview Integer Constants Floating Point Constants Character Constants String Constants Enumeration Constants Pointer Constants Constant Expression Keywords Identifiers Punctuators - Concepts Objects and Lvalues Scope and Visibility Name Spaces Duration - Types Fundamental Types Arithmetic Types Enumerations Void Type Derived Types Arrays Pointers Introduction to Pointers Pointer Arithmetic Structures Introduction to Structures Working with Structures Structure Member Access Unions Bit Fields Type Conversions Standard Conversions Explicit Typecasting
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- Declarations Introduction to Declarations Linkage Storage Classes Type Qualifiers Typedef Specifier ASM Declaration Initialization - Functions Introduction to Functions Function Calls and Argument Conversion - Operators Introduction to Operators Operators Precedence and Associativity Arithmetic Operators Relational Operators Bitwise Operators Logical Opeartors Conditional Operators Assignment Operators Sizeof Operator - Expressions Introduction to Expressions Comma Expressions - Statements Introduction Labeled Statements Expression Statements Selection Statements If Statement Switch Statement Iteration Statements (Loops) While Statement Do Statement For Statement Jump Statements Break and Continue Statements Goto Statement Return Statement Compound Statements (Blocks) MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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- Preprocessor Introduction to Preprocessor Preprocessor Directives Macros File Inclusion Preprocessor Operators Conditional Compilation



142



MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 6 mikroC PRO for PIC



Language Reference



LEXICAL ELEMENTS OVERVIEW The following topics provide a formal definition of the mikroC PRO for PIC lexical elements. They describe different categories of word-like units (tokens) recognized by the mikroC PRO for PIC. In the tokenizing phase of compilation, the source code file is parsed (that is, broken down) into tokens and whitespace. The tokens in the mikroC PRO for PIC are derived from a series of operations performed on your programs by the compiler and its built-in preprocessor.



WHITESPACE Whitespace is a collective name given to spaces (blanks), horizontal and vertical tabs, newline characters and comments. Whitespace can serve to indicate where tokens start and end, but beyond this function, any surplus whitespace is discarded. For example, two sequences int i; float f;



and int i; float f;



are lexically equivalent and parse identically to give six tokens: int i ; float f ;
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The ASCII characters representing whitespace can occur within string literals. In that case they are protected from the normal parsing process (they remain as a part of the string). For example, char name[] = "mikro foo";



parses into seven tokens, including a single string literal token: char name [ ] = "mikro foo" ;



/* just one token here! */



Line Splicing with Backslash (\) A special case occurs if a line ends with a backslash (\). Both backslash and new line character are discarded, allowing two physical lines of a text to be treated as one unit. So, the following code "mikroC PRO \ for PIC Compiler"



parses into "mikroC PRO for PIC Compiler". Refer to String Constants for more information.
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COMMENTS Comments are pieces of a text used to annotate a program and technically are another form of whitespace. Comments are for the programmer’s use only; they are stripped from the source text before parsing. There are two ways to delineate comments: the C method and the C++ method. Both are supported by mikroC PRO for PIC. You should also follow the guidelines on the use of whitespace and delimiters in comments, discussed later in this topic to avoid other portability problems.



C comments C comment is any sequence of characters placed after the symbol pair /*. The comment terminates at the first occurance of the pair */ following the initial /*. The entire sequence, including four comment-delimiter symbols, is replaced by one space after macro expansion. In the mikroC PRO for PIC, int /* type */ i /* identifier */;



parses as: int i;



Note that the mikroC PRO for PIC does not support a nonportable token pasting strategy using /**/. For more information on token pasting, refer to the Preprocessor Operators.



C++ comments The mikroC PRO for PIC allows single-line comments using two adjacent slashes (//). The comment can start in any position and extends until the next new line. The following code int i; int j;



// this is a comment



parses as: int i; int j;
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Nested comments ANSI C doesn’t allow nested comments. The attempt to nest a comment like this /*



int /* declaration */ i; */



fails, because the scope of the first /* ends at the first */. This gives us i; */



which would generate a syntax error.
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TOKENS Token is the smallest element of a C program that compiler can recognize. The parser separates tokens from the input stream by creating the longest token possible using the input characters in a left–to–right scan. The mikroC PRO for PIC recognizes the following kinds of tokens: -



keywords identifiers constants operators punctuators (also known as separators)



Token Extraction Example Here is an example of token extraction. Take a look at the following example code sequence: inter =



a+++b;



First, note that inter would be parsed as a single identifier, rather than as the keyword int followed by the identifier er. The programmer who has written the code might have intended to write inter = a + (++b), but it wouldn’t work that way. The compiler would parse it into the seven following tokens: inter = a ++ + b ;



// // // // // // //



variable identifier assignment operator variable identifier postincrement operator addition operator variable identifier statement terminator



Note that +++ parses as ++ (the longest token possible) followed by +. According to the operator precedence rules, our code sequence is actually: inter (a++)+b;
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CONSTANTS Constants or literals are tokens representing fixed numeric or character values. The mikroC PRO for PIC supports: -



integer constants floating point constants character constants string constants (strings literals) enumeration constants



The data type of a constant is deduced by the compiler using such clues as a numeric value and format used in the source code.



Integer Constants Integer constants can be decimal (base 10), hexadecimal (base 16), binary (base 2), or octal (base 8). In the absence of any overriding suffixes, the data type of an integer constant is derived from its value.



Long and Unsigned Suffixes The suffix L (or l) attached to any constant forces that constant to be represented as a long. Similarly, the suffix U (or u) forces a constant to be unsigned. Both L and U suffixes can be used with the same constant in any order or case: ul, Lu, UL, etc. In the absence of any suffix (U, u, L, or l), a constant is assigned the “smallest” of the following types that can accommodate its value: short, unsigned short, int, unsigned int, long int, unsigned long int. Otherwise:  If a constant has the U suffix, its data type will be the first of the following that can accommodate its value: unsigned short, unsigned int, unsigned long int.



 If a constant has the L suffix, its data type will be the first of the following that can accommodate its value: long int, unsigned long int.  If a constant has both L and U suffixes, (LU or UL), its data type will be unsigned long int.
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Decimals Decimal constants from -2147483648 to 4294967295 are allowed. Constants exceeding these bounds will produce an “Out of range” error. Decimal constants must not use an initial zero. An integer constant that has an initial zero is interpreted as an octal constant. Thus, int i = 10; int i = 010; int i = 0;



/* decimal 10 */ /* decimal 8 */ /* decimal 0 = octal 0 */



In the absence of any overriding suffixes, the data type of a decimal constant is derived from its value, as shown below:



Value Assigned to Constant



Assumed Type



< -2147483648



Error: Out of range!



-2147483648 – -32769



long



-32768 – -129



int



-128 – 127



short



128 – 255



unsigned short



256 – 32767



int



32768 – 65535



unsigned int



65536 – 2147483647



long



2147483648 – 4294967295



unsigned long



> 4294967295



Error: Out of range!



Hexadecimal Constants All constants starting with 0x (or 0X) are taken to be hexadecimal. In the absence of any overriding suffixes, the data type of an hexadecimal constant is derived from its value, according to the rules presented above. For example, 0xC367 will be treated as unsigned int.
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All constants starting with 0b (or 0B) are taken to be binary. In the absence of any overriding suffixes, the data type of an binary constant is derived from its value, according to the rules presented above. For example, 0b11101 will be treated as short.



Octal Constants All constants with an initial zero are taken to be octal. If an octal constant contains the illegal digits 8 or 9, an error is reported. In the absence of any overriding suffixes, the data type of an octal constant is derived from its value, according to the rules presented above. For example, 0777 will be treated as int.



Floating Point Constants A floating-point constant consists of: - Decimal integer - Decimal point - Decimal fraction - e or E and a signed integer exponent (optional) - Type suffix: f or F or l or L (optional) Either decimal integer or decimal fraction (but not both) can be omitted. Either decimal point or letter e (or E) with a signed integer exponent (but not both) can be omitted. These rules allow conventional and scientific (exponent) notations. Negative floating constants are taken as positive constants with an unary operator minus (-) prefixed. The mikroC PRO for PIC limits floating-point constants to the range ±1.17549435082 * 10-38 .. ±6.80564774407 * 1038. Here are some examples: 0. -1.23 23.45e6 2e-5 3E+10 .09E34



// // // // // //



= = = = = =



0.0 -1.23 23.45 * 10^6 2.0 * 10^-5 3.0 * 10^10 0.09 * 10^34



The mikroC PRO for PIC floating-point constants are of the type double. Note that the mikroC PRO for PIC’s implementation of ANSI Standard considers float and double (together with the long double variant) to be the same type.
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Character Constants A character constant is one or more characters enclosed in single quotes, such as 'A', '+', or '\n'. In the mikroC PRO for PIC, single-character constants are of the unsigned int type. Multi-character constants are referred to as string constants or string literals. For more information refer to String Constants.



Escape Sequences A backslash character (\) is used to introduce an escape sequence, which allows a visual representation of certain nongraphic characters. One of the most common escape constants is the newline character (\n). A backslash is used with octal or hexadecimal numbers to represent an ASCII symbol or control code corresponding to that value; for example, '\x3F' for the question mark. Any value within legal range for data type char (0 to 0xFF for the mikroC PRO for PIC) can be used. Larger numbers will generate the compiler error “Out of range”. For example, the octal number \777 is larger than the maximum value allowed (\377) and will generate an error. The first nonoctal or nonhexadecimal character encountered in an octal or hexadecimal escape sequence marks the end of the sequence. Note: You must use the sequence \\ to represent an ASCII backslash, as used in operating system paths. The following table shows the available escape sequences: Sequence



Value



Char



Description



\a



0x07



BEL



Audible bell



\b



0x08



BS



Backspace



\f



0x0C



FF



Formfeed



\n



0x0A



LF



Newline (Linefeed)



\r



0x0D



CR



Carriage Return



\t



0x09



HT



Tab (horizontal)



\v



0x0B



VT



Vertical Tab



\\



0x5C



\



Backslash



\'



0x27



‘



Single quote (Apostrophe)



\"



0x22



‘’



Double quote



\?



0x3F



?



Question mark



\O



any



O = string of up to 3 octal digits



\xH



any



H = string of hex digits



\XH



any



H = string of hex digits
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Some ambiguous situations might arise when using escape sequences. Here is an example: Lcd_Out_Cp("\x091.0 Intro");



This is intended to be interpreted as \x09 and "1.0 Intro". However, the mikroC PRO for PIC compiles it as the hexadecimal number \x091 and literal string ".0 Intro". To avoid such problems, we could rewrite the code in the following way: Lcd_Out_Cp("\x09" "1.0 Intro");



For more information on the previous line, refer to String Constants. Ambiguities might also arise if an octal escape sequence is followed by a nonoctal digit. For example, the following constant: "\118"



would be interpreted as a two-character constant made up of the characters \11 and 8, because 8 is not a legal octal digit.



String Constants String constants, also known as string literals, are a special type of constants which store fixed sequences of characters. A string literal is a sequence of any number of characters surrounded by double quotes: "This is a string."



The null string, or empty string, is written like "". A literal string is stored internally as a given sequence of characters plus a final null character. A null string is stored as a single null character. The characters inside the double quotes can include escape sequences. This code, for example: "\t\"Name\"\\\tAddress\n\n"



prints like this: "Name"\
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The "Name" is preceded by two tabs; The Address is preceded by one tab. The line is followed by two new lines. The \" provides interior double quotes. The escape character sequence \\ is translated into \ by the compiler. Adjacent string literals separated only by whitespace are concatenated during the parsing phase. For example: "This is " "just" " an example."



is equivalent to "This is just an example."



Line Continuation with Backslash You can also use the backslash (\) as a continuation character to extend a string constant across line boundaries: "This is really \ a one-line string."



Enumeration Constants Enumeration constants are identifiers defined in enum type declarations. The identifiers are usually chosen as mnemonics to contribute to legibility. Enumeration constants are of int type. They can be used in any expression where integer constants are valid. For example: enum weekdays { SUN = 0, MON, TUE, WED, THU, FRI, SAT };



The identifiers (enumerators) used must be unique within the scope of the enum declaration. Negative initializers are allowed. See Enumerations for details about enum declarations.
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A pointer or pointed-at object can be declared with the const modifier. Anything declared as const cannot change its value. It is also illegal to create a pointer that might violate a non-assignability of the constant object. Consider the following examples: int i; // int * pi; // int * const cp = &i; // const int ci = 7; // const int * pci; // const int * const cpc = &ci;



i is an int pi is a pointer to int (uninitialized) cp is a constant pointer to int ci is a constant int pci is a pointer to constant int // cpc is a constant pointer to a // constant int



The following assignments are legal: i = ci; *cp = ci; ++pci; pci = cpc;



// // // // // //



Assign const-int to int Assign const-int to object-pointed-at-by-a-const-pointer Increment a pointer-to-const Assign a const-pointer-to-a-const to a pointer-to-const



The following assignments are illegal: ci = 0; ci--; *pci = 3; cp = &ci; cpc++; pi = pci;



// // // // // // // // // //



NO--cannot assign to a const-int NO--cannot change a const-int NO--cannot assign to an object pointed at by pointer-to-const. NO--cannot assign to a const-pointer, even if value would be unchanged. NO--cannot change const-pointer NO--if this assignment were allowed, you would be able to assign to *pci (a const value) by assigning to *pi.



Similar rules are applayed to the volatile modifier. Note that both const and volatile can appear as modifiers to the same identifier.
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Constant Expressions A constant expressions can be evaluated during translation rather that runtime and accordingly may be used in any place that a constant may be. Constant expressions can consist only of the following: -



literals, enumeration constants, simple constants (no constant arrays or structures), sizeof operators.



Constant expressions cannot contain any of the following operators, unless the operators are contained within the operand of a sizeof operator: assignment, comma, decrement, function call, increment. Each constant expression can evaluate to a constant that is in the range of representable values for its type. Constant expression can be used anywhere a constant is legal.



MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



155



CHAPTER 6



Language Reference



mikroC PRO for PIC



KEYWORDS Keywords are words reserved for special purposes and must not be used as normal identifier names. Beside standard C keywords, all relevant SFR are defined as global variables and represent reserved words that cannot be redefined (for example: TMR0, PCL, etc). Probe the Code Assistant for specific letters (Ctrl+Space in Editor) or refer to Predefined Globals and Constants. Here is an alphabetical listing of keywords in C: -



asm auto break case char const continue default do double else enum extern float for goto if int long register return short signed sizeof static struct switch typedef union unsigned void volatile while



Also, the mikroC PRO for PIC includes a number of predefined identifiers used in libraries. You could replace them by your own definitions, if you want to develop your own libraries. For more information, see mikroC PRO for PIC Libraries. MIKROELEKTRONIKA MIKROELEKTRONIKA - SOFTWARE - SOFTWARE AND HARDWARE AND HARDWARE SOLUTIONS SOLUTIONS FOR EMBEDDED FOR EMBEDDED WORLD WORLD 156
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IDENTIFIERS Identifiers are arbitrary names of any length given to functions, variables, symbolic constants, user-defined data types, and labels. All these program elements will be referred to as objects throughout the help (don't get confused with the meaning of object in object-oriented programming). Identifiers can contain the letters a to z and A to Z, underscore character “_”, and digits 0 to 9. The only restriction is that the first character must be a letter or an underscore.



Case Sensitivity The mikroC PRO for PIC identifiers aren't case sensitive by default, so that Sum, sum, and suM represent an equivalent identifier. Case sensitivity can be activated or suspended in Output Settings window. Even if case sensitivity is turned off Keywords remain case sensitive and they must be written in lower case.



Uniqueness and Scope Although identifier names are arbitrary (according to the stated rules), if the same name is used for more than one identifier within the same scope and sharing the same name space then error arises. Duplicate names are legal for different name spaces regardless of scope rules. For more information on scope, refer to Scope and Visibility.



Identifier Examples Here are some valid identifiers: temperature_V1 Pressure no_hit dat2string SUM3 _vtext



… and here are some invalid identifiers: 7temp %higher int j23.07.04



// // // //



NO NO NO NO



-----



cannot cannot cannot cannot



begin with a numeral contain special characters match reserved word contain special characters (dot)
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The mikroC PRO for PIC punctuators (also known as separators) are: -



[ ] – Brackets ( ) – Parentheses { } – Braces , – Comma ; – Semicolon : – Colon * – Asterisk = – Equal sign # – Pound sign



Most of these punctuators also function as operators.



Brackets Brackets [ ] indicate single and multidimensional array subscripts: char ch, str[] = "mikro"; int mat[3][4]; ch = str[3];



/* 3 x 4 matrix */ /* 4th element */



Parentheses Parentheses ( ) are used to group expressions, isolate conditional expressions, and indicate function calls and function parameters: d = c * (a + b); if (d == z) ++x; func(); void func2(int n);



/* override normal precedence */ /* essential with conditional statement */ /* function call, no args */ /* function declaration with parameters */



Parentheses are recommended in macro definitions to avoid potential precedence problems during an expansion: #define CUBE(x) ((x) * (x) * (x))



For more information, refer to Operators Precedence And Associativity and Expressions.
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Braces Braces { } indicate the start and end of a compound statement: if (d == z) { ++x; func(); }



Closing brace serves as a terminator for the compound statement, so a semicolon is not required after }, except in structure declarations. Sometimes, the semicolon can be illegal, as in if (statement) { ... }; else { ... };



/* illegal semicolon! */



For more information, refer to the Compound Statements.



Comma Comma (,) separates the elements of a function argument list: void func(int n, float f, char ch);



Comma is also used as an operator in comma expressions. Mixing two uses of comma is legal, but you must use parentheses to distinguish them. Note that (exp1, exp2) evalutates both but is equal to the second: func(i, j); /* call func with two args */ func((exp1, exp2), (exp3, exp4, exp5)); /* also calls func with two args! */



Semicolon Semicolon (;) is a statement terminator. Any legal C expression (including the empty expression) followed by a semicolon is interpreted as a statement, known as an expression statement. The expression is evaluated and its value is discarded. If the expression statement has no side effects, the mikroC PRO for PIC might ignore it. a + b; ++a; ;



/* Evaluate a + b, but discard value */ /* Side effect on a, but discard value of ++a */ /* Empty expression, or a null statement */
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For more information, see the Statements.



Colon Use colon (:) to indicate the labeled statement: start: x = 0; ... goto start;



Labels are discussed in the Labeled Statements.



Asterisk (Pointer Declaration) Asterisk (*) in a variable declaration denotes the creation of a pointer to a type: char *char_ptr;



/* a pointer to char is declared */



Pointers with multiple levels of indirection can be declared by indicating a pertinent number of asterisks: int **int_ptr; double ***double_ptr;



/* a pointer to an array of integers */ /* a pointer to a matrix of doubles */



You can also use asterisk as an operator to either dereference a pointer or as multiplication operator: i = *int_ptr; a = b * 3.14;



For more information, see the Pointers.



Equal Sign
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Equal sign (=) separates variable declarations from initialization lists: int test[5] = { 1, 2, 3, 4, 5 }; int x = 5;



Equal sign is also used as an assignment operator in expressions: int a, b, c; a = b + c;



For more information, see Assignment Operators.



Pound Sign (Preprocessor Directive) Pound sign (#) indicates a preprocessor directive when it occurs as the first nonwhitespace character on a line. It signifies a compiler action, not necessarily associated with a code generation. See the Preprocessor Directives for more information. # and ## are also used as operators to perform token replacement and merging dur-



ing the preprocessor scanning phase. See the Preprocessor Operators.
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CONCEPTS This section covers some basic concepts of language, essential for understanding of how C programs work. First, we need to establish the following terms that will be used throughout the help: -



Objects and lvalues Scope and Visibility Name Spaces Duration



Objects An object is a specific region of memory that can hold a fixed or variable value (or set of values). This use of a term object is different from the same term, used in object-oriented languages, which is more general. Our definiton of the word would encompass functions, variables, symbolic constants, user-defined data types, and labels. Each value has an associated name and type (also known as a data type). The name is used to access the object and can be a simple identifier or complex expression that uniquely refers the object.



Objects and Declarations Declarations establish a necessary mapping between identifiers and objects. Each declaration associates an identifier with a data type. Associating identifiers with objects requires each identifier to have at least two attributes: storage class and type (sometimes referred to as data type). The mikroC PRO for PIC compiler deduces these attributes from implicit or explicit declarations in the source code. Usually, only the type is explicitly specified and the storage class specifier assumes the automatic value auto. Generally speaking, an identifier cannot be legally used in a program before its declaration point in the source code. Legal exceptions to this rule (known as forward references) are labels, calls to undeclared functions, and struct or union tags. The range of objects that can be declared includes: - Variables - Functions - Types - Arrays of other types - Structure, union, and enumeration tags
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The recursive nature of the declarator syntax allows complex declarators. You’ll probably want to use typedefs to improve legibility if constructing complex objects.



Lvalues Lvalue is an object locator: an expression that designates an object. An example of lvalue expression is *P, where P is any expression evaluating to a non-null pointer. A modifiable lvalue is an identifier or expression that relates to an object that can be accessed and legally changed in memory. A const pointer to a constant, for example, is not a modifiable lvalue. A pointer to a constant can be changed (but its dereferenced value cannot). Historically, l stood for “left”, meaning that lvalue could legally stand on the left (the receiving end) of an assignment statement. Now only modifiable lvalues can legally stand to the left of an assignment operator. For example, if a and b are nonconstant integer identifiers with properly allocated memory storage, they are both modifiable lvalues, and assignments such as a = 1 and b = a + b are legal.



Rvalues The expression a + b is not lvalue: a + b = a is illegal because the expression on the left is not related to an object. Such expressions are sometimes called rvalues (short for right values).
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The scope of an identifier is a part of the program in which the identifier can be used to access its object. There are different categories of scope: block (or local), function, function prototype, and file. These categories depend on how and where identifiers are declared.  Block: The scope of an identifier with block (or local) scope starts at the declara tion point and ends at the end of the block containing the declaration (such block is known as the enclosing block). Parameter declarations with a function defini tion also have block scope, limited to the scope of the function body.  File: File scope identifiers, also known as globals, are declared outside of all blocks; their scope is from the point of declaration to the end of the source file.  Function: The only identifiers having function scope are statement labels. Label names can be used with goto statements anywhere in the function in which the label is declared. Labels are declared implicitly by writing label_name: fol lowed by a statement. Label names must be unique within a function.  Function prototype: Identifiers declared within the list of parameter declarations in a function prototype (not as a part of a function definition) have a function pro totype scope. This scope ends at the end of the function prototype.



Visibility The visibility of an identifier is a region of the program source code from which an identifier’s associated object can be legally accessed. Scope and visibility usually coincide, though there are circumstances under which an object becomes temporarily hidden by the appearance of a duplicate identifier: the object still exists but the original identifier cannot be used to access it until the scope of the duplicate identifier ends. Technically, visibility cannot exceed a scope, but a scope can exceed visibility. See the following example: void f (int i) { int j; j = 3; { double j; j = 0.1;



// auto by default // int i and j are in scope and visible // nested block // j is local name in the nested block // i and double j are visible; // int j = 3 in scope but hidden



}
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j += 1;



// double j out of scope // int j visible and = 4



} // i and j are both out of scope



Name Spaces Name space is a scope within which an identifier must be unique. The mikroC PRO for PIC uses four distinct categories of identifiers: 1. goto label names - must be unique within the function in which they are declared. 2. Structure, union, and enumeration tags - must be unique within the block in which they are defined. Tags declared outside of any function must be unique. 3. Structure and union member names - must be unique within the structure or union in which they are defined. There is no restriction on the type or offset of members with the same member name in different structures. 4. Variables, typedefs, functions, and enumeration members - must be unique with in the scope in which they are defined. Externally declared identifiers must be unique among externally declared variables. Duplicate names are legal for different name spaces regardless of the scope rules. For example: int blue = 73; { // open a block enum colors { black, red, green, blue, violet, white } c; /* enumerator blue = 3 now hides outer declaration of int blue */ struct colors { int i, j; }; double red = 2;



// ILLEGAL: colors duplicate tag // ILLEGAL: redefinition of red



} blue = 37;



// back in int blue scope



Duration Duration, closely related to a storage class, defines a period during which the declared identifiers have real, physical objects allocated in memory. We also distinguish between compile-time and run-time objects. Variables, for instance, unlike typedefs and types, have real memory allocated during run time. There are two kinds of duration: static and local.
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Memory is allocated to objects with static duration as soon as execution is underway; this storage allocation lasts until the program terminates. Static duration objects usually reside in fixed data segments allocated according to the memory specifier in force. All globals have static duration. All functions, wherever defined, are objects with static duration. Other variables can be given static duration by using the explicit static or extern storage class specifiers. In the mikroC PRO for PIC, static duration objects are not initialized to zero (or null) in the absence of any explicit initializer. Don’t mix static duration with file or global scope. An object can have static duration and local scope – see the example below.



Local Duration Local duration objects are also known as automatic objects. They are created on the stack (or in a register) when an enclosing block or a function is entered. They are deallocated when the program exits that block or function. Local duration objects must be explicitly initialized; otherwise, their contents are unpredictable. The storage class specifier auto can be used when declaring local duration variables, but it is usually redundant, because auto is default for variables declared within a block. An object with local duration also has local scope because it does not exist outside of its enclosing block. On the other hand, a local scope object can have static duration. For example: void f() { /* local duration variable; init a upon every call to f */ int a = 1; /* static duration variable; init b only upon first call to f */ static int b = 1; /* checkpoint! */ a++; b++; } void main() { /* At checkpoint, we will f(); // a=1, b=1, after f(); // a=1, b=2, after f(); // a=1, b=3, after // etc. }
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TYPES The mikroC PRO for PIC is a strictly typed language, which means that every object, function, and expression must have a strictly defined type, known in the time of compilation. Note that the mikroC PRO for PIC works exclusively with numeric types. The type serves:  to determine the correct memory allocation required initially.  to interpret the bit patterns found in the object during subsequent access. in many type-checking situations, to ensure that illegal assignments are trapped. The mikroC PRO for PIC supports many standard (predefined) and user-defined data types, including signed and unsigned integers in various sizes, floating-point numbers with various precisions, arrays, structures, and unions. In addition, pointers to most of these objects can be established and manipulated in memory. The type determines how much memory is allocated to an object and how the program will interpret the bit patterns found in the object’s storage allocation. A given data type can be viewed as a set of values (often implementation-dependent) that identifiers of that type can assume, together with a set of operations allowed with these values. The compile-time operator sizeof allows you to determine the size in bytes of any standard or user-defined type. The mikroC PRO for PIC standard libraries and your own program and header files must provide unambiguous identifiers (or expressions derived from them) and types so that the mikroC PRO for PIC can consistently access, interpret, and (possibly) change the bit patterns in memory corresponding to each active object in your program.



Type Categories A common way to categorize types is to divide them into: - fundamental - derived The fudamental types represent types that cannot be split up into smaller parts. They are sometimes referred to as unstructured types. The fundamental types are void, char, int, float, and double, together with short, long, signed, and unsigned variants of some of them. For more information on fundamental types, refer to the topic Fundamental Types. The derived types are also known as structured types and they include pointers to other types, arrays of other types, function types, structures, and unions. For more information on derived types, refer to the topic Derived Types. MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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Fundamental Types The fudamental types represent types that cannot be divided into more basic elements, and are the model for representing elementary data on machine level. The fudamental types are sometimes referred to as unstructured types, and are used as elements in creating more complex derived or user-defined types. The fundamental types include: - Arithmetic Types - Enumerations - Void Type



Arithmetic Types The arithmetic type specifiers are built up from the following keywords: void, char, int, float and double, together with the prefixes short, long, signed and unsigned. From these keywords you can build both integral and floating-point types.



Integral Types The types char and int, together with their variants, are considered to be integral data types. Variants are created by using one of the prefix modifiers short, long, signed and unsigned. In the table below is an overview of the integral types – keywords in parentheses can be (and often are) omitted. The modifiers signed and unsigned can be applied to both char and int. In the absence of the unsigned prefix, signed is automatically assumed for integral types. The only exception is char, which is unsigned by default. The keywords signed and unsigned, when used on their own, mean signed int and unsigned int, respectively. The modifiers short and long can only be applied to int. The keywords short and long, used on their own, mean short int and long int, respectively.
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Size in Bytes



Range



(unsigned) char



1



0 .. 255



signed char



1



- 128 .. 127



(signed) short (int)



1



- 128 .. 127



unsigned short (int)



1



0 .. 255



(signed) int



2



-32768 .. 32767



unsigned (int)



2



0 .. 65535



(signed) long (int)



4



-2147483648 .. 2147483647



unsigned long (int)



4



0 .. 4294967295



Floating-point Types The types float and double, together with the long double variant, are considered to be floating-point types. The mikroC PRO for PIC’s implementation of an ANSI Standard considers all three to be the same type. Floating point in the mikroC PRO for PIC is implemented using the Microchip AN575 32-bit format (IEEE 754 compliant). An overview of the floating-point types is shown in the table below: Type



Size in Bytes



Range



float



4



-1.5 * 1045 .. +3.4 * 1038



double



4



-1.5 * 1045 .. +3.4 * 1038



long double



4



-1.5 * 1045 .. +3.4 * 1038
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An enumeration data type is used for representing an abstract, discreet set of values with appropriate symbolic names.



Enumeration Declaration Enumeration is declared like this: enum tag {enumeration-list};



Here, tag is an optional name of the enumeration; enumeration-list is a commadelimited list of discreet values, enumerators (or enumeration constants). Each enumerator is assigned a fixed integral value. In the absence of explicit initializers, the first enumerator is set to zero, and the value of each succeeding enumerator is set to a value of its predecessor increased by one. Variables of the enum type are declared the same as variables of any other type. For example, the following declaration: enum colors { black, red, green, blue, violet, white } c;



establishes a unique integral type, enum colors, variable c of this type, and set of enumerators with constant integer values (black = 0, red = 1, ...). In the mikroC PRO for PIC, a variable of an enumerated type can be assigned any value of the type int – no type checking beyond that is enforced. That is: c = red; c = 1;



// OK // Also OK, means the same



With explicit integral initializers, you can set one or more enumerators to specific values. The initializer can be any expression yielding a positive or negative integer value (after possible integer promotions). Any subsequent names without initializers will be increased by one. These values are usually unique, but duplicates are legal. The order of constants can be explicitly re-arranged. For example: enum colors { black, red, green, blue=6, violet, white=4 };
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value value value value value value



0 1 2 6 7 4
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Initializer expression can include previously declared enumerators. For example, in the following declaration: enum memory_sizes { bit = 1, nibble = 4 * bit, byte = 2 * nibble, kilobyte = 1024 * byte };



nibble would acquire the value 4, byte the value 8, and kilobyte the value 8192.



Anomous Enum Type In our previous declaration, the identifier colors is an optional enumeration tag that can be used in subsequent declarations of enumeration variables of the enum colors type: enum colors bg, border;



/* declare variables bg and border */



Like with struct and union declarations, you can omit the tag if no further variables of this enum type are required: /* Anonymous enum type: */ enum { black, red, green, blue, violet, white } color;



Enumeration Scope Enumeration tags share the same name space as structure and union tags. Enumerators share the same name space as ordinary variable identifiers: int blue = 73; { // open a block enum colors { black, red, green, blue, violet, white } c; /* enumerator blue = 3 now hides outer declaration of int blue */ struct colors { int i, j; }; double red = 2;



// ILLEGAL: colors duplicate tag // ILLEGAL: redefinition of red



} blue = 37;



// back in int blue scope
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Void Type void is a special type indicating the absence of any value. There are no objects of void; instead, void is used for deriving more complex types.



Void Functions Use the void keyword as a function return type if the function does not return a value. void print_temp(char temp) { Lcd_Out_Cp("Temperature:"); Lcd_Out_Cp(temp); Lcd_Chr_Cp(223); // degree character Lcd_Chr_Cp('C'); }



Use void as a function heading if the function does not take any parameters. Alternatively, you can just write empty parentheses: main(void) { // same as main() ... }



Generic Pointers Pointers can be declared as void, which means that they can point to any type. These pointers are sometimes called generic.
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Derived Types The derived types are also known as structured types. They are used as elements in creating more complex user-defined types. The derived types include: -



arrays pointers structures unions



Arrays Array is the simplest and most commonly used structured type. A variable of array type is actually an array of objects of the same type. These objects represent elements of an array and are identified by their position in array. An array consists of a contiguous region of storage exactly large enough to hold all of its elements.



Array Declaration Array declaration is similar to variable declaration, with the brackets added after identifer: type array_name[constant-expression]



This declares an array named as array_name and composed of elements of type. The type can be any scalar type (except void), user-defined type, pointer, enumeration, or another array. Result of constant-expression within the brackets determines a number of elements in array. If an expression is given in an array declarator, it must evaluate to a positive constant integer. The value is a number of elements in an array. Each of the elements of an array is indexed from 0 to the number of elements minus one. If a number of elements is n, elements of array can be approached as variables array_name[0] .. array_name[n-1] of type. Here are a few examples of array declaration: #define MAX = 50 int vector_one[10]; /* declares an array of 10 integers */ float vector_two[MAX]; /* declares an array of 50 floats */ float vector_three[MAX - 20]; /* declares an array of 30 floats */
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An array can be initialized in declaration by assigning it a comma-delimited sequence of values within braces. When initializing an array in declaration, you can omit the number of elements – it will be automatically determined according to the number of elements assigned. For example: /* Declare an array which holds number of days in each month: */ int days[12] = {31,28,31,30,31,30,31,31,30,31,30,31}; /* This declaration is identical to the previous one */ int days[] = {31,28,31,30,31,30,31,31,30,31,30,31};



If you specify both the length and starting values, the number of starting values must not exceed the specified length. The opposite is possible, in this case the trailing “excess” elements will be assigned to some encountered runtime values from memory. In case of array of char, you can use a shorter string literal notation. For example: /* The two declarations are identical: */ const char msg1[] = {'T', 'e', 's', 't', '\0'}; const char msg2[] = "Test";



For more information on string literals, refer to String Constants.



Arrays n Expressions When the name of an array comes up in expression evaluation (except with operators & and sizeof), it is implicitly converted to the pointer pointing to array’s first element. See Arrays and Pointers for more information.



Multi-dimensional Arrays An array is one-dimensional if it is of scalar type. One-dimensional arrays are sometimes referred to as vectors. Multidimensional arrays are constructed by declaring arrays of array type. These arrays are stored in memory in such way that the right most subscript changes fastest, i.e. arrays are stored “in rows”. Here is a sample of 2-dimensional array: float m[50][20];



/* 2-dimensional array of size 50x20 */



A variable m is an array of 50 elements, which in turn are arrays of 20 floats each. Thus, we have a matrix of 50x20 elements: the first element is m[0][0], the last one
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is m[49][19]. The first element of the 5th row would be m[4][0]. If you don't initialize the array in the declaration, you can omit the first dimension of multi-dimensional array. In that case, array is located elsewhere, e.g. in another file. This is a commonly used technique when passing arrays as function parameters: int a[3][2][4];



/* 3-dimensional array of size 3x2x4 */



void func(int n[][2][4]) { /* we can omit first dimension */ ... n[2][1][3]++; /* increment the last element*/ } void main() { ... func(a); }



You can initialize a multi-dimensional array with an appropriate set of values within braces. For example: int a[3][2] = {{1,2}, {2,6}, {3,7}};



Pointers Pointers are special objects for holding (or “pointing to”) memory addresses. In the mikroC PRO for PIC, address of an object in memory can be obtained by means of an unary operator &. To reach the pointed object, we use an indirection operator (*) on a pointer. A pointer of type “pointer to object of type” holds the address of (that is, points to) an object of type. Since pointers are objects, you can have a pointer pointing to a pointer (and so on). Other objects commonly pointed to include arrays, structures, and unions. A pointer to a function is best thought of as an address, usually in a code segment, where that function’s executable code is stored; that is, the address to which control is transferred when that function is called. Although pointers contain numbers with most of the characteristics of unsigned integers, they have their own rules and restrictions for declarations, assignments, conversions, and arithmetic. The examples in the next few sections illustrate these rules and restrictions.



MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



175



CHAPTER 6 mikroC PRO for PIC



Language Reference Pointer Declarations



Pointers are declared the same as any other variable, but with * ahead of identifier. A type at the beginning of declaration specifies the type of a pointed object. A pointer must be declared as pointing to some particular type, even if that type is void, which really means a pointer to anything. Pointers to void are often called generic pointers, and are treated as pointers to char in the mikroC PRO for PIC. If type is any predefined or user-defined type, including void, the declaration type *p;



/* Uninitialized pointer */



declares p to be of type “pointer to type”. All scoping, duration, and visibility rules are applied to the p object just declared. You can view the declaration in this way: if *p is an object of type, then p has to be a pointer to such object (object of type). Note: You must initialize pointers before using them! Our previously declared pointer *p is not initialized (i.e. assigned a value), so it cannot be used yet. Note: In case of multiple pointer declarations, each identifier requires an indirect operator. For example: int *pa, *pb, *pc; /* is same as: */ int *pa; int *pb; int *pc;



Once declared, though, a pointer can usually be reassigned so that it points to an object of another type. The mikroC PRO for PIC lets you reassign pointers without typecasting, but the compiler will warn you unless the pointer was originally declared to be pointing to void. You can assign the void* pointer to the non-void* pointer – refer to void for details.
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Null Pointers A null pointer value is an address that is guaranteed to be different from any valid pointer in use in a program. Assigning the integer constant 0 to a pointer assigns a null pointer value to it. For example: int *pn = 0;



/* Here's one null pointer */



/* We can test the pointer like this: */ if ( pn == 0 ) { ... }



The pointer type “pointer to void” must not be confused with the null pointer. The declaration void *vp;



declares that vp is a generic pointer capable of being assigned to by any “pointer to type” value, including null, without complaint. Assignments without proper casting between a “pointer to type1” and a “pointer to type2”, where type1 and type2 are different types, can invoke a compiler warning or error. If type1 is a function and type2 isn’t (or vice versa), pointer assignments are illegal. If type1 is a pointer to void, no cast is needed. If type2 is a pointer to void, no cast is needed.



Function Pointers Function Pointers are pointers, i.e. variables, which point to the address of a function. // Define a function pointer int (*pt2Function) (float, char, char);



Note: Thus functions and function pointers with different calling convention (argument order, arguments type or return type is different) are incompatible with each other.
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Assign an address to a Function Pointer It's quite easy to assign the address of a function to a function pointer. Simply take the name of a suitable and known function. Using the address operator & infront of the function's name is optional. //Assign an address to the function pointer int DoIt (float a, char b, char c){ return a+b+c; } pt2Function = &DoIt; // assignment



Example: int addC(char x,char y){ return x+y; } int subC(char x,char y){ return x-y; } int mulC(char x,char y){ return x*y; } int divC(char x,char y){ return x/y; } int modC(char x,char y){ return x%y; } //array of pointer to functions that receive two chars and returns int int (*arrpf[])(char,char) = { addC ,subC,mulC,divC,modC}; int res; char i; void main() { for (i=0;i (c + d)) ? (a + b) : (c + d) */



It is highly recommended to put parentheses around each argument in the macro body in order to avoid possible problems with operator precedence.



Undefining Macros The #undef directive is used to undefine a macro. #undef macro_identifier



The directive #undef detaches any previous token sequence from macro_identifier; the macro definition has been forgotten, and macro_identifier is undefined. No macro expansion occurs within the #undef lines. The state of being defined or undefined is an important property of an identifier, regardless of the actual definition. The #ifdef and #ifndef conditional directives, used to test whether any identifier is currently defined or not, offer a flexible mechanism for controlling many aspects of a compilation. After a macro identifier has been undefined, it can be redefined with #define, using the same or different token sequence.



File Inclusion The preprocessor directive #include pulls in header files (extension .h) into the source code. Do not rely on preprocessor to include source files (extension ) — see Add/Remove Files from Project for more information. The syntax of the #include directive has two formats: #include #include "header_name"



The preprocessor removes the #include line and replaces it with the entire text of a header file at that point in the source code. The placement of #include can therefore influence the scope and duration of any identifiers in the included file. The difference between these two formats lies in searching algorithm employed in MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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trying to locate the include file. If the #include directive is used with the version, the search is made successively in each of the following locations, in this particular order: 1. the mikroC PRO for PIC installation folder › “include” folder 2. user's custom search paths The "header_name" version specifies a user-supplied include file; the mikroC PRO for PIC will look for the header file in the following locations, in this particular order: 1. the project folder (folder which contains the project file .mcppi) 2. the mikroC PRO for PIC installation folder › “include” folder 3. user's custom search paths



Explicit Path By placing an explicit path in header_name, only that directory will be searched. For example: #include "C:\my_files\test.h"



Note There is also a third version of the #include directive, rarely used, which assumes that neither < nor “ appear as the first non-whitespace character following #include: #include macro_identifier



It assumes that macro definition that will expand macro identifier into a valid delimited header name with either or "header_name" formats exists.
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Preprocessor Operators The # (pound sign) is a preprocessor directive when it occurs as the first non-whitespace character on a line. Also, # and ## perform operator replacement and merging during the preprocessor scanning phase.



Operator # In C preprocessor, a character sequence enclosed by quotes is considered a token and its content is not analyzed. This means that macro names within quotes are not expanded. If you need an actual argument (the exact sequence of characters within quotes) as a result of preprocessing, use the # operator in macro body. It can be placed in front of a formal macro argument in definition in order to convert the actual argument to a string after replacement. For example, let’s have macro LCD_PRINT for printing variable name and value on Lcd: #define LCD_PRINT(val) Lcd_Custom_Out_Cp(#val ": "); \ Lcd_Custom_Out_Cp(IntToStr(val));



Now, the following code, LCD_PRINT(temp)



will be preprocessed to this: Lcd_Custom_Out_Cp("temp" ": "); Lcd_Custom_Out_Cp(IntToStr(temp));



Operator ## Operator ## is used for token pasting. Two tokens can be pasted(merged) together by placing ## in between them (plus optional whitespace on either side). The preprocessor removes whitespace and ##, combining the separate tokens into one new token. This is commonly used for constructing identifiers. For example, see the definition of macro SPLICE for pasting two tokens into one identifier: #define SPLICE(x,y) x ## _ ## y



Now, the call SPLICE(cnt,2) will expand to the identifier cnt_2. MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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Note The mikroC PRO for PIC does not support the older nonportable method of token pasting using (l/**/r).



Conditional Compilation Conditional compilation directives are typically used to make source programs easy to change and easy to compile in different execution environments. The mikroC PRO for PIC supports conditional compilation by replacing the appropriate sourcecode lines with a blank line. All conditional compilation directives must be completed in the source or include file in which they have begun.



Directives #if, #elif, #else and #endif The conditional directives #if, #elif, #else, and #endif work very similar to the common C conditional statements. If the expression you write after #if has a nonzero value, the line group immediately following the #if directive is retained in the translation unit. The syntax is: #if constant_expression_1 [#elif constant_expression_2 ] ... [#elif constant_expression_n ] [#else ] #endif



Each #if directive in a source file must be matched by a closing #endif directive. Any number of #elif directives can appear between #if and #endif directives, but at most one #else directive is allowed. The #else directive, if present, must be the last directive before #endif. sections can be any program text that has meaning to compiler or preprocessor. The preprocessor selects a single section by evaluating constant_expression fol-
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lowing each #if or #elif directive until it finds a true (nonzero) constant expression. The constant expressions are subject to macro expansion. If all occurrences of constant-expression are false, or if no #elif directives appear, the preprocessor selects the text block after the #else clause. If the #else clause is omitted and all instances of constant_expression in the #if block are false, no section is selected for further processing. Any processed section can contain further conditional clauses, nested to any depth. Each nested #else, #elif, or #endif directive belongs to the closest preceding the #if directive. The net result of the preceding scenario is that only one code section (possibly empty) will be compiled.



Directives #ifdef and #ifndef The #ifdef and #ifndef directives can be used anywhere #if can be used and they can test whether an identifier is currently defined or not. The line #ifdef identifier



has exactly the same effect as #if 1 if identifier is currently defined, and the same effect as #if 0 if identifier is currently undefined. The other directive, #ifndef, tests true for the “not-defined” condition, producing the opposite results. The syntax thereafter follows that of #if, #elif, #else, and #endif. An identifier defined as NULL is considered to be defined.
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Libraries mikroC PRO for PIC provides a set of libraries which simplify the initialization and use of PIC compliant MCUs and their modules: Use Library manager to include mikroC PRO for PIC Libraries in you project.
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Libraries Hardware PIC-specific Libraries - ADC Library - CAN Library - CANSPI Library - Compact Flash Library - EEPROM Library - Ethernet PIC18FxxJ60 Library - Flash Memory Library - Graphic LCD Library - I2C Library - Keypad Library - LCD Library - Manchester Code Library - Muliti Media Card Libray - OneWire Library - Port Expander Library - PrintOut Library - PS/2 Library - PWM Library - RS-485 Library - Software I2C Library - Software SPI Library - Software UART Library - Sound Library - SPI Library - SPI Ethernet Library - SPI Graphic LCD Library - SPI LCD Library - SPI LCD8 Library - SPI T6963C Graphic LCD Library - T6963C Graphic LCD Library - UART Library - USB HID Library



Standard ANSI C Libraries - ANSI - ANSI - ANSI - ANSI



C C C C



Ctype Library Math Library Stdlib Library String Library



Miscellaneous Libraries - Button Library - Conversions Library - Sprint Library - Setjmp Library - Time Library - Trigonometry Library See also Built-in Routines.
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LIBRARY DEPENDENCIES Certain libraries use (depend on) function and/or variables, constants defined in other libraries. Image below shows clear representation about these dependencies. For example, SPI_Glcd uses Glcd_Fonts and Port_Expander library which uses SPI library. This means that if you check SPI_Glcd library in Library manager, all libraries on which it depends will be checked too.



Related topics: Library manager, PIC Libraries MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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Libraries HARDWARE LIBRARIES - ADC Library - CAN Library - CANSPI Library - Compact Flash Library - EEPROM Library - Ethernet PIC18FxxJ60 Library - Flash Memory Library - Graphic Lcd Library - I˛C Library - Keypad Library - Lcd Library - Manchester Code Library - Multi Media Card Library - OneWire Library - Port Expander Library - PrintOut Library - PS/2 Library - PWM Library - RS-485 Library - Software I˛C Library - Software SPI Library - Software UART Library - Sound Library - SPI Library - SPI Ethernet Library - SPI Graphic Lcd Library - SPI Lcd Library - SPI Lcd8 Library - SPI T6963C Graphic Lcd Library - T6963C Graphic Lcd Library - UART Library - USB HID Library
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ADC LIBRARY ADC (Analog to Digital Converter) module is available with a number of PIC MCU models. Library function ADC_Read is included to provide you comfortable work with the module.



ADC_Read Prototype



unsigned ADC_Read(unsigned short channel);



Returns



10-bit unsigned value read from the specified channel. Initializes PIC’s internal ADC module to work with RC clock. Clock determines the time period necessary for performing AD conversion (min 12TAD).



Description



Parameter channel represents the channel from which the analog value is to be acquired. Refer to the appropriate datasheet for channel-to-pin mapping.



Requires



Nothing.



Example



unsigned tmp; ... tmp = ADC_Read(2);



// Read analog value from channel 2



Library Example This example code reads analog value from channel 2 and displays it on PORTB and PORTC. unsigned int temp_res; void main() { ANSEL = 0x04; TRISA = 0xFF; ANSELH = 0; TRISC = 0x3F; TRISB = 0; do { temp_res = ADC_Read(2); PORTB = temp_res; PORTC = temp_res >> 2; } while(1);



// // // // //



Configure AN2 pin as analog PORTA is input Configure other AN pins as digital I/O Pins RC7, RC6 are outputs PORTB is output



// Get 10-bit results of AD conversion // Send lower 8 bits to PORTB // Send 2 most significant bits to RC7, RC6



}
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ADC HW connection



CAN LIBRARY mikroC PRO for PIC provides a library (driver) for working with the CAN module. CAN is a very robust protocol that has error detection and signalling, self–checking and fault confinement. Faulty CAN data and remote frames are re-transmitted automatically, similar to the Ethernet. Data transfer rates vary from up to 1 Mbit/s at network lengths below 40m to 250 Kbit/s at 250m cables, and can go even lower at greater network distances, down to 200Kbit/s, which is the minimum bitrate defined by the standard. Cables used are shielded twisted pairs, and maximum cable length is 1000m. CAN supports two message formats:  Standard format, with 11 identifier bits, and  Extended format, with 29 identifier bits Note: CAN Library is supported only by MCUs with the CAN module. Note: Consult the CAN standard about CAN bus termination resistance.
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Library Routines        



CANSetOperationMode CANGetOperationMode CANInitialize CANSetBaudRate CANSetMask CANSetFilter CANRead CANWrite



Following routines are for the internal use by compiler only:  RegsToCANID  CANIDToRegs Be sure to check CAN constants necessary for using some of the functions.



CANSetOperationMode Prototype



void CANSetOperationMode(unsigned short mode, unsigned short wait_flag);



Returns



Nothing. Sets CAN to requested mode, i.e. copies mode to CANSTAT. Parameter mode needs to be one of CAN_OP_MODE constants (see CAN constants). Parameter wait_flag needs to be either 0 or 0xFF:



Description



 If set to 0xFF, this is a blocking call – the function won’t “return” until the requested mode is set.  If 0, this is a non-blocking call. It does not verify if CAN module is switched to requested mode or not. Caller must use CANGetOperationMode to verify correct operation mode before performing mode specific operation.



Requires



CAN routines are currently supported only by P18XXX8 PIC MCUs. Microcontroller must be connected to CAN transceiver (MCP2551 or similar) which is connected to CAN bus.



Example



CANSetOperationMode(_CAN_MODE_CONFIG, 0xFF);
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Libraries CANGetOperationMode Prototype



unsigned short CANGetOperationMode();



Returns



Current opmode.



Description Function returns current operational mode of CAN module. Requires



CAN routines are currently supported only by P18XXX8 PIC MCUs. Microcontroller must be connected to CAN transceiver (MCP2551 or similar) which is connected to CAN bus.



Example



if (CANGetOperationMode() == _CAN_MODE_NORMAL) { ... };



CANInitialize Prototype



void CANInitialize(char SJW, char BRP, char PHSEG1, char PHSEG2, char PROPSEG, char CAN_CONFIG_FLAGS);



Returns



Nothing. Initializes CAN. All pending transmissions are aborted. Sets all mask registers to 0 to allow all messages. The Config mode is internaly set by this function. Upon a execution of this function Normal mode is set. Filter registers are set according to flag value:



Description



if (CAN_CONFIG_FLAGS & _CAN_CONFIG_VALID_XTD_MSG != 0) // Set all filters to XTD_MSG else if (config & _CAN_CONFIG_VALID_STD_MSG != 0) // Set all filters to STD_MSG else // Set half the filters to STD, and the rest to XTD_MSG



Parameters:  SJW as defined in 18XXX8 datasheet (1–4)  BRP as defined in 18XXX8 datasheet (1–64)  PHSEG1 as defined in 18XXX8 datasheet (1–8)  PHSEG2 as defined in 18XXX8 datasheet (1–8)  PROPSEG as defined in 18XXX8 datasheet (1–8)  CAN_CONFIG_FLAGS is formed from predefined constants (see CAN constants)
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Requires



CAN routines are currently supported only by P18XXX8 PIC MCUs. Microcontroller must be connected to CAN transceiver (MCP2551 or similar) which is connected to CAN bus.



Example



init = _CAN_CONFIG_SAMPLE_THRICE & _CAN_CONFIG_PHSEG2_PRG_ON & _CAN_CONFIG_STD_MSG & _CAN_CONFIG_DBL_BUFFER_ON & _CAN_CONFIG_VALID_XTD_MSG & _CAN_CONFIG_LINE_FILTER_OFF; ... CANInitialize(1, 1, 3, 3, 1, init);



// initialize CAN
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CANSetBoudRate Prototype



void CANSetBaudRate(char SJW, char BRP, char PHSEG1, char PHSEG2, char PROPSEG, char CAN_CONFIG_FLAGS);



Returns



Nothing. Sets CAN baud rate. Due to complexity of CAN protocol, you cannot simply force a bps value. Instead, use this function when CAN is in Config mode. Refer to datasheet for details. Parameters:



Description      



SJW as defined in 18XXX8 datasheet (1–4) BRP as defined in 18XXX8 datasheet (1–64) PHSEG1 as defined in 18XXX8 datasheet (1–8) PHSEG2 as defined in 18XXX8 datasheet (1–8) PROPSEG as defined in 18XXX8 datasheet (1–8) CAN_CONFIG_FLAGS is formed from predefined constants (see CAN constants)



Requires



CAN must be in Config mode; otherwise the function will be ignored. CAN routines are currently supported only by P18XXX8 PIC MCUs. Microcontroller must be connected to CAN transceiver (MCP2551 or similar) which is connected to CAN bus.



Example



init = _CAN_CONFIG_SAMPLE_THRICE & _CAN_CONFIG_PHSEG2_PRG_ON & _CAN_CONFIG_STD_MSG & _CAN_CONFIG_DBL_BUFFER_ON & _CAN_CONFIG_VALID_XTD_MSG & _CAN_CONFIG_LINE_FILTER_OFF; ... CANSetBaudRate(1, 1, 3, 3, 1, init);
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void CANSetFilter(char CAN_FILTER, long value, char CAN_CONFIG_FLAGS);



Returns



Nothing. Function sets mask for advanced filtering of messages. Given value is bit adjusted to appropriate buffer mask registers. Parameters:



Description  CAN_MASK is one of predefined constant values (see CAN constants)  value is the mask register value  CAN_CONFIG_FLAGS selects type of message to filter, either _CAN_CONFIG_XTD_MSG or _CAN_CONFIG_STD_MSG



Requires



CAN must be in Config mode; otherwise the function will be ignored. CAN routines are currently supported only by P18XXX8 PIC MCUs. Microcontroller must be connected to CAN transceiver (MCP2551 or similar) which is connected to CAN bus.



Example



// Set all mask bits to 1, i.e. all filtered bits are relevant: CANSetMask(_CAN_MASK_B1, -1, _CAN_CONFIG_XTD_MSG); // Note that -1 is just a cheaper way to write 0xFFFFFFFF. Complement will do the trick and fill it up with ones.



CANSetFilter Prototype



void CANSetFilter(char CAN_FILTER, long value, char CAN_CONFIG_FLAGS);



Returns



Nothing. Function sets message filter. Given value is bit adjusted to appropriate buffer mask registers. Parameters:



Description  CAN_FILTER is one of predefined constant values (see CAN constants)  value is the filter register value  CAN_CONFIG_FLAGS selects type of message to filter, either _CAN_CONFIG_XTD_MSG or
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_CAN_CONFIG_STD_MSG



Requires



CAN must be in Config mode; otherwise the function will be ignored. CAN routines are currently supported only by P18XXX8 PIC MCUs. Microcontroller must be connected to CAN transceiver (MCP2551 or similar) which is connected to CAN bus.



Example



// Set id of filter B1_F1 to 3: CANSetFilter(_CAN_FILTER_B1_F1, 3, _CAN_CONFIG_XTD_MSG);
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CANRead Prototype



char CANRead(long *id, char *data, char *datalen, char *CAN_RX_MSG_FLAGS);



Returns



Message from receive buffer or zero if no message found. Function reads message from receive buffer. If at least one full receive buffer is found, it is extracted and returned. If none found, function returns zero. Parameters:



Description    



id is message identifier data is an array of bytes up to 8 bytes in length datalen is data length, from 1–8.



CAN_RX_MSG_FLAGS is value formed from constants (see CAN constants)



Requires



CAN must be in mode in which receiving is possible. CAN routines are currently supported only by P18XXX8 PIC MCUs. Microcontroller must be connected to CAN transceiver (MCP2551 or similar) which is connected to CAN bus.



Example



char rcv, rx, len, data[8]; long id; // ... rx = 0; // ... rcv = CANRead(id, data, len, rx);



CANWrite Prototype



unsigned short CANWrite(long id, char *data, char datalen, char CAN_TX_MSG_FLAGS);



Returns



Returns zero if message cannot be queued (buffer full).



If at least one empty transmit buffer is found, function sends message on queue for transmission. If buffer is full, function returns 0. Parameters:  id is CAN message identifier. Only 11 or 29 bits may be used depending on Description message type (standard or extended)  data is array of bytes up to 8 bytes in length  datalen is data length from 1–8  CAN_TX_MSG_FLAGS is value formed from constants (see CAN constants) Requires



CAN must be in Normal mode. CAN routines are currently supported only by P18XXX8 PIC MCUs. Microcontroller must be connected to CAN transceiver (MCP2551 or similar) which is connected to CAN bus.



Example



char tx, data; long id; // ... tx = _CAN_TX_PRIORITY_0 & _CAN_TX_XTD_FRAME; // ... CANWrite(id, data, 2, tx);
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There is a number of constants predefined in CAN library. To be able to use the library effectively, you need to be familiar with these. You might want to check the example at the end of the chapter.



CAN_OP_MODE CAN_OP_MODE constants define CAN operation CANSetOperationMode expects one of these as its argument: const char _CAN_MODE_BITS _CAN_MODE_NORMAL _CAN_MODE_SLEEP _CAN_MODE_LOOP _CAN_MODE_LISTEN _CAN_MODE_CONFIG



= = = = = =



0xE0, 0x00, 0x20, 0x40, 0x60, 0x80;



mode.



// Use this to access opmode



Function



bits



CAN_CONFIG_FLAGS CAN_CONFIG_FLAGS constants define flags related to CAN module configuration. Functions CANInitialize and CANSetBaudRate expect one of these (or a bitwise combination) as their argument: const char _CAN_CONFIG_DEFAULT _CAN_CONFIG_PHSEG2_PRG_BIT _CAN_CONFIG_PHSEG2_PRG_ON _CAN_CONFIG_PHSEG2_PRG_OFF
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= 0xFF,



// 11111111



= 0x01, = 0xFF, = 0xFE,



// XXXXXXX1 // XXXXXXX0



_CAN_CONFIG_LINE_FILTER_BIT = 0x02, _CAN_CONFIG_LINE_FILTER_ON = 0xFF, _CAN_CONFIG_LINE_FILTER_OFF = 0xFD,



// XXXXXX1X // XXXXXX0X



_CAN_CONFIG_SAMPLE_BIT _CAN_CONFIG_SAMPLE_ONCE _CAN_CONFIG_SAMPLE_THRICE



= 0x04, = 0xFF, = 0xFB,



// XXXXX1XX // XXXXX0XX



_CAN_CONFIG_MSG_TYPE_BIT _CAN_CONFIG_STD_MSG _CAN_CONFIG_XTD_MSG



= 0x08, = 0xFF, = 0xF7,



// XXXX1XXX // XXXX0XXX



_CAN_CONFIG_DBL_BUFFER_BIT _CAN_CONFIG_DBL_BUFFER_ON _CAN_CONFIG_DBL_BUFFER_OFF



= 0x10, = 0xFF, = 0xEF,



// XXX1XXXX // XXX0XXXX
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= 0x60, = 0xFF, = 0xDF, = 0xBF, = 0x9F;



// X11XXXXX // X10XXXXX // X01XXXXX // X00XXXXX



You may use bitwise AND (&) to form config byte out of these values. For example: init = _CAN_CONFIG_SAMPLE_THRICE & _CAN_CONFIG_PHSEG2_PRG_ON & _CAN_CONFIG_STD_MSG & _CAN_CONFIG_DBL_BUFFER_ON & _CAN_CONFIG_VALID_XTD_MSG & _CAN_CONFIG_LINE_FILTER_OFF; ... CANInitialize(1, 1, 3, 3, 1, init);



// initialize CAN



CAN_TX_MSG_FLAGS CAN_TX_MSG_FLAGS are flags related to transmission of a CAN message: const char _CAN_TX_PRIORITY_BITS _CAN_TX_PRIORITY_0 _CAN_TX_PRIORITY_1 _CAN_TX_PRIORITY_2 _CAN_TX_PRIORITY_3 _CAN_TX_FRAME_BIT _CAN_TX_STD_FRAME _CAN_TX_XTD_FRAME



= = = = =



0x03, 0xFC, 0xFD, 0xFE, 0xFF,



// // // //



XXXXXX00 XXXXXX01 XXXXXX10 XXXXXX11



= 0x08, = 0xFF, = 0xF7,



// XXXXX1XX // XXXXX0XX



_CAN_TX_RTR_BIT = 0x40, _CAN_TX_NO_RTR_FRAME = 0xFF, _CAN_TX_RTR_FRAME = 0xBF;



// X1XXXXXX // X0XXXXXX



You may use bitwise AND (&) to adjust the appropriate flags. For example: // form value to be used with CANSendMessage: send_config = _CAN_TX_PRIORITY_0 & _CAN_TX_XTD_FRAME & _CAN_TX_NO_RTR_FRAME; ... CANSendMessage(id, data, 1, send_config);
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CAN_RX_MSG_FLAGS are flags related to reception of CAN message. If a particular bit is set; cor-



responding meaning is TRUE or else it will be FALSE. const char _CAN_RX_FILTER_BITS _CAN_RX_FILTER_1 _CAN_RX_FILTER_2 _CAN_RX_FILTER_3 _CAN_RX_FILTER_4 _CAN_RX_FILTER_5 _CAN_RX_FILTER_6 _CAN_RX_OVERFLOW _CAN_RX_INVALID_MSG _CAN_RX_XTD_FRAME _CAN_RX_RTR_FRAME _CAN_RX_DBL_BUFFERED



= = = = = = = = = = = =



0x07, // Use this to access filter bits 0x00, 0x01, 0x02, 0x03, 0x04, 0x05, 0x08, // Set if Overflowed else cleared 0x10, // Set if invalid else cleared 0x20, // Set if XTD message else cleared 0x40, // Set if RTR message else cleared 0x80; // Set if this message was hard ware double-buffered



You may use bitwise AND (&) to adjust the appropriate flags. For example: if (MsgFlag & _CAN_RX_OVERFLOW != 0) { ... // Receiver overflow has occurred. // We have lost our previous message. }



CAN_MASK CAN_MASK constants define mask codes. Function CANSetMask expects one of



these as its argument: #const char _CAN_MASK_B1 = 0, _CAN_MASK_B2 = 1;



CAN_FILTER CAN_FILTER constants define filter codes. Function CANSetFilter expects one of these as its



argument: const char _CAN_FILTER_B1_F1 _CAN_FILTER_B1_F2 _CAN_FILTER_B2_F1 _CAN_FILTER_B2_F2
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= = = =



0, 1, 2, 3,
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Libraries _CAN_FILTER_B2_F3 = 4, _CAN_FILTER_B2_F4 = 5;



Library Example This is a simple demonstration of CAN Library routines usage. First node initiates the communication with the second node by sending some data to its address. The second node responds by sending back the data incremented by 1. First node then does the same and sends incremented data back to second node, etc. Code for the first CAN node: unsigned char Can_Init_Flags, Can_Send_Flags, Can_Rcv_Flags; // can flags unsigned char Rx_Data_Len; // received data length in bytes char RxTx_Data[8]; // can rx/tx data buffer char Msg_Rcvd; // reception flag const long ID_1st = 12111, ID_2nd = 3; // node IDs long Rx_ID; void main() { PORTC = 0; TRISC = 0;



// clear PORTC // set PORTC as output



Can_Init_Flags = 0; Can_Send_Flags = 0; Can_Rcv_Flags = 0;



// // clear flags //



Can_Send_Flags = _CAN_TX_PRIORITY_0 & // form value to be used _CAN_TX_XTD_FRAME & // with CANWrite _CAN_TX_NO_RTR_FRAME; Can_Init_Flags = _CAN_CONFIG_SAMPLE_THRICE & _CAN_CONFIG_PHSEG2_PRG_ON & _CAN_CONFIG_XTD_MSG & _CAN_CONFIG_DBL_BUFFER_ON & _CAN_CONFIG_VALID_XTD_MSG;



// form value to be used // with CANInit



CANInitialize(1,3,3,3,1,Can_Init_Flags); // Initialize CAN module CANSetOperationMode(_CAN_MODE_CONFIG,0xFF); // set CONFIGURATION mode CANSetMask(_CAN_MASK_B1,-1,_CAN_CONFIG_XTD_MSG); // set all mask1 bits to ones CANSetMask(_CAN_MASK_B2,-1,_CAN_CONFIG_XTD_MSG); // set all mask2 bits to ones CANSetFilter(_CAN_FILTER_B2_F4,ID_2nd,_CAN_CONFIG_XTD_MSG);// set id of filter B2_F4 to 2nd node ID CANSetOperationMode(_CAN_MODE_NORMAL,0xFF); RxTx_Data[0] = 9;



// set NORMAL mode



// set initial data to be sent
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CANWrite(ID_1st, RxTx_Data, 1, Can_Send_Flags); // send initial message while(1) { // endless loop Msg_Rcvd = CANRead(&Rx_ID , RxTx_Data , &Rx_Data_Len, &Can_Rcv_Flags); // receive message if ((Rx_ID == ID_2nd) && Msg_Rcvd) { // if message received check id PORTC = RxTx_Data[0]; // id correct, output data at PORTC RxTx_Data[0]++; // increment received data Delay_ms(10); CANWrite(ID_1st, RxTx_Data, 1, Can_Send_Flags); // send incremented data back } } }



Code for the second CAN node: unsigned char Can_Init_Flags, Can_Send_Flags, Can_Rcv_Flags; // can flags unsigned char Rx_Data_Len; // received data length in bytes char RxTx_Data[8]; // can rx/tx data buffer char Msg_Rcvd; // reception flag const long ID_1st = 12111, ID_2nd = 3; // node IDs long Rx_ID; void main() { PORTC = 0; TRISC = 0;



// clear PORTC // set PORTC as output



Can_Init_Flags = 0; Can_Send_Flags = 0; Can_Rcv_Flags = 0;



// // clear flags //



Can_Send_Flags = _CAN_TX_PRIORITY_0 & // form value to be used _CAN_TX_XTD_FRAME & // with CANWrite _CAN_TX_NO_RTR_FRAME; Can_Init_Flags = _CAN_CONFIG_SAMPLE_THRICE & // form value to be used _CAN_CONFIG_PHSEG2_PRG_ON & // with CANInit _CAN_CONFIG_XTD_MSG & _CAN_CONFIG_DBL_BUFFER_ON & _CAN_CONFIG_VALID_XTD_MSG & _CAN_CONFIG_LINE_FILTER_OFF; CANInitialize(1,3,3,3,1,Can_Init_Flags); // initialize external CAN module CANSetOperationMode(_CAN_MODE_CONFIG,0xFF); // set CONFIGURATION mode CANSetMask(_CAN_MASK_B1,-1,_CAN_CONFIG_XTD_MSG); // set all mask1 bits to ones
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CANSetMask(_CAN_MASK_B2,-1,_CAN_CONFIG_XTD_MSG); // set all mask2 bits to ones CANSetFilter(_CAN_FILTER_B2_F3,ID_1st,_CAN_CONFIG_XTD_MSG);// set id of filter B2_F3 to 1st node ID CANSetOperationMode(_CAN_MODE_NORMAL,0xFF); // set NORMAL mode while (1) { // endless loop Msg_Rcvd = CANRead(&Rx_ID , RxTx_Data , &Rx_Data_Len, &Can_Rcv_Flags); // receive message if ((Rx_ID == ID_1st) && Msg_Rcvd) { // if message received check id PORTC = RxTx_Data[0]; // id correct, output data at PORTC RxTx_Data[0]++; // increment received data CANWrite(ID_2nd, RxTx_Data, 1, Can_Send_Flags); // send incremented data back } }



HW Connection



Example of interfacing CAN transceiver with MCU and bus MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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The SPI module is available with a number of the PIC compliant MCUs. The mikroC PRO for PIC provides a library (driver) for working with mikroElektronika's CANSPI Add-on boards (with MCP2515 or MCP2510) via SPI interface. The CAN is a very robust protocol that has error detection and signalization, self–checking and fault confinement. Faulty CAN data and remote frames are retransmitted automatically, similar to the Ethernet. Data transfer rates depend on distance. For example, 1 Mbit/s can be achieved at network lengths below 40m while 250 Kbit/s can be achieved at network lengths below 250m. The greater distance the lower maximum bitrate that can be achieved. The lowest bitrate defined by the standard is 200Kbit/s. Cables used are shielded twisted pairs. CAN supports two message formats:  Standard format, with 11 identifier bits; and  Extended format, with 29 identifier bits. Note:  Consult the CAN standard about CAN bus termination resistance.  An effective CANSPI communication speed depends on SPI and certainly is slower than “real” CAN.  The library uses the SPI module for communication. User must initialize SPI module before using the SPI Graphic Lcd Library. For MCUs with two SPI modules it is possible to initialize both of them and then switch by using the SPI_Set_Active() routine.  CANSPI module refers to mikroElektronika's CANSPI Add-on board connected to SPI module of MCU.



External dependecies of CANSPI Library The following variables must be defined in all projects using CANSPI Library:



Description:



Example:



extern sfr sbit CanSpi_CS;



Chip Select line.



sbit CanSpi_CS at RC0_bit;



extern sfr sbit CanSpi_Rst;



Reset line.



sbit CanSpi_Rst at RC2_bit;



extern sfr sbit CanSpi_CS_Direction;



Direction of the Chip Select pin.



sbit CanSpi_CS_Direction at TRISC0_bit;



extern sfr sbit sbit CanSpi_Rst_Direction Direction of the Reset pin. at TRISC2_bit; CanSpi_Rst_Direction;
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Library Routines -



CANSPISetOperationMode CANSPIGetOperationMode CANSPIInitialize CANSPISetBaudRate CANSPISetMask CANSPISetFilter CANSPIread CANSPIWrite



The following routines are for an internal use by the library only: - RegsToCANSPIID - CANSPIIDToRegs Be sure to check CANSPI constants necessary for using some of the functions.
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void CANSPISetOperationMode(char mode, char WAIT);



Returns



Nothing. Sets the CANSPI module to requested mode. Parameters:



- mode: CANSPI module operation mode. Valid values: CANSPI_OP_MODE conDescription stants (see CANSPI constants). - WAIT: CANSPI mode switching verification request. If WAIT == 0, the call is nonblocking. The function does not verify if the CANSPI module is switched to requested mode or not. Caller must use CANSPIGetOperationMode to verify correct operation mode before performing mode specific operation. If WAIT != 0, the call is blocking – the function won’t “return” until the requested mode is set.



Requires



The CANSPI routines are supported only by MCUs with the SPI module. MCU has to be properly connected to mikroElektronika's CANSPI Extra Board or similar hardware. See connection example at the bottom of this page.



Example



// set the CANSPI module into configuration mode (wait inside CANSPISetOperationMode until this mode is set) CANSPISetOperationMode(_CANSPI_MODE_CONFIG, 0xFF);



CANSPIGetOperationMode Prototype



char CANSPIGetOperationMode();



Returns



Current operation mode.



The function returns current operation mode of the CANSPI module. Check CANDescription SPI_OP_MODE constants (see CANSPI constants) or device datasheet for operation mode codes.
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Requires



The CANSPI routines are supported only by MCUs with the SPI module. MCU has to be properly connected to mikroElektronika's CANSPI Extra Board or similar hardware. See connection example at the bottom of this page.



Example



// check whether the CANSPI module is in Normal mode and if it is do something. if (CANSPIGetOperationMode() == _CANSPI_MODE_NORMAL) { ... }
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CANSPIInitialize Prototype



void CANSPIInitialize( char SJW, char BRP, char PHSEG1, char PHSEG2, char PROPSEG, char CANSPI_CONFIG_FLAGS);



Returns



Nothing. Initializes the CANSPI module. Stand-Alone CAN controller in the CANSPI module is set to: -



Disable CAN capture Continue CAN operation in Idle mode Do not abort pending transmissions Fcan clock: 4*Tcy (Fosc) Baud rate is set according to given parameters CAN mode: Normal Filter and mask registers IDs are set to zero Filter and mask message frame type is set according to CAN_CONFIG_FLAGS value



Description SAM, SEG2PHTS, WAKFIL and DBEN bits are set according to CANSPI_CONFIG_FLAGS value.



Parameters: - SJW as defined in CAN controller's datasheet - BRP as defined in CAN controller's datasheet - PHSEG1 as defined in CAN controller's datasheet - PHSEG2 as defined in CAN controller's datasheet - PROPSEG as defined in CAN controller's datasheet - CAN_CONFIG_FLAGS is formed from predefined constants (see CANSPI constants) Global variables: -



Requires



CanSpi_CS: Chip Select line CanSpi_Rst: Reset line CanSpi_CS_Direction: Direction of the Chip Select pin CanSpi_Rst_Direction: Direction of the Reset pin



must be defined before using this function. The CANSPI routines are supported only by MCUs with the SPI module. The SPI module needs to be initialized. See the SPI1_Init and SPI1_Init_Advanced routines. MCU has to be properly connected to mikroElektronika's CANSPI Extra Board or similar hardware. See connection example at the bottom of this page.
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Libraries // CANSPI module connections sbit CanSpi_CS at RC0_bit; sbit CanSpi_CS_Direction at TRISC0_bit; sbit CanSpi_Rst at RC2_bit; sbit CanSpi_Rst_Direction at TRISC2_bit; // End CANSPI module connections



Example
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// initialize the CANSPI module with the appropriate baud rate and message acceptance flags along with the sampling rules char CanSPi_Init_Flags; ... CanSPi_Init_Flags = _CANSPI_CONFIG_SAMPLE_THRICE & // form value to be used _CANSPI_CONFIG_PHSEG2_PRG_ON & // with CANSPIInitialize _CANSPI_CONFIG_XTD_MSG & _CANSPI_CONFIG_DBL_BUFFER_ON & _CANSPI_CONFIG_VALID_XTD_MSG; ... SPI1_Init(); // initialize SPI module CANSPIInitialize(1,3,3,3,1,CanSpi_Init_Flags); // initialize external CANSPI module
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CANSPISetBaudRate Prototype



void CANSPISetBaudRate( char SJW, char BRP, char PHSEG1, char PHSEG2, char PROPSEG, char CANSPI_CONFIG_FLAGS);



Returns



Nothing. Sets the CANSPI module baud rate. Due to complexity of the CAN protocol, you can not simply force a bps value. Instead, use this function when the CANSPI module is in Config mode. SAM, SEG2PHTS and WAKFIL bits are set according to CANSPI_CONFIG_FLAGS



value. Refer to datasheet for details. Description Parameters: - SJW as defined in CAN controller's datasheet - BRP as defined in CAN controller's datasheet - PHSEG1 as defined in CAN controller's datasheet - PHSEG2 as defined in CAN controller's datasheet - PROPSEG as defined in CAN controller's datasheet - CAN_CONFIG_FLAGS is formed from predefined constants (see CANSPI constants) The CANSPI module must be in Config mode, otherwise the function will be ignored. See CANSPISetOperationMode. Requires



The CANSPI routines are supported only by MCUs with the SPI module. MCU has to be properly connected to mikroElektronika's CANSPI Extra Board or similar hardware. See connection example at the bottom of this page.



Example



// set required baud rate and sampling rules char canspi_config_flags; ... CANSPISetOperationMode(CANSPI_MODE_CONFIG,0xFF); // set CONFIGURATION mode (CANSPI module mast be in config mode for baud rate settings) canspi_config_flags = _CANSPI_CONFIG_SAMPLE_THRICE & _CANSPI_CONFIG_PHSEG2_PRG_ON & _CANSPI_CONFIG_STD_MSG & _CANSPI_CONFIG_DBL_BUFFER_ON & _CANSPI_CONFIG_VALID_XTD_MSG & _CANSPI_CONFIG_LINE_FILTER_OFF; CANSPISetBaudRate(1, 1, 3, 3, 1, canspi_config_flags);
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void CANSPISetMask(char CANSPI_MASK, long val, char CANSPI_CONFIG_FLAGS);



Returns



Nothing. Configures mask for advanced filtering of messages. The parameter value is bit-adjusted to the appropriate mask registers. Parameters:



- CAN_MASK: CANSPI module mask number. Valid values: CANSPI_MASK costants (see CANSPI constants) Description - val: mask register value - CAN_CONFIG_FLAGS: selects type of message to filter. Valid values: CANSPI_CONFIG_ALL_VALID_MSG, CANSPI_CONFIG_MATCH_MSG_TYPE and CANSPI_CONFIG_STD_MSG, CANSPI_CONFIG_MATCH_MSG_TYPE and CANSPI_CONFIG_XTD_MSG.



(see CANSPI constants) The CANSPI module must be in Config mode, otherwise the function will be ignored. See CANSPISetOperationMode. Requires



The CANSPI routines are supported only by MCUs with the SPI module. MCU has to be properly connected to mikroElektronika's CANSPI Extra Board or similar hardware. See connection example at the bottom of this page. // set the appropriate filter mask and message type value CANSPISetOperationMode(_CANSPI_MODE_CONFIG,0xFF); // set CONFIGURATION mode (CANSPI module must be in config mode for mask settings)



Example
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// Set all B1 mask bits to 1 (all filtered bits are relevant): // Note that -1 is just a cheaper way to write 0xFFFFFFFF. // Complement will do the trick and fill it up with ones. CANSPISetMask(_CANSPI_MASK_B1, -1, _CANSPI_CONFIG_MATCH_MSG_TYPE & _CANSPI_CONFIG_XTD_MSG);
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CANSPISetFilter Prototype



void CANSPISetFilter(char CANSPI_FILTER, long val, char CANSPI_CONFIG_FLAGS);



Returns



Nothing. Configures message filter. The parameter value is bit-adjusted to the appropriate filter registers. Parameters:



- CAN_FILTER: CANSPI module filter number. Valid values: CANSPI_FILTER constants (see CANSPI constants) Description - val: filter register value - CAN_CONFIG_FLAGS: selects type of message to filter. Valid values: CANSPI_CONFIG_ALL_VALID_MSG, CANSPI_CONFIG_MATCH_MSG_TYPE and CANSPI_CONFIG_STD_MSG, CANSPI_CONFIG_MATCH_MSG_TYPE and CANSPI_CONFIG_XTD_MSG.



(see CANSPI constants) The CANSPI module must be in Config mode, otherwise the function will be ignored. See CANSPISetOperationMode. Requires



The CANSPI routines are supported only by MCUs with the SPI module. MCU has to be properly connected to mikroElektronika's CANSPI Extra Board or similar hardware. See connection example at the bottom of this page.



Example



// set the appropriate filter value and message type CANSPISetOperationMode(_CANSPI_MODE_CONFIG,0xFF); // set CONFIGURATION mode (CANSPI module must be in config mode for filter settings) /* Set id of filter B1_F1 to 3: */ CANSPISetFilter(_CANSPI_FILTER_B1_F1, 3, _CANSPI_CONFIG_XTD_MSG);
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char CANSPIRead(long *id, char *rd_data, char *data_len, char *CANSPI_RX_MSG_FLAGS);



- 0 if nothing is received - 0xFF if one of the Receive Buffers is full (message received)



Returns



If at least one full Receive Buffer is found, it will be processed in the following way: - Message ID is retrieved and stored to location provided by the id parameter - Message data is retrieved and stored to a buffer provided by the rd_data parameter - Message length is retrieved and stored to location provided by the data_len parameter Description - Message flags are retrieved and stored to location provided by the CAN_RX_MSG_FLAGS parameter Parameters: -



id: message identifier storage address rd_data: data buffer (an array of bytes up to 8 bytes in length) data_len: data length storage address. CAN_RX_MSG_FLAGS: message flags storage address



The CANSPI module must be in a mode in which receiving is possible. See CANSPISetOperationMode. Requires



The CANSPI routines are supported only by MCUs with the SPI module. MCU has to be properly connected to mikroElektronika's CANSPI Extra Board or similar hardware. See connection example at the bottom of this page.



Example
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// check the CANSPI module for received messages. If any was received do something. char msg_rcvd, rx_flags, data_len; char data[8]; long msg_id; ... CANSPISetOperationMode(CA_NSPI_MODE_NORMAL,0xFF); // set NORMAL mode (CANSPI module must be in mode in which receive is possible) ... rx_flags = 0; // clear message flags if (msg_rcvd = CANSPIRead(msg_id, data, data_len, rx_flags)) { ... }
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CANSPIWrite Prototype Returns



char CANSPIWrite(long id, char *wr_data, char data_len, char CANSPI_TX_MSG_FLAGS);



- 0 if all Transmit Buffers are busy - 0xFF if at least one Transmit Buffer is available If at least one empty Transmit Buffer is found, the function sends message in the queue for transmission. Parameters:



Description



- id:CAN message identifier. Valid values: 11 or 29 bit values, depending on message type (standard or extended) - wr_data: data to be sent (an array of bytes up to 8 bytes in length) - data_len: data length. Valid values: 1 to 8 - CAN_RX_MSG_FLAGS: message flags The CANSPI module must be in mode in which transmission is possible. See CANSPISetOperationMode.



Requires



The CANSPI routines are supported only by MCUs with the SPI module. MCU has to be properly connected to mikroElektronika's CANSPI Extra Board or similar hardware. See connection example at the bottom of this page.



Example



// send message extended CAN message with the appropriate ID and data char tx_flags; char data[8]; long msg_id; ... CANSPISetOperationMode(_CANSPI_MODE_NORMAL,0xFF); // set NORMAL mode (CANSPI must be in mode in which transmission is possible) tx_flags = _CANSPI_TX_PRIORITY_0 & _CANSPI_TX_XTD_FRAME; // set message flags CANSPIWrite(msg_id, data, 2, tx_flags);
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There is a number of constants predefined in the CANSPI library. You need to be familiar with them in order to be able to use the library effectively. Check the example at the end of the chapter.



CANSPI_OP_MODE The CANSPI_OP_MODE constants define CANSPI operation mode. Function CANSPISetOperationMode expects one of these as it's argument: const char _CANSPI_MODE_BITS _CANSPI_MODE_NORMAL _CANSPI_MODE_SLEEP _CANSPI_MODE_LOOP _CANSPI_MODE_LISTEN _CANSPI_MODE_CONFIG



= 0xE0, = 0x00, = 0x20, = 0x40, = 0x60, = 0x80;



// Use this to access opmode



bits



CANSPI_CONFIG_FLAGS The CANSPI_CONFIG_FLAGS constants define flags related to the CANSPI module configuration. The functions CANSPIInitialize, CANSPISetBaudRate, CANSPISetMask and CANSPISetFilter expect one of these (or a bitwise combination) as their argument: const char _CANSPI_CONFIG_DEFAULT _CANSPI_CONFIG_PHSEG2_PRG_BIT _CANSPI_CONFIG_PHSEG2_PRG_ON _CANSPI_CONFIG_PHSEG2_PRG_OFF
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= 0xFF,



// 11111111



= 0x01, = 0xFF, = 0xFE,



// XXXXXXX1 // XXXXXXX0



_CANSPI_CONFIG_LINE_FILTER_BIT = 0x02, _CANSPI_CONFIG_LINE_FILTER_ON = 0xFF, _CANSPI_CONFIG_LINE_FILTER_OFF = 0xFD,



// XXXXXX1X // XXXXXX0X



_CANSPI_CONFIG_SAMPLE_BIT _CANSPI_CONFIG_SAMPLE_ONCE _CANSPI_CONFIG_SAMPLE_THRICE



= 0x04, = 0xFF, = 0xFB,



// XXXXX1XX // XXXXX0XX



_CANSPI_CONFIG_MSG_TYPE_BIT _CANSPI_CONFIG_STD_MSG _CANSPI_CONFIG_XTD_MSG



= 0x08, = 0xFF, = 0xF7,



// XXXX1XXX // XXXX0XXX
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Libraries _CANSPI_CONFIG_DBL_BUFFER_BIT _CANSPI_CONFIG_DBL_BUFFER_ON _CANSPI_CONFIG_DBL_BUFFER_OFF



= 0x10, = 0xFF, = 0xEF,



// XXX1XXXX // XXX0XXXX



_CANSPI_CONFIG_MSG_BITS _CANSPI_CONFIG_ALL_MSG _CANSPI_CONFIG_VALID_XTD_MSG _CANSPI_CONFIG_VALID_STD_MSG _CANSPI_CONFIG_ALL_VALID_MSG



= 0x60, = 0xFF, = 0xDF, = 0xBF, = 0x9F;



// X11XXXXX // X10XXXXX // X01XXXXX // X00XXXXX



You may use bitwise AND (&) to form config byte out of these values. For example: init = _CANSPI_CONFIG_SAMPLE_THRICE & _CANSPI_CONFIG_PHSEG2_PRG_ON & _CANSPI_CONFIG_STD_MSG & _CANSPI_CONFIG_DBL_BUFFER_ON & _CANSPI_CONFIG_VALID_XTD_MSG & _CANSPI_CONFIG_LINE_FILTER_OFF; ... CANSPIInitialize(1, 1, 3, 3, 1, init);



// initialize CANSPI



CANSPI_TX_MSG_FLAGS CANSPI_TX_MSG_FLAGS are flags related to transmission of a CAN message: const char _CANSPI_TX_PRIORITY_BITS _CANSPI_TX_PRIORITY_0 _CANSPI_TX_PRIORITY_1 _CANSPI_TX_PRIORITY_2 _CANSPI_TX_PRIORITY_3 _CANSPI_TX_FRAME_BIT _CANSPI_TX_STD_FRAME _CANSPI_TX_XTD_FRAME



= = = = =



0x03, 0xFC, 0xFD, 0xFE, 0xFF,



// // // //



XXXXXX00 XXXXXX01 XXXXXX10 XXXXXX11



= 0x08, = 0xFF, = 0xF7,



// XXXXX1XX // XXXXX0XX



_CANSPI_TX_RTR_BIT = 0x40, _CANSPI_TX_NO_RTR_FRAME = 0xFF, _CANSPI_TX_RTR_FRAME = 0xBF;



// X1XXXXXX // X0XXXXXX



You may use bitwise AND (&) to adjust the appropriate flags. For example: /* form value to be used as sending message flag : */ send_config = _CANSPI_TX_PRIORITY_0 & _CANSPI_TX_XTD_FRAME & _CANSPI_TX_NO_RTR_FRAME; ... CANSPIWrite(id, data, 1, send_config);
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Libraries CANSPI_RX_MSG_FLAGS



CANSPI_RX_MSG_FLAGS are flags related to reception of CAN message. If a particular bit is set then corresponding meaning is TRUE or else it will be FALSE. const char _CANSPI_RX_FILTER_BITS _CANSPI_RX_FILTER_1 _CANSPI_RX_FILTER_2 _CANSPI_RX_FILTER_3 _CANSPI_RX_FILTER_4 _CANSPI_RX_FILTER_5 _CANSPI_RX_FILTER_6



= = = = = = =



0x07, 0x00, 0x01, 0x02, 0x03, 0x04, 0x05,



// Use this to access filter bits



_CANSPI_RX_OVERFLOW = 0x08, // Set if Overflowed else cleared _CANSPI_RX_INVALID_MSG = 0x10, // Set if invalid else cleared _CANSPI_RX_XTD_FRAME = 0x20, // Set if XTD message else cleared _CANSPI_RX_RTR_FRAME = 0x40, // Set if RTR message else cleared _CANSPI_RX_DBL_BUFFERED = 0x80; // Set if this message was hard ware double-buffered



You may use bitwise AND (&) to adjust the appropriate flags. For example: if (MsgFlag & _CANSPI_RX_OVERFLOW != 0) { ... // Receiver overflow has occurred. // We have lost our previous message. }



CANSPI_MASK The CANSPI_MASK constants define mask codes. Function CANSPISetMask expects one of these as it's argument: const char _CANSPI_MASK_B1 = 0, _CANSPI_MASK_B2 = 1;



CANSPI_FILTER The CANSPI_FILTER constants define filter codes. Functions CANSPISetFilter expects one of these as it's argument: const char _CANSPI_FILTER_B1_F1 _CANSPI_FILTER_B1_F2 _CANSPI_FILTER_B2_F1 _CANSPI_FILTER_B2_F2
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= = = =



0, 1, 2, 3,
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Library Example This is a simple demonstration of CANSPI Library routines usage. First node initiates the communication with the second node by sending some data to its address. The second node responds by sending back the data incremented by 1. First node then does the same and sends incremented data back to second node, etc. Code for the first CANSPI node: unsigned char Can_Init_Flags, Can_Send_Flags, Can_Rcv_Flags; // can flags unsigned char Rx_Data_Len; // received data length in bytes char RxTx_Data[8]; // can rx/tx data buffer char Msg_Rcvd; // reception flag const long ID_1st = 12111, ID_2nd = 3; // node IDs long Rx_ID; // CANSPI module connections sbit CanSpi_CS at RC0_bit; sbit CanSpi_CS_Direction at TRISC0_bit; sbit CanSpi_Rst at RC2_bit; sbit CanSpi_Rst_Direction at TRISC2_bit; // End CANSPI module connections void main() { ANSEL = 0; ANSELH = 0;



// Configure AN pins as digital I/O



PORTB = 0; TRISB = 0;



// clear PORTB // set PORTB as output



Can_Init_Flags = 0; Can_Send_Flags = 0; Can_Rcv_Flags = 0;



// // clear flags //



Can_Send_Flags = _CANSPI_TX_PRIORITY_0 & // form value to be used _CANSPI_TX_XTD_FRAME & // with CANSPIWrite _CANSPI_TX_NO_RTR_FRAME; Can_Init_Flags = _CANSPI_CONFIG_SAMPLE_THRICE & // Form value to be used _CANSPI_CONFIG_PHSEG2_PRG_ON & // with CANSPIInit _CANSPI_CONFIG_XTD_MSG & _CANSPI_CONFIG_DBL_BUFFER_ON & _CANSPI_CONFIG_VALID_XTD_MSG;
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// initialize SPI1 module



CANSPIInitialize(1,3,3,3,1,Can_Init_Flags); // Initialize external CANSPI module CANSPISetOperationMode(_CANSPI_MODE_CONFIG,0xFF); // set CONFIGURATION mode CANSPISetMask(_CANSPI_MASK_B1,-1,_CANSPI_CONFIG_XTD_MSG); // set all mask1 bits to ones CANSPISetMask(_CANSPI_MASK_B2,-1,_CANSPI_CONFIG_XTD_MSG); // set all mask2 bits to ones CANSPISetFilter(_CANSPI_FILTER_B2_F4,ID_2nd,_CANSPI_CONFIG_XTD_MSG); // set id of filter B2_F4 to 2nd node ID CANSPISetOperationMode(_CANSPI_MODE_NORMAL,0xFF); // set NORMAL mode RxTx_Data[0] = 9;



// set initial data to be sent



CANSPIWrite(ID_1st, RxTx_Data, 1, Can_Send_Flags); // send initial message while(1) { // endless loop Msg_Rcvd = CANSPIRead(&Rx_ID , RxTx_Data , &Rx_Data_Len, &Can_Rcv_Flags);// receive message if ((Rx_ID == ID_2nd) && Msg_Rcvd) { // if message received check id PORTB = RxTx_Data[0]; // id correct, output data at PORTC RxTx_Data[0]++; // increment received data Delay_ms(10); CANSPIWrite(ID_1st, RxTx_Data, 1, Can_Send_Flags); // send incremented data back } } }
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Code for the second CANSPI node: unsigned char Can_Init_Flags, Can_Send_Flags, Can_Rcv_Flags; // can flags unsigned char Rx_Data_Len; // received data length in bytes char RxTx_Data[8]; // can rx/tx data buffer char Msg_Rcvd; // reception flag const long ID_1st = 12111, ID_2nd = 3; // node IDs long Rx_ID; // CANSPI module connections sbit CanSpi_CS at RC0_bit; sbit CanSpi_CS_Direction at TRISC0_bit; sbit CanSpi_Rst at RC2_bit; sbit CanSpi_Rst_Direction at TRISC2_bit; // End CANSPI module connections void main() { ANSEL = 0; ANSELH = 0;



// Configure AN pins as digital I/O



PORTB = 0; TRISB = 0;



// clear PORTB // set PORTB as output



Can_Init_Flags = 0; Can_Send_Flags = 0; Can_Rcv_Flags = 0;



// // clear flags //



Can_Send_Flags = _CANSPI_TX_PRIORITY_0 & // form value to be used _CANSPI_TX_XTD_FRAME & // with CANSPIWrite _CANSPI_TX_NO_RTR_FRAME; Can_Init_Flags = _CANSPI_CONFIG_SAMPLE_THRICE & // Form value to be used _CANSPI_CONFIG_PHSEG2_PRG_ON & // with CANSPIInit _CANSPI_CONFIG_XTD_MSG & _CANSPI_CONFIG_DBL_BUFFER_ON & _CANSPI_CONFIG_VALID_XTD_MSG & _CANSPI_CONFIG_LINE_FILTER_OFF; SPI1_Init();



// initialize SPI1 module



CANSPIInitialize(1,3,3,3,1,Can_Init_Flags); // initialize external CANSPI module CANSPISetOperationMode(_CANSPI_MODE_CONFIG,0xFF); // set CONFIGURATION mode CANSPISetMask(_CANSPI_MASK_B1,-1,_CANSPI_CONFIG_XTD_MSG);// set all mask1 bits to ones CANSPISetMask(_CANSPI_MASK_B2,-1,_CANSPI_CONFIG_XTD_MSG); // set
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CANSPISetFilter(_CANSPI_FILTER_B2_F3,ID_1st,_CANSPI_CONFIG_XTD_MSG); // set id of filter B2_F3 to 1st node ID CANSPISetOperationMode(_CANSPI_MODE_NORMAL,0xFF);// set NORMAL mode while (1) { // endless loop Msg_Rcvd = CANSPIRead(&Rx_ID , RxTx_Data , &Rx_Data_Len, &Can_Rcv_Flags); // receive message if ((Rx_ID == ID_1st) && Msg_Rcvd) { // if message received check id PORTB = RxTx_Data[0]; // id correct, output data at PORTC RxTx_Data[0]++; // increment received data CANSPIWrite(ID_2nd, RxTx_Data, 1, Can_Send_Flags); // send incremented data back } } }



HW Connection



Example of interfacing CAN transceiver MCP2510 with MCU via SPI interface
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COMPACT FLASH LIBRARY The Compact Flash Library provides routines for accessing data on Compact Flash card (abbr. CF further in text). CF cards are widely used memory elements, commonly used with digital cameras. Great capacity and excellent access time of only a few microseconds make them very attractive for microcontroller applications. In CF card, data is divided into sectors. One sector usually comprises 512 bytes. Routines for file handling, the Cf_Fat routines, are not performed directly but successively through 512B buffer. Note: Routines for file handling can be used only with FAT16 file system. Note: Library functions create and read files from the root directory only. Note: Library functions populate both FAT1 and FAT2 tables when writing to files, but the file data is being read from the FAT1 table only; i.e. there is no recovery if the FAT1 table gets corrupted. Note: If MMC/SD card has Master Boot Record (MBR), the library will work with the first available primary (logical) partition that has non-zero size. If MMC/SD card has Volume Boot Record (i.e. there is only one logical partition and no MBRs), the library works with entire card as a single partition. For more information on MBR, physical and logical drives, primary/secondary partitions and partition tables, please consult other resources, e.g. Wikipedia and similar. Note: Before writing operation, make sure not to overwrite boot or FAT sector as it could make your card on PC or digital camera unreadable. Drive mapping tools, such as Winhex, can be of great assistance.
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Description:



Example:



extern sfr char CF_Data_Port;



Compact Flash Data Port.



char CF_Data_Port at PORTD;



extern sfr sbit CF_RDY;



Ready signal line.



sbit CF_RDY at RB7_bit;



extern sfr sbit CF_WE;



Write Enable signal line.



sbit CF_WE at RB6_bit;



extern sfr sbit CF_OE;



Output Enable signal line.



sbit CF_OE at RB5_bit;



extern sfr sbit CF_CD1;



Chip Detect signal line.



sbit CF_CD1 at RB4_bit;



extern sfr sbit CF_CE1;



Chip Enable signal line.



sbit CF_CE1 at RB3_bit;



extern sfr sbit CF_A2;



Address pin 2.



sbit CF_A2 at RB2_bit;



extern sfr sbit CF_A1;



Address pin 1.



sbit CF_A1 at RB1_bit;



extern sfr sbit CF_A0;



Address pin 0.



sbit CF_A0 at RB0_bit;



extern sfr sbit CF_RDY_direction;



Direction of the Ready pin.



sbit CF_RDY_direction at TRISB7_bit;



extern sfr sbit CF_WE_direction;



Direction of the Write Enable pin.



sbit CF_WE_direction at TRISB6_bit;



extern sfr sbit CF_OE_direction;



Direction of the Output Enable pin.



sbit CF_OE_direction at TRISB5_bit;



extern sfr sbit CF_CD1_direction;



Direction of the Chip Detect pin.



sbit CF_CD1_direction at TRISB4_bit;



extern sfr sbit CF_CE1_direction;



Direction of the Chip Enable pin.



sbit CF_CE1_direction at TRISB3_bit;



extern sfr sbit CF_A2_direction;



Direction of the Address 2 pin.



sbit CF_A2_direction at TRISB2_bit;



extern sfr sbit CF_A1_direction;



Direction of the Address 1 pin.



sbit CF_A1_direction at TRISB1_bit;



extern sfr sbit CF_A0_direction;



Direction of the Address 0 pin.



sbit CF_A0_direction at TRISB0_bit;
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Library Routines -



Cf_Init Cf_Detect Cf_Enable Cf_Disable Cf_Read_Init Cf_Read_Byte Cf_Write_Init Cf_Write_Byte Cf_Read_Sector Cf_Write_Sector



Routines for file handling: -



Cf_Fat_Init Cf_Fat_QuickFormat Cf_Fat_Assign Cf_Fat_Reset Cf_Fat_Read Cf_Fat_Rewrite Cf_Fat_Append Cf_Fat_Delete Cf_Fat_Write Cf_Fat_Set_File_Date Cf_Fat_Get_File_Date Cf_Fat_Get_File_Size Cf_Fat_Get_Swap_File



The following routine is for the internal use by compiler only: - Cf_Issue_ID_Command
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void Cf_Init();



Returns



Nothing.



Description Initializes ports appropriately for communication with CF card. Global variables:



Requires



-



CF_Data_Port : Compact Flash data port CF_RDY : Ready signal line CF_WE : Write enable signal line CF_OE : Output enable signal line CF_CD1 : Chip detect signal line CF_CE1 : Enable signal line CF_A2 : Address pin 2 CF_A1 : Address pin 1 CF_A0 : Address pin 0 CF_RDY_direction : Direction of the Ready pin CF_WE_direction : Direction of the Write enable pin CF_OE_direction : Direction of the Output enable pin CF_CD1_direction : Direction of the Chip detect pin CF_CE1_direction : Direction of the Chip enable pin CF_A2_direction : Direction of the Address 2 pin CF_A1_direction : Direction of the Address 1 pin CF_A0_direction : Direction of the Address 0 pin



must be defined before using this function. // set compact flash pinout char Cf_Data_Port at PORTD; sbit sbit sbit sbit sbit sbit sbit sbit



CF_RDY CF_WE CF_OE CF_CD1 CF_CE1 CF_A2 CF_A1 CF_A0



at at at at at at at at



RB7_bit; RB6_bit; RB5_bit; RB4_bit; RB3_bit; RB2_bit; RB1_bit; RB0_bit;



Example sbit CF_RDY_direction at TRISB7_bit; sbit CF_WE_direction at TRISB6_bit; sbit CF_OE_direction at TRISB5_bit; sbit CF_CD1_direction at TRISB4_bit; sbit CF_CE1_direction at TRISB3_bit; sbit CF_A2_direction at TRISB2_bit; sbit CF_A1_direction at TRISB1_bit; sbit CF_A0_direction at TRISB0_bit; // end of compact flash pinout ... Cf_Init(); // initialize CF
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Cf_Detect Prototype



unsigned short Cf_Detect(void);



Returns



- 1 - if CF card was detected - 0 - otherwise



Description Checks for presence of CF card by reading the chip detect pin. Requires



The corresponding MCU ports must be appropriately initialized for CF card. See Cf_Init.



Example



// Wait until CF card is inserted: do asm nop; while (!Cf_Detect());



Cf_Enable Prototype



void Cf_Enable(void);



Returns



Nothing.



Enables the device. Routine needs to be called only if you have disabled the Description device by means of the Cf_Disable routine. These two routines in conjunction allow you to free/occupy data line when working with multiple devices. Requires



The corresponding MCU ports must be appropriately initialized for CF card. See Cf_Init.



Example



// enable compact flash Cf_Enable();



Cf_Disable Prototype



void Cf_Disable(void);



Returns



Nothing.



Routine disables the device and frees the data lines for other devices. To enable Description the device again, call Cf_Enable. These two routines in conjunction allow you to free/occupy data line when working with multiple devices. Requires



The corresponding MCU ports must be appropriately initialized for CF card. See Cf_Init.



Example



// disable compact flash Cf_Disable();
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Libraries Cf_Read_Init Prototype



void Cf_Read_Init(unsigned long address, unsigned short sector_count);



Returns



Nothing. Initializes CF card for reading.



Description



Parameters: - address: the first sector to be prepared for reading operation. - sector_count: number of sectors to be prepared for reading operation.



Requires



The corresponding MCU ports must be appropriately initialized for CF card. See Cf_Init.



Example



// initialize compact flash for reading from sector 590 Cf_Read_Init(590, 1);



Cf_Read_Byte Prototype



unsigned short Cf_Read_Byte(void);



Returns a byte read from Compact Flash sector buffer. Returns Note: Higher byte of the unsigned return value is cleared. Description



Requires



Reads one byte from Compact Flash sector buffer location currently pointed to by internal read pointers. These pointers will be autoicremented upon reading. The corresponding MCU ports must be appropriately initialized for CF card. See Cf_Init. CF card must be initialized for reading operation. See Cf_Read_Init.



Example
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// Read a byte from compact flash: char data; ... data = Cf_Read_Byte();
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Cf_Write_Init Prototype



void Cf_Write_Init(unsigned long address, unsigned short sectcnt);



Returns



Nothing. Initializes CF card for writing.



Description



Parameters: - address: the first sector to be prepared for writing operation. - sectcnt: number of sectors to be prepared for writing operation.



Requires



The corresponding MCU ports must be appropriately initialized for CF card. See Cf_Init.



Example



// initialize compact flash for writing to sector 590 Cf_Write_Init(590, 1);



Cf_Write_Byte Prototype



void Cf_Write_Byte(unsigned short data_);



Returns



Nothing.



Description



Writes a byte to Compact Flash sector buffer location currently pointed to by writing pointers. These pointers will be autoicremented upon reading. When sector buffer is full, its contents will be transfered to appropriate flash memory sector. Parameters: - data_: byte to be written.



Requires



The corresponding MCU ports must be appropriately initialized for CF card. See Cf_Init. CF card must be initialized for writing operation. See Cf_Write_Init.



Example



char data = 0xAA; ... Cf_Write_Byte(data);
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Libraries Cf_Read_Sector Prototype



void Cf_Read_Sector(unsigned long sector_number, unsigned short *buffer);



Returns



Nothing. Reads one sector (512 bytes). Read data is stored into buffer provided by the buffer parameter.



Description Parameters: sector_number: sector to be read. buffer: data buffer of at least 512 bytes in length.



Requires



The corresponding MCU ports must be appropriately initialized for CF card. See Cf_Init.



Example



// read sector 22 unsigned short data[512]; ... Cf_Read_Sector(22, data);



Cf_Write_Sector Prototype



void Cf_Write_Sector(unsigned long sector_number, unsigned short *buffer);



Returns



Nothing. Writes 512 bytes of data provided by the buffer parameter to one CF sector.



Description



Parameters: - sector_number: sector to be written to. - buffer: data buffer of 512 bytes in length.
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Requires



The corresponding MCU ports must be appropriately initialized for CF card. See Cf_Init.



Example



// write to sector 22 unsigned short data[512]; ... Cf_Write_Sector(22, data);
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Cf_Fat_Init Prototype



unsigned short Cf_Fat_Init();



Returns



- 0 - if CF card was detected and successfuly initialized - 1 - if FAT16 boot sector was not found - 255 - if card was not detected



Description



Initializes CF card, reads CF FAT16 boot sector and extracts necessary data needed by the library.



Requires



Nothing.



Example



// Init the FAT library if (!Cf_Fat_Init()) { ... }



// Init the FAT library



Cf_Fat_QuickFormat Prototype



unsigned char Cf_Fat_QuickFormat(char *cf_fat_label);



Returns



- 0 - if CF card was detected, successfuly formated and initialized - 1 - if FAT16 format was unseccessful - 255 - if card was not detected



Formats to FAT16 and initializes CF card. Parameters: - cf_fat_label: volume label (11 characters in length). If less than 11



Description



characters are provided, the label will be padded with spaces. If null string is passed, the volume will not be labeled. Note: This routine can be used instead or in conjunction with Cf_Fat_Init routine. Note: If CF card already contains a valid boot sector, it will remain unchanged (except volume label field) and only FAT and ROOT tables will be erased. Also, the new volume label will be set.



Requires



Nothing.



Example



//--- format and initialize the FAT library if (!Cf_Fat_QuickFormat(&cf_fat_label)) { ... }



MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



281



CHAPTER 7 mikroC PRO for PIC



Libraries Cf_Fat_Assign Prototype



unsigned short Cf_Fat_Assign(char *filename, char file_cre_attr);



Returns



- 0 if file does not exist and no new file is created. - 1 if file already exists or file does not exist but a new file is created.



Assigns file for file operations (read, write, delete...). All subsequent file operations will be applied over the assigned file.



Description



Parameters: - filename: name of the file that should be assigned for file operations. The file name should be in DOS 8.3 (file_name.extension) format. The file name and extension will be automatically padded with spaces by the library if they have less than length required (i.e. "mikro.tx" -> "mikro .tx "), so the user does not have to take care of that. The file name and extension are case insensitive. The library will convert them to proper case automatically, so the user does not have to take care of that. Also, in order to keep backward compatibility with the first version of this library, file names can be entered as UPPERCASE string of 11 bytes in length with no dot character between the file name and extension (i.e. "MIKROELETXT" -> MIKROELE.TXT). In this case the last 3 characters of the string are considered to be file extension. - file_cre_attr: file creation and attributs flags. Each bit corresponds to the appropriate file attribut:: Bit



Mask



Description



0



0x01



Read Only



1



0x02



Hidden



2



0x04



System



3



0x08



Volume Label



4



0x10



Subdirectory



5



0x20



Archive



6



0x40



Device (internal use only, never found on disk)



7



0x80



File creation flag. If the file does not exist and this flag is set, a new file with specified name will be created.



Note: Long File Names (LFN) are not supported.
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Requires



CF card and CF library must be initialized for file operations. See Cf_Fat_Init.



Example



// create file with archive attributes if it does not already exist Cf_Fat_Assign("MIKRO007.TXT",0xA0);
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Cf_Fat_Reset Prototype



void Cf_Fat_Reset(unsigned long *size);



Returns



Nothing. Opens currently assigned file for reading.



Description



Parameters: - size: buffer to store file size to. After file has been open for reading its size is



returned through this parameter. Requires



CF card and CF library must be initialized for file operations. See Cf_Fat_Init. File must be previously assigned. See Cf_Fat_Assign.



Example



unsigned long size; ... Cf_Fat_Reset(size);



Cf_Fat_Read Prototype



void Cf_Fat_Read(unsigned short *bdata);



Returns



Nothing. Reads a byte from currently assigned file opened for reading. Upon function execution file pointers will be set to the next character in the file.



Description Parameters: - bdata: buffer to store read byte to. Upon this function execution read byte is



returned through this parameter. Requires



CF card and CF library must be initialized for file operations. See Cf_Fat_Init. File must be previously assigned. See Cf_Fat_Assign. File must be open for reading. See Cf_Fat_Reset.



Example



char character; ... Cf_Fat_Read(&character);
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Libraries Cf_Fat_Rewrite Prototype



void Cf_Fat_Rewrite();



Returns



Nothing.



Description



Opens currently assigned file for writing. If the file is not empty its content will be erased.



Requires



CF card and CF library must be initialized for file operations. See Cf_Fat_Init. The file must be previously assigned. See Cf_Fat_Assign.



Example



// open file for writing Cf_Fat_Rewrite();



Cf_Fat_Append Prototype



void Cf_Fat_Append();



Returns



Nothing.



Opens currently assigned file for appending. Upon this function execution file Description pointers will be positioned after the last byte in the file, so any subsequent file writing operation will start from there. Requires



CF card and CF library must be initialized for file operations. See Cf_Fat_Init. File must be previously assigned. See Cf_Fat_Assign.



Example



// open file for appending Cf_Fat_Append();



Cf_Fat_Delete Prototype



void Cf_Fat_Delete();



Returns



Nothing.



Description Deletes currently assigned file from CF card.
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Requires



CF card and CF library must be initialized for file operations. See Cf_Fat_Init. File must be previously assigned. See Cf_Fat_Assign.



Example



// delete current file Cf_Fat_Delete();
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Cf_Fat_Write Prototype



void Cf_Fat_Write(char *fdata, unsigned data_len);



Returns



Nothing. Writes requested number of bytes to currently assigned file opened for writing.



Description



Parameters: - fdata: data to be written. - data_len: number of bytes to be written.



Requires



CF card and CF library must be initialized for file operations. See Cf_Fat_Init. File must be previously assigned. See Cf_Fat_Assign. File must be open for writing. See Cf_Fat_Rewrite or Cf_Fat_Append.



Example



char file_contents[42]; ... Cf_Fat_Write(file_contents, 42); // write data to the assigned file



Cf_Fat_Set_File_Date Prototype



void Cf_Fat_Set_File_Date(unsigned int year, unsigned short month, unsigned short day, unsigned short hours, unsigned short mins, unsigned short seconds);



Returns



Nothing. Sets the date/time stamp. Any subsequent file writing operation will write this stamp to currently assigned file's time/date attributs. Parameters:



Description - year: year attribute. Valid values: 1980-2107 - month: month attribute. Valid values: 1-12 - day: day attribute. Valid values: 1-31 - hours: hours attribute. Valid values: 0-23 - mins: minutes attribute. Valid values: 0-59 - seconds: seconds attribute. Valid values: 0-59 Requires



CF card and CF library must be initialized for file operations. See Cf_Fat_Init. File must be previously assigned. See Cf_Fat_Assign. File must be open for writing. See Cf_Fat_Rewrite or Cf_Fat_Append.



Example



Cf_Fat_Set_File_Date(2005,9,30,17,41,0);
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Libraries Cf_Fat_Set_File_Date Prototype



void Cf_Fat_Get_File_Date(unsigned int *year, unsigned short *month, unsigned short *day, unsigned short *hours, unsigned short *mins);



Returns



Nothing. Reads time/date attributes of currently assigned file.



Parameters: - year: buffer to store year attribute to. Upon function execution year attribute is returned through this parameter. - month: buffer to store month attribute to. Upon function execution month Description attribute is returned through this parameter. - day: buffer to store day attribute to. Upon function execution day attribute is returned through this parameter. - hours: buffer to store hours attribute to. Upon function execution hours attribute is returned through this parameter. - mins: buffer to store minutes attribute to. Upon function execution minutes attribute is returned through this parameter. Requires



CF card and CF library must be initialized for file operations. See Cf_Fat_Init. File must be previously assigned. See Cf_Fat_Assign.



Example



unsigned year; char month, day, hours, mins; ... Cf_Fat_Get_File_Date(&year, &month, &day, &hours, &mins);



Cf_Fat_Set_File_Size Prototype



unsigned long Cf_Fat_Get_File_Size();



Returns



Size of the currently assigned file in bytes.



Description This function reads size of currently assigned file in bytes.



286



Requires



CF card and CF library must be initialized for file operations. See Cf_Fat_Init. File must be previously assigned. See Cf_Fat_Assign.



Example



unsigned long my_file_size; ... my_file_size = Cf_Fat_Get_File_Size();
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Cf_Fat_Get_Swap_File Prototype Returns



unsigned long Cf_Fat_Get_Swap_File(unsigned long sectors_cnt, char *filename, char file_attr);



- Number of the start sector for the newly created swap file, if there was enough free space on CF card to create file of required size. - 0 otherwise This function is used to create a swap file of predefined name and size on the CF media. If a file with specified name already exists on the media, search for consecutive sectors will ignore sectors occupied by this file. Therefore, it is recommended to erase such file if it exists before calling this function. If it is not erased and there is still enough space for a new swap file, this function will delete it after allocating new memory space for a new swap file. The purpose of the swap file is to make reading and writing to CF media as fast as possible, by using the Cf_Read_Sector() and Cf_Write_Sector() functions directly, without potentially damaging the FAT system. Swap file can be considered as a "window" on the media where the user can freely write/read data. It's main purpose in the mikroC's library is to be used for fast data acquisition; when the time-critical acquisition has finished, the data can be re-written into a "normal" file, and formatted in the most suitable way. Parameters: - sectors_cnt: number of consecutive sectors that user wants the swap file to have. - filename: name of the file that should be assigned for file operations. The file name



should be in DOS 8.3 (file_name.extension) format. The file name and extension will be automatically padded with spaces by the library if they have less than length required (i.e. "mikro.tx" -> "mikro .tx "), so the user does not have to take care of that. The file name and extension are case insensitive. The library will convert them to proper case automatically, so the user does not have to take care of that. Also, in order Description to keep backward compatibility with the first version of this library, file names can be entered as UPPERCASE string of 11 bytes in length with no dot chsaracter between the file name and extension (i.e. "MIKROELETXT" -> MIKROELE.TXT). In this case the last 3 characters of the string are considered to be file extension. - file_attr: file creation and attributs flags. Each bit corresponds to the appropriate file attribut: Bit



Mask



Description



0



0x01



Read Only



1



0x02



Hidden



2



0x04



System



3



0x08



Volume Label



4



0x10



Subdirectory



5



0x20



Archive



6



0x40



Device (internal use only, never found on disk)



7



0x80



Not used



Note: Long File Names (LFN) are not supported.
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Libraries Requires



CF card and CF library must be initialized for file operations. See Cf_Fat_Init.



Example



//-------------- Try to create a swap file with archive atribute, whose size will be at least 1000 sectors. // If it succeeds, it sends the No. of start sector over UART unsigned long size; ... size = Cf_Fat_Get_Swap_File(1000, "mikroE.txt", 0x20); if (size) { UART_Write(0xAA); UART_Write(Lo(size)); UART_Write(Hi(size)); UART_Write(Higher(size)); UART_Write(Highest(size)); UART_Write(0xAA); }



Library Example The following example demonstrates various aspects of the Cf_Fat16 library: Creation of new file and writing down to it; Opening existing file and re-writing it (writing from start-of-file); Opening existing file and appending data to it (writing from end-of-file); Opening a file and reading data from it (sending it to USART terminal); Creating and modifying several files at once; // set compact flash pinout char Cf_Data_Port at PORTD; sbit sbit sbit sbit sbit sbit sbit sbit



CF_RDY CF_WE CF_OE CF_CD1 CF_CE1 CF_A2 CF_A1 CF_A0



at at at at at at at at



RB7_bit; RB6_bit; RB5_bit; RB4_bit; RB3_bit; RB2_bit; RB1_bit; RB0_bit;



sbit CF_RDY_direction sbit CF_WE_direction sbit CF_OE_direction sbit CF_CD1_direction sbit CF_CE1_direction sbit CF_A2_direction sbit CF_A1_direction sbit CF_A0_direction // end of cf pinout



at at at at at at at at



TRISB7_bit; TRISB6_bit; TRISB5_bit; TRISB4_bit; TRISB3_bit; TRISB2_bit; TRISB1_bit; TRISB0_bit;



const LINE_LEN = 39; char err_txt[20] = "FAT16 not found"; char file_contents[LINE_LEN] = "XX CF FAT16 library by Anton Rieckertn";
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CHAPTER 7 mikroC PRO for PIC char filename[14] = "MIKRO00x.TXT"; unsigned short loop, loop2; unsigned long i, size; char Buffer[512];



Libraries // File names



// UART1 write text and new line (carriage return + line feed) void UART1_Write_Line(char *uart_text) { UART1_Write_Text(uart_text); UART1_Write(13); UART1_Write(10); } // Creates new file and writes some data to it void M_Create_New_File() { filename[7] = 'A'; Cf_Fat_Assign(&filename, 0xA0); // Find existing file or create a new one Cf_Fat_Rewrite(); // To clear file and start with new data for(loop = 1; loop 8; Delay_ms(500); }



// // // //



P16's FLASH is 14-bit wide, so two MSB's will always be '00' Display data on PORTB LS Byte and PORTC MS Byte



}
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Libraries GRAPHIC LCD LIBRARY



The mikroC PRO for PIC provides a library for operating Graphic Lcd 128x64 (with commonly used Samsung KS108/KS107 controller). For creating a custom set of Glcd images use Glcd Bitmap Editor Tool.



External dependencies of Graphic LCD Library The following variables must be defined in all projects using Graphic LCD Library:
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Description:



Example:



extern sfr char GLCD_DataPort;



Glcd Data Port.



char GLCD_DataPort at PORTD;



extern sfr sbit GLCD_CS1;



Chip Select 1 line.



sbit GLCD_CS1 at RB0_bit;



extern sfr sbit GLCD_CS2;



Chip Select 2 line.



sbit GLCD_CS2 at RB1_bit;



extern sfr sbit GLCD_RS;



Register select line.



sbit GLCD_RS at RB2_bit;



extern sfr sbit GLCD_RW;



Read/Write line.



sbit GLCD_RW at RB3_bit;



extern sfr sbit GLCD_EN;



Enable line.



sbit GLCD_EN at RB4_bit;



extern sfr sbit GLCD_RST;



Reset line.



sbit GLCD_RST at RB5_bit;



extern sfr sbit GLCD_CS1_Direction;



Direction of the Chip Select 1 pin.



sbit GLCD_CS1_Direction at TRISB0_bit;



extern sfr sbit GLCD_CS2_Direction;



Direction of the Chip Select 2 pin.



sbit GLCD_CS2_Direction at TRISB1_bit;



extern sfr sbit GLCD_RS_Direction;



Direction of the Register select pin.



sbit GLCD_RS_Direction at TRISB2_bit;



extern sfr sbit GLCD_RW_Direction;



Direction of the Read/Write pin.



sbit GLCD_RW_Direction at TRISB3_bit;



extern sfr sbit GLCD_EN_Direction;



Direction of the Enable pin.



sbit GLCD_EN_Direction at TRISB4_bit;



extern sfr sbit GLCD_RST_Direction;



Direction of the Reset pin.



sbit GLCD_RST_Direction at TRISB5_bit;
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Library Routines Basic routines: -



Glcd_Init Glcd_Set_Side Glcd_Set_X Glcd_Set_Page Glcd_Read_Data Glcd_Write_Data



Advanced routines: -



Glcd_Fill Glcd_Dot Glcd_Line Glcd_V_Line Glcd_H_Line Glcd_Rectangle Glcd_Box Glcd_Circle Glcd_Set_Font Glcd_Write_Char Glcd_Write_Text Glcd_Image
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Libraries Glcd_Init Prototype



void Glcd_Init();



Returns



Nothing.



Description



Initializes the Glcd module. Each of the control lines is both port and pin configurable, while data lines must be on a single port (pins ). Global variables:



Requires



-



GLCD_CS1: Chip select 1 signal pin GLCD_CS2: Chip select 2 signal pin GLCD_RS: Register select signal pin GLCD_RW: Read/Write Signal pin GLCD_EN: Enable signal pin GLCD_RST: Reset signal pin GLCD_DataPort: Data port GLCD_CS1_Direction: Direction of the Chip select 1 pin GLCD_CS2_Direction: Direction of the Chip select 2 pin GLCD_RS_Direction: Direction of the Register select signal pin GLCD_RW_Direction: Direction of the Read/Write signal pin GLCD_EN_Direction: Direction of the Enable signal pin GLCD_RST_Direction: Direction of the Reset signal pin



must be defined before using this function. // glcd pinout settings char GLCD_DataPort at PORTD; sbit sbit sbit sbit sbit sbit



Example
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GLCD_CS1 at RB0_bit; GLCD_CS2 at RB1_bit; GLCD_RS at RB2_bit; GLCD_RW at RB3_bit; GLCD_EN at RB4_bit; GLCD_RST at RB5_bit;



sbit GLCD_CS1_Direction at TRISB0_bit; sbit GLCD_CS2_Direction at TRISB1_bit; sbit GLCD_RS_Direction at TRISB2_bit; sbit GLCD_RW_Direction at TRISB3_bit; sbit GLCD_EN_Direction at TRISB4_bit; sbit GLCD_RST_Direction at TRISB5_bit; ... ANSEL = 0; ANSELH = 0; Glcd_Init();
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Glcd_Set_Side Prototype



void Glcd_Set_Side(unsigned short x_pos);



Returns



Nothing. Selects Glcd side. Refer to the Glcd datasheet for detailed explaination. Parameters: - x_pos: position on x-axis. Valid values: 0..127



Description The parameter x_pos specifies the Glcd side: values from 0 to 63 specify the left side, values from 64 to 127 specify the right side. Note: For side, x axis and page layout explanation see schematic at the bottom of this page. Requires



Glcd needs to be initialized, see Glcd_Init routine. The following two lines are equivalent, and both of them select the left side of Glcd:



Example Glcd_Select_Side(0); Glcd_Select_Side(10);



Glcd_Set_X Prototype



void Glcd_Set_X(unsigned short x_pos);



Returns



Nothing. Sets x-axis position to x_pos dots from the left border of Glcd within the selected side. Parameters:



Description - x_pos: position on x-axis. Valid values: 0..63



Note: For side, x axis and page layout explanation see schematic at the bottom of this page. Requires



Glcd needs to be initialized, see Glcd_Init routine.



Example



Glcd_Set_X(25);
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Libraries Glcd_Set_Page Prototype



void Glcd_Set_Page(unsigned short page);



Returns



Nothing. Selects page of the Glcd. Parameters:



Description



- page: page number. Valid values: 0..7 Note: For side, x axis and page layout explanation see schematic at the bottom of this page.



Requires



GLCD needs to be initialized, see Glcd_Init routine.



Example



Glcd_Set_Page(5);



Glcd_Read_Data Prototype



unsigned short Glcd_Read_Data();



Returns



One byte from GLCD memory.



Description



Reads data from from the current location of Glcd memory and moves to the next location. Glcd needs to be initialized, see Glcd_Init routine.



Requires



Example
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Glcd side, x-axis position and page should be set first. See functions Glcd_Set_Side, Glcd_Set_X, and Glcd_Set_Page. unsigned short data; ... data = Glcd_Read_Data();
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Glcd_Write_Data Prototype



void Glcd_Write_Data(unsigned short ddata);



Returns



Nothing. Writes one byte to the current location in Glcd memory and moves to the next location.



Description



Parameters: - ddata: data to be written Glcd needs to be initialized, see Glcd_Init routine.



Requires



Example



Glcd side, x-axis position and page should be set first. See functions Glcd_Set_Side, Glcd_Set_X, and Glcd_Set_Page. unsigned short data; ... Glcd_Write_Data(data);



Glcd_Fill Prototype



void Glcd_Fill(unsigned short pattern);



Returns



Nothing. Fills Glcd memory with the byte pattern. Parameters:



Description - pattern: byte to fill Glcd memory with To clear the Glcd screen, use Glcd_Fill(0). To fill the screen completely, use Glcd_Fill(0xFF). Requires



Glcd needs to be initialized, see Glcd_Init routine.



Example



// Clear screen Glcd_Fill(0);
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Libraries Glcd_Dot Prototype



void Glcd_Dot(unsigned short x_pos, unsigned short y_pos, unsigned short color);



Returns



Nothing. Draws a dot on Glcd at coordinates (x_pos, y_pos). Parameters:



- x_pos: x position. Valid values: 0..127 - y_pos: y position. Valid values: 0..63 Description - color: color parameter. Valid values: 0..2 The parameter color determines a dot state: 0 clears dot, 1 puts a dot, and 2 inverts dot state. Note: For x and y axis layout explanation see schematic at the bottom of this page. Requires



Glcd needs to be initialized, see Glcd_Init routine.



Example



// Invert the dot in the upper left corner Glcd_Dot(0, 0, 2);



Glcd_Line Prototype



void Glcd_Line(int x_start, int y_start, int x_end, int y_end, unsigned short color);



Returns



Nothing. Draws a line on Glcd. Parameters:



Description -



x_start: x coordinate of the line start. Valid values: 0..127 y_start: y coordinate of the line start. Valid values: 0..63 x_end: x coordinate of the line end. Valid values: 0..127 y_end: y coordinate of the line end. Valid values: 0..63 color: color parameter. Valid values: 0..2



The parameter color determines the line color: 0 white, 1 black, and 2 inverts each dot.
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Requires



Glcd needs to be initialized, see Glcd_Init routine.



Example



// Draw a line between dots (0,0) and (20,30) Glcd_Line(0, 0, 20, 30, 1);
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Glcd_V_Line Prototype



void Glcd_V_Line(unsigned short y_start, unsigned short y_end, unsigned short x_pos, unsigned short color);



Returns



Nothing. Draws a vertical line on Glcd. Parameters:



Description -



y_start: y coordinate of the line start. Valid values: 0..63 y_end: y coordinate of the line end. Valid values: 0..63 x_pos: x coordinate of vertical line. Valid values: 0..127 color: color parameter. Valid values: 0..2



The parameter color determines the line color: 0 white, 1 black, and 2 inverts each dot. Requires



Glcd needs to be initialized, see Glcd_Init routine.



Example



// Draw a vertical line between dots (10,5) and (10,25) Glcd_V_Line(5, 25, 10, 1);



Glcd_H_Line Prototype



void Glcd_H_Line(unsigned short x_start, unsigned short x_end, unsigned short y_pos, unsigned short color);



Returns



Nothing. Draws a horizontal line on Glcd. Parameters:



- x_start: x coordinate of the line start. Valid values: 0..127 Description -x_end: x coordinate of the line end. Valid values: 0..127 - y_pos: y coordinate of horizontal line. Valid values: 0..63 - color: color parameter. Valid values: 0..2 The parameter color determines the line color: 0 white, 1 black, and 2 inverts each dot. Requires



Glcd needs to be initialized, see Glcd_Init routine.



Example



// Draw a horizontal line between dots (10,20) and (50,20) Glcd_H_Line(10, 50, 20, 1);
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Libraries Glcd_Rectangle Prototype



void Glcd_Rectangle(unsigned short x_upper_left, unsigned short y_upper_left, unsigned short x_bottom_right, unsigned short y_bottom_right, unsigned short color);



Returns



Nothing. Draws a rectangle on GLCD. Parameters:



- x_upper_left: x coordinate of the upper left rectangle corner. Valid values: 0..127 - y_upper_left: y coordinate of the upper left rectangle corner. Valid values: 0..63 - x_bottom_right: x coordinate of the lower right rectangle corner. Valid Description values: 0..127 - y_bottom_right: y coordinate of the lower right rectangle corner. Valid values: 0..63 - color: color parameter. Valid values: 0..2 The parameter color determines the color of the rectangle border: 0 white, 1 black, and 2 inverts each dot. Requires



GLCD needs to be initialized, see Glcd_Init routine.



Example



// Draw a rectangle between dots (5,5) and (40,40) Glcd_Rectangle(5, 5, 40, 40, 1);



Glcd_Box Prototype



void Glcd_Box(unsigned short x_upper_left, unsigned short y_upper_left, unsigned short x_bottom_right, unsigned short y_bottom_right, unsigned short color);



Returns



Nothing. Draws a box on GLCD.



Parameters: - x_upper_left: x coordinate of the upper left box corner. Valid values: 0..127 - y_upper_left: y coordinate of the upper left box corner. Valid values: 0..63 Description - x_bottom_right: x coordinate of the lower right box corner. Valid values: 0..127 - y_bottom_right: y coordinate of the lower right box corner. Valid values: 0..63 - color: color parameter. Valid values: 0..2 The parameter color determines the color of the box fill: 0 white, 1 black, and 2 inverts each dot.
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Requires



GLCD needs to be initialized, see Glcd_Init routine.



Example



// Draw a box between dots (5,15) and (20,40) Glcd_Box(5, 15, 20, 40, 1);
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Glcd_Circle Prototype



void Glcd_Circle(int x_center, int y_center, int radius, unsigned short color);



Returns



Nothing. Draws a circle on GLCD. Parameters:



Description -



x_center: x coordinate of the circle center. Valid values: 0..127 y_center: y coordinate of the circle center. Valid values: 0..63 radius: radius size color: color parameter. Valid values: 0..2



The parameter color determines the color of the circle line: 0 white, 1 black, and 2 inverts each dot. Requires



GLCD needs to be initialized, see Glcd_Init routine.



Example



// Draw a circle with center in (50,50) and radius=10 Glcd_Circle(50, 50, 10, 1);



Glcd_Set_Font Prototype



void Glcd_Set_Font(const char *activeFont, unsigned short aFontWidth, unsigned short aFontHeight, unsigned int aFontOffs);



Returns



Nothing. Sets font that will be used with Glcd_Write_Char and Glcd_Write_Text routines. Parameters:



Description



activeFont: font to be set. Needs to be formatted as an array of byte aFontWidth: width of the font characters in dots. aFontHeight: height of the font characters in dots. aFontOffs: number that represents difference between the mikroC PRO for



PIC character set and regular ASCII set (eg. if 'A' is 65 in ASCII character, and 'A' is 45 in the mikroC PRO for PIC character set, aFontOffs is 20). Demo fonts supplied with the library have an offset of 32, which means that they start with space.



The user can use fonts given in the file “__Lib_GLCDFonts” file located in the Uses folder or create his own fonts. Requires



GLCD needs to be initialized, see Glcd_Init routine.



Example



// Use the custom 5x7 font "myfont" which starts with space (32): Glcd_Set_Font(&myfont, 5, 7, 32);
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Libraries Glcd_Write_Char Prototype



void Glcd_Write_Char(unsigned short chr, unsigned short x_pos, unsigned short page_num, unsigned short color);



Returns



Nothing. Prints character on the GLCD. Parameters:



- chr: character to be written - x_pos: character starting position on x-axis. Valid values: 0..(127-FontWidth) - page_num: the number of the page on which character will be written. Valid Description values: 0..7 - color: color parameter. Valid values: 0..2 The parameter color determines the color of the character: 0 white, 1 black, and 2 inverts each dot. Note: For x axis and page layout explanation see schematic at the bottom of this page.
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Requires



Glcd needs to be initialized, see Glcd_Init routine. Use Glcd_Set_Font to specify the font for display; if no font is specified, then default 5x8 font supplied with the library will be used.



Example



// Write character 'C' on the position 10 inside the page 2: Glcd_Write_Char('C', 10, 2, 1);
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Glcd_Write_Text Prototype



void Glcd_Write_Text(char *text, unsigned short x_pos, unsigned short page_num, unsigned short color);



Returns



Nothing. Prints text on GLCD. Parameters:



- text: text to be written - x_pos: text starting position on x-axis. - page_num: the number of the page on which text will be written. Valid values: 0..7 Description - color: color parameter. Valid values: 0..2 The parameter color determines the color of the text: 0 white, 1 black, and 2 inverts each dot. Note: For x axis and page layout explanation see schematic at the bottom of this page. Requires



Glcd needs to be initialized, see Glcd_Init routine. Use Glcd_Set_Font to specify the font for display; if no font is specified, then default 5x8 font supplied with the library will be used.



Example



// Write text "Hello world!" on the position 10 inside the page 2: Glcd_Write_Text("Hello world!", 10, 2, 1);



Glcd_Image Prototype



void Glcd_Image(code const unsigned short *image);



Returns



Nothing. Displays bitmap on GLCD. Parameters:



Description



- image: image to be displayed. Bitmap array must be located in code memory. Use the mikroC PRO for PIC integrated Glcd Bitmap Editor to convert image to a constant array suitable for displaying on Glcd.



Requires



Glcd needs to be initialized, see Glcd_Init routine.



Example



// Draw image my_image on Glcd Glcd_Image(my_image);
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Libraries Library Example



The following example demonstrates routines of the Glcd library: initialization, clear(pattern fill), image displaying, drawing lines, circles, boxes and rectangles, text displaying and handling. //Declarations----------------------------------------------------------------const code char truck_bmp[1024]; //--------------------------------------------------------------enddeclarations // Glcd module connections char GLCD_DataPort at PORTD; sbit sbit sbit sbit sbit sbit



GLCD_CS1 GLCD_CS2 GLCD_RS GLCD_RW GLCD_EN GLCD_RST



at at at at at at



RB0_bit; RB1_bit; RB2_bit; RB3_bit; RB4_bit; RB5_bit;



sbit GLCD_CS1_Direction at TRISB0_bit; sbit GLCD_CS2_Direction at TRISB1_bit; sbit GLCD_RS_Direction at TRISB2_bit; sbit GLCD_RW_Direction at TRISB3_bit; sbit GLCD_EN_Direction at TRISB4_bit; sbit GLCD_RST_Direction at TRISB5_bit; // End Glcd module connections void delay2S(){ Delay_ms(2000); }



// 2 seconds delay function



void main() { unsigned short ii; char *someText; #define COMPLETE_EXAMPLE // comment this line to make simpler/smaller example ANSEL = 0; // Configure AN pins as digital ANSELH = 0; C1ON_bit = 0; // Disable comparators C2ON_bit = 0; Glcd_Init(); Glcd_Fill(0x00);



// Initialize GLCD // Clear GLCD



while(1) {
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Libraries #ifdef COMPLETE_EXAMPLE Glcd_Image(truck_bmp); delay2S(); delay2S(); #endif Glcd_Fill(0x00); Glcd_Box(62,40,124,56,1); Glcd_Rectangle(5,5,84,35,1); Glcd_Line(0, 0, 127, 63, 1); delay2S();



// Draw image



// Clear GLCD // Draw box // Draw rectangle // Draw line



for(ii = 5; ii < 60; ii+=5 ){ // Draw horizontal and vertical lines Delay_ms(250); Glcd_V_Line(2, 54, ii, 1); Glcd_H_Line(2, 120, ii, 1); } delay2S(); Glcd_Fill(0x00); // Clear GLCD #ifdef COMPLETE_EXAMPLE Glcd_Set_Font(Character8x7, 8, 7, 32);// Choose font, see __Lib_GLCDFonts.c in Uses folder #endif Glcd_Write_Text("mikroE", 1, 7, 2); // Write string for (ii = 1; ii output voltage (0..Vref) void DAC_Output(unsigned int valueDAC) { char temp; Chip_Select = 0;



// Select DAC chip



// Send High Byte temp = (valueDAC >> 8) & 0x0F;// Store valueDAC[11..8] to temp[3..0] temp |= 0x30; // Define DAC setting, see MCP4921 datasheet Soft_SPI_Write(temp); // Send high byte via Soft SPI // Send Low Byte temp = valueDAC; Soft_SPI_Write(temp);



// Store valueDAC[7..0] to temp[7..0] // Send low byte via Soft SPI



Chip_Select = 1;



// Deselect DAC chip



} void main() { ANSEL



= 0;



// turn off analog inputs
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Libraries ANSELH = 0; InitMain();



// Perform main initialization



value = 2048;



// When program starts, DAC gives // the output in the mid-range



while (1) {



// Endless loop



if ((RA0_bit) && (value < 4095)) { value++; } else { if ((RA1_bit) && (value > 0)) { value--; } } DAC_Output(value); Delay_ms(1);



// If RA0 button is pressed // increment value



// If RA1 button is pressed // decrement value



// Send value to DAC chip // Slow down key repeat pace



} }
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SOFTWARE UART LIBRARY The mikroC PRO for PIC provides routines for implementing Software UART communication. These routines are hardware independent and can be used with any MCU. The Software UART Library provides easy communication with other devices via the RS232 protocol. Note: The Software UART library implements time-based activities, so interrupts need to be disabled when using it.



Library Routines -



Soft_Uart_Init Soft_Uart_Read Soft_Uart_Write Soft_Uart_Break
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char Soft_UART_Init(char *port, char rx_pin, char tx_pin, unsigned long baud_rate, char inverted);



Returns



- 2 - error, requested baud rate is too low - 1 - error, requested baud rate is too high - 0 - successful initialization



Configures and initializes the software UART module. Parameters: Description



port: port to be used. rx_pin: sets rx_pin to be used. tx_pin: sets tx_pin to be used. baud_rate: baud rate to be set. Maximum baud rate depends on the MCU’s



clock and working conditions. - inverted: inverted output flag. When set to a non-zero value, inverted logic on output is used. Software UART routines use Delay_Cyc routine. If requested baud rate is too low then calculated parameter for calling Delay_Cyc exceeeds Delay_Cyc argument range. If requested baud rate is too high then rounding error of Delay_Cyc argument corrupts Software UART timings.



Requires



Nothing. This will initialize software UART and establish the communication at 9600 bps:



Example
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char error; ... error = Soft_UART_Init(&PORTC, 7, 6, 14400, 0); Soft UART at 9600 bps



// Initialize
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Soft_UART_Read Prototype



char Soft_UART_Read(char * error);



Returns



Byte received via UART. The function receives a byte via software UART. This is a blocking function call (waits for start bit). Programmer can unblock it by calling Soft_UART_Break routine.



Description Parameters: - error: Error flag. Error code is returned through this variable. 0 - no error 1 - stop bit error 255 - user abort, Soft_UART_Break called



Requires



Example



Software UART must be initialized before using this function. See the Soft_UART_Init routine. char data, error; ... // wait until data is received do data = Soft_UART_Read(&error); while (error); // Now we can work with data: if (data) {...}
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void Soft_UART_Write(char udata);



Returns



Nothing. This routine sends one byte via the Software UART bus.



Description



Parameters: - udata: data to be sent.



Requires



Software UART must be initialized before using this function. See the Soft_UART_Init routine. Be aware that during transmission, software UART is incapable of receiving data – data transfer protocol must be set in such a way to prevent loss of information.



Example



char some_byte = 0x0A; ... // Write a byte via Soft Uart Soft_UART_Write(some_byte);



Soft_Uart_Break Prototype



void Soft_UART_Break();



Returns



Nothing.



Soft_UART_Read is blocking routine and it can block the program flow. Calling this routine from the interrupt will unblock the program execution. This mechaDescription nism is similar to WDT. Note: Interrupts should be disabled before using Software UART routines again (see note at the top of this page). Requires



Nothing. char data1, error, counter = 0; void interrupt() { if (INTCON.T0IF) { if (counter >= 20) { Soft_UART_Break(); counter = 0; } else counter++;



Example



INTCON.T0IF = 0;



// reset counter



// increment counter // Clear Timer0 overflow interrupt flag



} }
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void main() { OPTION_REG = 0x04;



// TMR0 prescaler set to 1:32



... if (Soft_UART_Init(&PORTC, 7, 6, 9600, 0) = 0) Soft_UART_Write(0x55);



Example



... // try Soft_UART_Read with blocking prevention mechanism INTCON.GIE = 1; // Global interrupt enable INTCON.T0IE = 1; // Enable Timer0 overflow interrupt data1 = Soft_UART_Read(&error); INTCON.GIE = 0; // Global interrupt disable }
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This example demonstrates simple data exchange via software UART. If MCU is connected to the PC, you can test the example from the mikroC PRO for PIC USART Terminal Tool.



char i, error, byte_read;



// Auxiliary variables



void main(){ ANSEL = 0; ANSELH = 0; TRISB = 0x00; PORTB = 0;



// Configure AN pins as digital I/O



// Set PORTB as output (error signalization) // No error



error = Soft_UART_Init(&PORTC, 7, 6, 14400, 0); // Initialize Soft UART at 9600 bps if (error > 0) { PORTB = error; // Signalize Init error while(1); // Stop program } Delay_ms(100); for (i = 'z'; i >= 'A'; i--) { // Send bytes from 'z' downto 'A' Soft_UART_Write(i); Delay_ms(100); } while(1) { // Endless loop byte_read = Soft_UART_Read(&error); // Read byte, then test error flag if (error) // If error was detected PORTB = error; // signal it on PORTB else Soft_UART_Write(byte_read); // If error was not detected, return byte read } }
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SOUND LIBRARY The mikroC PRO for PIC provides a Sound Library to supply users with routines necessary for sound signalization in their applications. Sound generation needs additional hardware, such as piezo-speaker (example of piezo-speaker interface is given on the schematic at the bottom of this page).



Library Routines - Sound_Init - Sound_Play



Sound_Init Prototype



void Sound_Init(char *snd_port, char snd_pin);



Returns



Nothing. Configures the appropriate MCU pin for sound generation.



Description



Parameters: - snd_port: sound output port address - snd_pin: sound output pin



Requires



Nothing.



Example



// Initialize the pin RD3 for playing sound Sound_Init(&PORTD, 3);
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void Sound_Play(unsigned freq_in_hz, unsigned duration_ms);



Returns



Nothing. Generates the square wave signal on the appropriate pin.



Description



Parameters: - freq_in_Hz: signal frequency in Hertz (Hz) - duration_ms: signal duration in miliseconds (ms) Note: frequency range is limited by Delay_Cyc parameter. Maximum frequency that can be produced by this function is Freq_max = Fosc/(80*3). Minimum frequency is Freq_min = Fosc/(80*255). Generated frequency may differ from the freq_in_hz parameter due to integer arithmetics.



Requires



In order to hear the sound, you need a piezo speaker (or other hardware) on designated port. Also, you must call Sound_Init to prepare hardware for output before using this function.



Example



// Play sound of 1KHz in duration of 100ms Sound_Play(1000, 100);



Library Example The example is a simple demonstration of how to use the Sound Library for playing tones on a piezo speaker.



void Tone1() { Sound_Play(659, 250); }



// Frequency = 659Hz, duration = 250ms



void Tone2() { Sound_Play(698, 250); }



// Frequency = 698Hz, duration = 250ms



void Tone3() { Sound_Play(784, 250); }



// Frequency = 784Hz, duration = 250ms



void Melody() { Tone1(); Tone2(); Tone1(); Tone2(); Tone1(); Tone2(); Tone1(); Tone2(); Tone1(); Tone2(); Tone3(); Tone3();
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// Plays the melody "Yellow house" Tone3(); Tone3(); Tone3(); Tone3(); Tone3(); Tone3(); Tone3(); Tone3(); Tone2(); Tone2(); Tone1();
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} void ToneA() { Sound_Play( 880, 50); } void ToneC() { Sound_Play(1046, 50); } void ToneE() { Sound_Play(1318, 50); } void Melody2() { unsigned short i; for (i = 9; i > 0; i--) { ToneA(); ToneC(); ToneE(); } } void main() { ANSEL = 0; ANSELH = 0; TRISB = 0xF8; TRISD = 0xF7;



// Configure AN pins as digital I/O // Configure RB7..RB3 as input // Configure RD3 as output



Sound_Init(&PORTD, 3); Sound_Play(1000, 1000); while (1) { if (Button(&PORTB,7,1,1)) Tone1(); while (PORTB & 0x80);



// RB7 plays Tone1 // Wait for button to be released



if (Button(&PORTB,6,1,1)) Tone2(); while (PORTB & 0x40);



// RB6 plays Tone2



if (Button(&PORTB,5,1,1)) Tone3(); while (PORTB & 0x20);



// RB5 plays Tone3



if (Button(&PORTB,4,1,1)) Melody2(); while (PORTB & 0x10);



// RB4 plays Melody2



if (Button(&PORTB,3,1,1)) Melody(); while (PORTB & 0x08);



// RB3 plays Melody



// Wait for button to be released



// Wait for button to be released



// Wait for button to be released



// Wait for button to be released



} }
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Example of Sound Library sonnection



442



MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 7 mikroC PRO for PIC



Libraries



SPI LIBRARY SPI module is available with a number of PIC MCU models. mikroC PRO for PIC provides a library for initializing Slave mode and comfortable work with Master mode. PIC can easily communicate with other devices via SPI: A/D converters, D/A converters, MAX7219, LTC1290, etc. You need PIC MCU with hardware integrated SPI (for example, PIC16F877). Note: Some PIC18 MCUs have multiple SPI modules. Switching between the SPI modules in the SPI library is done by the SPI_Set_Active function (SPI module has to be previously initialized). Note: In order to use the desired SPI library routine, simply change the number 1 in the prototype with the appropriate module number, i.e. SPI2_Init();



Library Routines -



Spi1_Init Spi1_Init_Advanced Spi1_Read Spi1_Write Spi_Set_Active



Spi_Init Prototype



void SPI1_Init(void);



Returns



Nothing. This routine configures and enables SPI module with the following settings:



Description -



master mode 8 bit data transfer most significant bit sent first serial clock low when idle data sampled on leading edge serial clock = fosc/4



Requires



You need PIC MCU with hardware integrated SPI.



Example



SPI1_Init();



// Initialize the SPI module with default settings
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void SPI1_Init_Advanced(unsigned short master_slav, unsigned short data_sample, unsigned short clock_idle, unsigned short transmit_edge);



Returns



Nothing. Configures and initializes SPI. SPI1_Init or SPI1_Init_Advanced needs to be called before using other functions of SPI Library. Parameters mode, data_sample and clock_idle configure the SPI module, and can have the following values: Description



Predefined library const



SPI work mode:



Description



Master clock = Fosc/4



_SPI_MASTER_OSC_DIV4



Master clock = Fosc/16



_SPI_MASTER_OSC_DIV16



Master clock = Fosc/64



_SPI_MASTER_OSC_DIV64



Master clock source TMR2



_SPI_MASTER_TMR2



Slave select enabled



_SPI_SLAVE_SS_ENABLE



Slave select disabled



_SPI_SLAVE_SS_DIS



Data sampling interval: Input data sampled in middle of interval



_SPI_DATA_SAMPLE_MIDDLE



Input data sampled at the end of interval _SPI_DATA_SAMPLE_END



SPI clock idle state: Clock idle HIGH



_SPI_CLK_IDLE_HIGH



Clock idle LOW



_SPI_CLK_IDLE_LOW



Transmit edge:
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Data transmit on low to high edge



_SPI_LOW_2_HIGH



Data transmit on high to low edge



_SPI_HIGH_2_LOW



Requires



You need PIC MCU with hardware integrated SPI.



Example



// Set SPI1 module to master mode, clock = Fosc/4, data sampled at the middle of interval, clock idle state low and data transmitted at low to high edge: SPI1_Init_Advanced(_SPI_MASTER_OSC_DIV4, _SPI_DATA_SAMPLE_MIDDLE, _SPI_CLK_IDLE_LOW, _SPI_LOW_2_HIGH);
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Spi1_Read Prototype



unsigned short SPI1_Read(unsigned short buffer);



Returns



Returns the received data. Reads one byte from the SPI bus.



Description



Parameters: - buffer: dummy data for clock generation (see device Datasheet for SPI modules implementation details) You need PIC MCU with hardware integrated SPI.



Requires



Example



SPI must be initialized and communication established before using this function. See SPI1_Init_Advanced or SPI1_Init. short take, buffer; ... take = SPI1_Read(buffer);



Spi1_Write Prototype



void SPI1_Write(unsigned short data_);



Returns



Nothing. Writes byte via the SPI bus.



Description Parameters: - wrdata: data to be sent You need PIC MCU with hardware integrated SPI. Requires



Example



SPI must be initialized and communication established before using this function. See SPI1_Init_Advanced or SPI1_Init. SPI1_Write(1);
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void SPI_Set_Active(char (*read_ptr)(char))



Returns



Nothing. Sets the active SPI module which will be used by the SPI routines.



Description Parameters: - read_ptr: SPI1_Read handler Requires



Routine is available only for MCUs with two SPI modules. Used SPI module must be initialized before using this function. See the SPI1_Init, SPI1_Init_Advanced



Example



SPI_Set_Active(&SPI2_Read); // Sets the SPI2 module active



Library Example The code demonstrates how to use SPI library functions for communication between SPI module of the MCU and Microchip's MCP4921 12-bit D/A converter // DAC module connections sbit Chip_Select at RC0_bit; sbit Chip_Select_Direction at TRISC0_bit; // End DAC module connections unsigned int value; void InitMain() { TRISB0_bit = 1; TRISB1_bit = 1; Chip_Select = 1; Chip_Select_Direction = 0; SPI1_Init(); }



// Set RA0 pin as input // Set RA1 pin as input // Deselect DAC // Set CS# pin as Output // Initialize SPI module



// DAC increments (0..4095) --> output voltage (0..Vref) void DAC_Output(unsigned int valueDAC) { char temp; Chip_Select = 0;



// Select DAC chip



// Send High Byte temp = (valueDAC >> 8) & 0x0F; // Store valueDAC[11..8] to temp[3..0] temp |= 0x30; // Define DAC setting, see MCP4921 datasheet SPI1_Write(temp); // Send high byte via SPI // Send Low Byte
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temp = valueDAC; SPI1_Write(temp);



// Store valueDAC[7..0] to temp[7..0] // Send low byte via SPI



Chip_Select = 1;



// Deselect DAC chip



} void main() { ANSEL = 0; ANSELH = 0; InitMain(); value = 2048;



while (1) {



// Perform main initialization // When program starts, DAC gives // the output in the mid-range // Endless loop



if ((RA0_bit) && (value < 4095)) { value++; } else { if ((RA1_bit) && (value > 0)) { value--; } } DAC_Output(value); Delay_ms(1);



// If RA0 button is pressed // increment value



// If RA1 button is pressed // decrement value



// Send value to DAC chip // Slow down key repeat pace



} }
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448



MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD



CHAPTER 7 mikroC PRO for PIC



Libraries



SPI ETHERNET LIBRARY The ENC28J60 is a stand-alone Ethernet controller with an industry standard Serial Peripheral Interface (SPI™). It is designed to serve as an Ethernet network interface for any controller equipped with SPI. The ENC28J60 meets all of the IEEE 802.3 specifications. It incorporates a number of packet filtering schemes to limit incoming packets. It also provides an internal DMA module for fast data throughput and hardware assisted IP checksum calculations. Communication with the host controller is implemented via two interrupt pins and the SPI, with data rates of up to 10 Mb/s. Two dedicated pins are used for LED link and network activity indication. This library is designed to simplify handling of the underlying hardware (ENC28J60). It works with any PIC with integrated SPI and more than 4 Kb ROM memory. 38 to 40 MHz clock is recommended to get from 8 to 10 Mhz SPI clock, otherwise PIC should be clocked by ENC28J60 clock output due to its silicon bug in SPI hardware. If you try lower PIC clock speed, there might be board hang or miss some requests. SPI Ethernet library supports: - IPv4 protocol. - ARP requests. - ICMP echo requests. - UDP requests. - TCP requests (no stack, no packet reconstruction). - ARP client with cache. - DNS client. - UDP client. - DHCP client. - packet fragmentation is NOT supported. Note: Due to PIC16 RAM/Flash limitations PIC16 library does NOT have ARP, DNS, UDP and DHCP client support implemented. Note: Global library variable SPI_Ethernet_userTimerSec is used to keep track of time for all client implementations (ARP, DNS, UDP and DHCP). It is user responsibility to increment this variable each second in it's code if any of the clients is used. Note: For advanced users there are header files ("eth_enc28j60LibDef.h" and "eth_enc28j60LibPrivate.h") in Uses\P16 and Uses\P18 folders of the compiler with description of all routines and global variables, relevant to the user, implemented in the SPI Ethernet Library.
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Note: The appropriate hardware SPI module must be initialized before using any of the SPI Ethernet library routines. Refer to SPI Library. For MCUs with two SPI modules it is possible to initialize both of them and then switch by using the SPI_Set_Active() routine.



External dependencies of SPI Ethernet Library The following variables must be defined in all projects using SPI Ethernet Library:



Description:



Example:



extern sfr sbit SPI_Ethernet_CS



ENC28J60 chip select pin. at RC1_bit;



sbit SPI_Ethernet_CS



extern sfr sbit SPI_Ethernet_RST;



ENC28J60 reset pin.



sbit SPI_Ethernet_Rst at RC0_bit;



extern sfr sbit sbit Direction of the ENC28J60 SPI_Ethernet_CS_Direc SPI_Ethernet_CS_Direc chip select pin. tion; tion at TRISC1_bit; extern sfr sbit sbit Direction of the ENC28J60 SPI_Ethernet_RST_Dire SPI_Ethernet_Rst_Dire reset pin. ction; ction at TRISC0_bit;



The following routines must be defined in all project using SPI Ethernet Library:
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Description:



Example:



unsigned int SPI_Ethernet_UserTCP(unsigned char *remoteHost, unsigned int remotePort, unsigned int localPort, unsigned int reqLength);



Refer to the library example at the botTCP request handler. tom of this page for code implementation.



unsigned int SPI_Ethernet_UserUDP(unsigned char *remoteHost, unsigned int remotePort, unsigned int destPort, unsigned int reqLength);



Refer to the library example at the botUDP request handler. tom of this page for code implementation.
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Library Routines PIC16 and PIC18: -



SPI_Ethernet_Init SPI_Ethernet_Enable SPI_Ethernet_Disable SPI_Ethernet_doPacket SPI_Ethernet_putByte SPI_Ethernet_putBytes SPI_Ethernet_putString SPI_Ethernet_putConstString SPI_Ethernet_putConstBytes SPI_Ethernet_getByte SPI_Ethernet_getBytes SPI_Ethernet_UserTCP SPI_Ethernet_UserUDP



PIC18 Only: -



SPI_Ethernet_getIpAddress SPI_Ethernet_getGwIpAddress SPI_Ethernet_getDnsIpAddress SPI_Ethernet_getIpMask SPI_Ethernet_confNetwork SPI_Ethernet_arpResolve SPI_Ethernet_sendUDP SPI_Ethernet_dnsResolve SPI_Ethernet_initDHCP SPI_Ethernet_doDHCPLeaseTime SPI_Ethernet_renewDHCP
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void SPI_Ethernet_Init(unsigned char *mac, unsigned char *ip, unsigned char fullDuplex);



Returns



Nothing. This is MAC module routine. It initializes ENC28J60 controller. This function is internaly splited into 2 parts to help linker when coming short of memory. ENC28J60 controller settings (parameters not mentioned here are set to default):



- receive buffer start address : 0x0000. - receive buffer end address : 0x19AD. - transmit buffer start address: 0x19AE. - transmit buffer end address : 0x1FFF. - RAM buffer read/write pointers in auto-increment mode. - receive filters set to default: CRC + MAC Unicast + MAC Broadcast in OR mode. - flow control with TX and RX pause frames in full duplex mode. - frames are padded to 60 bytes + CRC. - maximum packet size is set to 1518. Description - Back-to-Back Inter-Packet Gap: 0x15 in full duplex mode; 0x12 in half duplex mode. - Non-Back-to-Back Inter-Packet Gap: 0x0012 in full duplex mode; 0x0C12 in half duplex mode. - Collision window is set to 63 in half duplex mode to accomodate some ENC28J60 revisions silicon bugs. - CLKOUT output is disabled to reduce EMI generation. - half duplex loopback disabled. - LED configuration: default (LEDA-link status, LEDB-link activity). Parameters: - mac: RAM buffer containing valid MAC address. - ip: RAM buffer containing valid IP address. - fullDuplex: ethernet duplex mode switch. Valid values: 0 (half duplex mode) and 1 (full duplex mode).
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Global variables: Requires



SPI_Ethernet_CS: Chip Select line SPI_Ethernet_CS_Direction: Direction of the Chip Select pin SPI_Ethernet_RST: Reset line SPI_Ethernet_RST_Direction: Direction of the Reset pin



must be defined before using this function. The SPI module needs to SPI1_Init_Advanced routines.



be



#define SPI_Ethernet_HALFDUPLEX #define SPI_Ethernet_FULLDUPLEX



Example



initialized.



See



the



SPI1_Init



and



0 1



// mE ehternet NIC pinout sfr sbit SPI_Ethernet_Rst at RC0_bit; sfr sbit SPI_Ethernet_CS at RC1_bit; sfr sbit SPI_Ethernet_Rst_Direction at TRISC0_bit; sfr sbit SPI_Ethernet_CS_Direction at TRISC1_bit; // end ethernet NIC definitions unsigned char myMacAddr[6] = {0x00, 0x14, 0xA5, 0x76, 0x19, 0x3f}; // my MAC address unsigned char myIpAddr = {192, 168, 1, 60 }; // my IP addr SPI1_Init(); SPI_Ethernet_Init(myMacAddr, myIpAddr, SPI_Ethernet_FULLDUPLEX);
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void SPI_Ethernet_Enable(unsigned char enFlt);



Returns



Nothing. This is MAC module routine. This routine enables appropriate network traffic on the ENC28J60 module by the means of it's receive filters (unicast, multicast, broadcast, crc). Specific type of network traffic will be enabled if a corresponding bit of this routine's input parameter is set. Therefore, more than one type of network traffic can be enabled at the same time. For this purpose, predefined library constants (see the table below) can be ORed to form appropriate input value. Parameters: - enFlt: network traffic/receive filter flags. Each bit corresponds to the appropriate network traffic/receive filter: Bit Mask



Description MAC Broadcast traffic/receive filter



0



0x01 flag. When set, MAC broadcast traf-



fic will be enabled. MAC Multicast traffic/receive filter 1



0x02 flag. When set, MAC multicast traffic



will be enabled. Description



Predefined library const _SPI_Ethernet_BROADCAST _SPI_Ethernet_MULTICAST



2



0x04 not used



none



3



0x08 not used



none



4



0x10 not used



none



5



0x20



6



0x40 not used



7



0x80 When set, MAC unicast traffic will be _SPI_Ethernet_UNICAST



CRC check flag. When set, packets _SPI_Ethernet_CRC with invalid CRC field will be discarded. none



MAC Unicast traffic/receive filter flag. enabled. Note: Advance filtering available in the ENC28J60 module such as Pattern Match, Magic Packet and Hash Table can not be enabled by this routine. Additionaly, all filters, except CRC, enabled with this routine will work in OR mode, which means that packet will be received if any of the enabled filters accepts it. Note: This routine will change receive filter configuration on-the-fly. It will not, in any way, mess with enabling/disabling receive/transmit logic or any other part of the ENC28J60 module. The ENC28J60 module should be properly cofigured by the means of SPI_Ethernet_Init routine.
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Requires



Ethernet module has to be initialized. See SPI_Ethernet_Init.



Example



SPI_Ethernet_Enable(_SPI_Ethernet_CRC | _SPI_Ethernet_UNICAST); // enable CRC checking and Unicast traffic



Spi_Ethernet_Disable Prototype



void SPI_Ethernet_Disable(unsigned char disFlt);



Returns



Nothing. This is MAC module routine. This routine disables appropriate network traffic on the ENC28J60 module by the means of it's receive filters (unicast, multicast, broadcast, crc). Specific type of network traffic will be disabled if a corresponding bit of this routine's input parameter is set. Therefore, more than one type of network traffic can be disabled at the same time. For this purpose, predefined library constants (see the table below) can be ORed to form appropriate input value. Parameters: - disFlt: network traffic/receive filter flags. Each bit corresponds to the appropriate network traffic/receive filter: Bit Mask



Description



Predefined library const



0



0x01



MAC Broadcast traffic/receive filter flag. When set, MAC broadcast traffic will be disabled.



1



0x02



MAC Multicast traffic/receive filter flag. When Spi_Ethernet_MUL TICAST set, MAC multicast traffic will be disabled.



2



0x04 not used



none



3



0x08 not used



none



4



0x10 not used



none



5



0x20 be disabled and packets with invalid CRC



Description



Spi_Ethernet_BRO ADCAST



CRC check flag. When set, CRC check will Spi_Ethernet_CRC



field will be accepted. 6



0x40 not used



7



0x80



MAC Unicast traffic/receive filter flag. When set, MAC unicast traffic will be disabled.



none Spi_Ethernet_UNI CAST



Note: Advance filtering available in the ENC28J60 module such as Pattern Match, Magic Packet and Hash Table can not be disabled by this routine. Note: This routine will change receive filter configuration on-the-fly. It will not, in any way, mess with enabling/disabling receive/transmit logic or any other part of the ENC28J60 module. The ENC28J60 module should be properly cofigured by the means of SPI_Ethernet_Init routine. MIKROELEKTRONIKA - SOFTWARE AND HARDWARE SOLUTIONS FOR EMBEDDED WORLD
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Ethernet module has to be initialized. See SPI_Ethernet_Init.



Example



SPI_Ethernet_Disable(_SPI_Ethernet_CRC | _SPI_Ethernet_UNICAST); // disable CRC checking and Unicast traffic



Spi_Ethernet_doPacket Prototype



unsigned char SPI_Ethernet_doPacket();



Returns



- 0 - upon successful packet processing (zero packets received or received packet processed successfully). - 1 - upon reception error or receive buffer corruption. ENC28J60 controller needs to be restarted. - 2 - received packet was not sent to us (not our IP, nor IP broadcast address). - 3 - received IP packet was not IPv4. - 4 - received packet was of type unknown to the library. This is MAC module routine. It processes next received packet if such exists. Packets are processed in the following manner:



- ARP & ICMP requests are replied automatically. - upon TCP request the Spi_Ethernet_UserTCP function is called for further Description processing. - upon UDP request the Spi_Ethernet_UserUDP function is called for further processing. Note: Spi_Ethernet_doPacket must be called as often as possible in user's code.
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Requires



Ethernet module has to be initialized. See Spi_Ethernet_Init.



Example



if (SPI_Ethernet_doPacket() == 0)(1) { ets ... }



// process received pack-
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Spi_Ethernet_putByte Prototype



void SPI_Ethernet_putByte(unsigned char v);



Returns



Nothing. This is MAC module routine. It stores one byte to address pointed by the current ENC28J60 write pointer (EWRPT).



Description



Parameters: - v: value to store



Requires



Ethernet module has to be initialized. See Spi_Ethernet_Init.



Example



char data; ... SPI_Ethernet_putByte(data); // put an byte into ENC28J60 buffer



Spi_Ethernet_putBytes Prototype



void SPI_Ethernet_putBytes(unsigned char *ptr, unsigned char n);



Returns



Nothing. This is MAC module routine. It stores requested number of bytes into ENC28J60 RAM starting from current ENC28J60 write pointer (EWRPT) location.



Description Parameters: - ptr: RAM buffer containing bytes to be written into ENC28J60 RAM. - n: number of bytes to be written. Requires



Ethernet module has to be initialized. See Spi_Ethernet_Init.



Example



char *buffer = "mikroElektronika"; ... SPI_Ethernet_putBytes(buffer, 16); // put an RAM array into ENC28J60 buffer
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void SPI_Ethernet_putConstBytes(const unsigned char *ptr, unsigned char n);



Returns



Nothing. This is MAC module routine. It stores requested number of const bytes into ENC28J60 RAM starting from current ENC28J60 write pointer (EWRPT) location.



Description Parameters: - ptr: const buffer containing bytes to be written into ENC28J60 RAM. - n: number of bytes to be written. Requires



Ethernet module has to be initialized. See Spi_Ethernet_Init.



Example



const char *buffer = "mikroElektronika"; ... SPI_Ethernet_putConstBytes(buffer, 16); // put a const array into ENC28J60 buffer



Spi_Ethernet_putString Prototype



unsigned int SPI_Ethernet_putString(unsigned char *ptr);



Returns



Number of bytes written into ENC28J60 RAM. This is MAC module routine. It stores whole string (excluding null termination) into ENC28J60 RAM starting from current ENC28J60 write pointer (EWRPT) location.



Description



Parameters: - ptr: string to be written into ENC28J60 RAM.
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Requires



Ethernet module has to be initialized. See Spi_Ethernet_Init.



Example



char *buffer = "mikroElektronika"; ... SPI_Ethernet_putString(buffer); // put a RAM string into ENC28J60 buffer
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Spi_Ethernet_putConstString Prototype



unsigned int SPI_Ethernet_putConstString(const unsigned char *ptr);



Returns



Number of bytes written into ENC28J60 RAM. This is MAC module routine. It stores whole const string (excluding null termination) into ENC28J60 RAM starting from current ENC28J60 write pointer (EWRPT) location.



Description



Parameters: - ptr: const string to be written into ENC28J60 RAM.



Requires



Ethernet module has to be initialized. See Spi_Ethernet_Init.



Example



const char *buffer = "mikroElektronika"; ... SPI_Ethernet_putConstString(buffer); // put a const string into ENC28J60 buffer



Spi_Ethernet_getByte Prototype



unsigned char SPI_Ethernet_getByte();



Returns



Byte read from ENC28J60 RAM.



Description



This is MAC module routine. It fetches a byte from address pointed to by current ENC28J60 read pointer (ERDPT).



Requires



Ethernet module has to be initialized. See Spi_Ethernet_Init.



Example



char buffer; ... buffer = SPI_Ethernet_getByte(); // read a byte from ENC28J60 buffer
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void SPI_Ethernet_getBytes(unsigned char *ptr, unsigned int addr, unsigned char n);



Returns



Nothing. This is MAC module routine. It fetches equested number of bytes from ENC28J60 RAM starting from given address. If value of 0xFFFF is passed as the address parameter, the reading will start from current ENC28J60 read pointer (ERDPT) location.



Description



Parameters: - ptr: buffer for storing bytes read from ENC28J60 RAM. - addr: ENC28J60 RAM start address. Valid values: 0..8192. - n: number of bytes to be read.
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Requires



Ethernet module has to be initialized. See Spi_Ethernet_Init.



Example



char buffer[16]; ... SPI_Ethernet_getBytes(buffer, 0x100, 16); // read 16 bytes, starting from address 0x100
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Spi_Ethernet_UserTCP Prototype



unsigned int SPI_Ethernet_UserTCP(unsigned char *remoteHost, unsigned int remotePort, unsigned int localPort, unsigned int reqLength);



- 0 - there should not be a reply to the request. - Length of TCP/HTTP reply data field - otherwise.



Returns



This is TCP module routine. It is internally called by the library. The user accesses to the TCP/HTTP request by using some of the SPI_Ethernet_get routines. The user puts data in the transmit buffer by using some of the SPI_Ethernet_put routines. The function must return the length in bytes of the TCP/HTTP reply, or 0 if there is nothing to transmit. If there is no need to reply to the TCP/HTTP requests, just define this function with return(0) as a single statement. Description



Parameters: -



remoteHost : client's IP address. remotePort : client's TCP port. localPort : port to which the request is sent. reqLength : TCP/HTTP request data field length.



Note: The function source code is provided with appropriate example projects. The code should be adjusted by the user to achieve desired reply. Requires



Ethernet module has to be initialized. See Spi_Ethernet_Init.



Example



This function is internally called by the library and should not be called by the user's code.
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unsigned int SPI_Ethernet_UserUDP(unsigned char *remoteHost, unsigned int remotePort, unsigned int destPort, unsigned int reqLength);



Returns



- 0 - there should not be a reply to the request. - Length of UDP reply data field - otherwise. This is UDP module routine. It is internally called by the library. The user accesses to the UDP request by using some of the SPI_Ethernet_get routines. The user puts data in the transmit buffer by using some of the SPI_Ethernet_put routines. The function must return the length in bytes of the UDP reply, or 0 if nothing to transmit. If you don't need to reply to the UDP requests, just define this function with a return(0) as single statement.



Description Parameters: - remoteHost : client's IP address. - remotePort : client's port. - destPort : port to which the request is sent. - reqLength : UDP request data field length. Note: The function source code is provided with appropriate example projects. The code should be adjusted by the user to achieve desired reply. Requires



Ethernet module has to be initialized. See Spi_Ethernet_Init.



Example



This function is internally called by the library and should not be called by the user's code.



SPI_Ethernet_getIpAddress Prototype



unsigned char * SPI_Ethernet_getIpAddress();



Returns



Ponter to the global variable holding IP address.



This routine should be used when DHCP server is present on the network to fetch assigned IP address. Description Note: User should always copy the IP address from the RAM location returned by this routine into it's own IP address buffer. These locations should not be altered by the user in any case.
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Requires



Ethernet module has to be initialized. See SPI_Ethernet_Init. Available for PIC18 family MCUs only.



Example



unsigned char ipAddr[4]; // user IP address buffer ... memcpy(ipAddr, SPI_Ethernet_getIpAddress(), 4); // fetch IP address
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SPI_Ethernet_getGwIpAddress Prototype



unsigned char * SPI_Ethernet_getGwIpAddress();



Returns



Ponter to the global variable holding gateway IP address. This routine should be used when DHCP server is present on the network to fetch assigned gateway IP address.



Description



Note: User should always copy the IP address from the RAM location returned by this routine into it's own gateway IP address buffer. These locations should not be altered by the user in any case!



Requires



Ethernet module has to be initialized. See SPI_Ethernet_Init. Available for PIC18 family MCUs only.



Example



unsigned char gwIpAddr[4]; // user gateway IP address buffer ... memcpy(gwIpAddr, SPI_Ethernet_getGwIpAddress(), 4); // fetch gateway IP address



SPI_Ethernet_getDnsIpAddress Prototype



unsigned char * SPI_Ethernet_getDnsIpAddress()



Returns



Ponter to the global variable holding DNS IP address. This routine should be used when DHCP server is present on the network to fetch assigned DNS IP address.



Description



Note: User should always copy the IP address from the RAM location returned by this routine into it's own DNS IP address buffer. These locations should not be altered by the user in any case.



Requires



Ethernet module has to be initialized. See SPI_Ethernet_Init. Available for PIC18 family MCUs only.



Example



unsigned char dnsIpAddr[4]; // user DNS IP address buffer ... memcpy(dnsIpAddr, SPI_Ethernet_getDnsIpAddress(), 4); // fetch DNS server address
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unsigned char * SPI_Ethernet_getIpMask()



Returns



Ponter to the global variable holding IP subnet mask. This routine should be used when DHCP server is present on the network to fetch assigned IP subnet mask.



Description



Note: User should always copy the IP address from the RAM location returned by this routine into it's own IP subnet mask buffer. These locations should not be altered by the user in any case.



Requires



Ethernet module has to be initialized. See SPI_Ethernet_Init. Available for PIC18 family MCUs only.



Example



unsigned char IpMask[4]; // user IP subnet mask buffer ... memcpy(IpMask, SPI_Ethernet_getIpMask(), 4); // fetch IP subnet mask



SPI_Ethernet_confNetwork Prototype



void SPI_Ethernet_confNetwork(char *ipMask, char *gwIpAddr, char *dnsIpAddr);



Returns



Nothing. Configures network parameters (IP subnet mask, gateway IP address, DNS IP address) when DHCP is not used.



Parameters: - ipMask: IP subnet mask. Description - gwIpAddr gateway IP address. - dnsIpAddr: DNS IP address. Note: The above mentioned network parameters should be set by this routine only if DHCP module is not used. Otherwise DHCP will override these settings
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Requires



Ethernet module has to be initialized. See SPI_Ethernet_Init. Available for PIC18 family MCUs only.



Example



char ipMask[4] = {255, 255, 255, 0 }; // network mask (for example : 255.255.255.0) char gwIpAddr[4] = {192, 168, 1, 1 }; // gateway (router) IP address char dnsIpAddr[4] = {192, 168, 1, 1 }; // DNS server IP address ... SPI_Ethernet_confNetwork(ipMask, gwIpAddr, dnsIpAddr); // set network configuration parameters
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SPI_Ethernet_arpResolve Prototype



unsigned char *SPI_Ethernet_arpResolve(unsigned char *ip, unsigned char tmax);



Returns



- MAC address behind the IP address - the requested IP address was resolved. - 0 - otherwise. This is ARP module routine. It sends an ARP request for given IP address and waits for ARP reply. If the requested IP address was resolved, an ARP cash entry is used for storing the configuration. ARP cash can store up to 3 entries. For ARP cash structure refer to "eth_enc28j60LibDef.h" header file in the compiler's Uses/P18 folder.



Description Parameters: - ip: IP address to be resolved. - tmax: time in seconds to wait for an reply. Note: The Ethernet services are not stopped while this routine waits for ARP reply. The incoming packets will be processed normaly during this time. Requires



Ethernet module has to be initialized. See SPI_Ethernet_Init. Available for PIC18 family MCUs only.



Example



unsigned char IpAddr[4] = {192, 168, 1, 1 }; // IP address ... SPI_Ethernet_arpResolve(IpAddr, 5); // get MAC address behind the above IP address, wait 5 secs for the response
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unsigned char SPI_Ethernet_sendUDP(unsigned char *destIP, unsigned int sourcePort, unsigned int destPort, unsigned char *pkt, unsigned int pktLen);



Returns



- 1 - UDP packet was sent successfuly. - 0 - otherwise. This is UDP module routine. It sends an UDP packet on the network. Parameters:



Description -
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destIP: remote host IP address. sourcePort: local UDP source port number. destPort: destination UDP port number. pkt: packet to transmit. pktLen: length in bytes of packet to transmit.



Requires



Ethernet module has to be initialized. See SPI_Ethernet_Init. Available for PIC18 family MCUs only.



Example



unsigned char IpAddr[4] = {192, 168, 1, 1 }; // remote IP address ... SPI_Ethernet_sendUDP(IpAddr, 10001, 10001, "Hello", 5); // send Hello message to the above IP address, from UDP port 10001 to UDP port 10001
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SPI_Ethernet_dnsResolve Prototype



unsigned char * SPI_Ethernet_dnsResolve(unsigned char *host, unsigned char tmax);



Returns



- pointer to the location holding the IP address - the requested host name was resolved. - 0 - otherwise. This is DNS module routine. It sends an DNS request for given host name and waits for DNS reply. If the requested host name was resolved, it's IP address is stored in library global variable and a pointer containing this address is returned by the routine. UDP port 53 is used as DNS port. Parameters:



Description



-host: host name to be resolved. -tmax: time in seconds to wait for an reply. Note: The Ethernet services are not stopped while this routine waits for DNS reply. The incoming packets will be processed normaly during this time. Note: User should always copy the IP address from the RAM location returned by this routine into it's own resolved host IP address buffer. These locations should not be altered by the user in any case.



Requires



Ethernet module has to be initialized. See SPI_Ethernet_Init. Available for PIC18 family MCUs only.



Example



unsigned char * remoteHostIpAddr[4]; // user host IP address buffer ... // SNTP server: // Zurich, Switzerland: Integrated Systems Lab, Swiss Fed. Inst. of Technology // 129.132.2.21: swisstime.ethz.ch // Service Area: Switzerland and Europe memcpy(remoteHostIpAddr, SPI_Ethernet_dnsResolve("swisstime.ethz.ch", 5), 4);
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Libraries SPI_Ethernet_initDHCP Prototype



unsigned char SPI_Ethernet_initDHCP(unsigned char tmax);



Returns



- 1 - network parameters were obtained successfully. - 0 - otherwise. This is DHCP module routine. It sends an DHCP request for network parameters (IP, gateway, DNS addresses and IP subnet mask) and waits for DHCP reply. If the requested parameters were obtained successfuly, their values are stored into the library global variables. These parameters can be fetched by using appropriate library IP get routines: -



SPI_Ethernet_getIpAddress - fetch IP address. SPI_Ethernet_getGwIpAddress - fetch gateway IP address. SPI_Ethernet_getDnsIpAddress - fetch DNS IP address. SPI_Ethernet_getIpMask - fetch IP subnet mask.



Description UDP port 68 is used as DHCP client port and UDP port 67 is used as DHCP server port. Parameters: - tmax: time in seconds to wait for an reply.



Note: The Ethernet services are not stopped while this routine waits for DNS reply. The incoming packets will be processed normaly during this time. Note:



When



DHCP



module



is



used,



global



library



variable



SPI_Ethernet_userTimerSec is used to keep track of time. It is user responsi-



bility to increment this variable each second in it's code.
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Requires



Ethernet module has to be initialized. See SPI_Ethernet_Init. Available for PIC18 family MCUs only.



Example



... SPI_Ethernet_initDHCP(5); // get network configuration from DHCP server, wait 5 sec for the response ...
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SPI_Ethernet_doDHCPLeaseTime Prototype



unsigned char SPI_Ethernet_doDHCPLeaseTime();



Returns



- 0 - lease time has not expired yet. - 1 - lease time has expired, it's time to renew it.



This is DHCP module routine. It takes care of IP address lease time by decreDescription menting the global lease time library counter. When this time expires, it's time to contact DHCP server and renew the lease. Requires



Ethernet module has to be initialized. See SPI_Ethernet_Init. Available for PIC18 family MCUs only.



Example



while(1) { ... if(SPI_Ethernet_doDHCPLeaseTime()) ... // it's time to renew the IP address lease }



SPI_Ethernet_renewDHCP Prototype



unsigned char SPI_Ethernet_renewDHCP(unsigned char tmax);



Returns



- 1 - upon success (lease time was renewed). - 0 - otherwise (renewal request timed out). This is DHCP module routine. It sends IP address lease time renewal request to DHCP server.



Description



Parameters: - tmax: time in seconds to wait for an reply.



Requires



Ethernet module has to be initialized. See SPI_Ethernet_Init. Available for PIC18 family MCUs only.



Example



while(1) { ... if(SPI_Ethernet_doDHCPLeaseTime()) SPI_Ethernet_renewDHCP(5); // it's time to renew the IP address lease, with 5 secs for a reply ... }
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Libraries Library Example This code shows how to use the Ethernet mini library : - the board will reply to ARP & ICMP echo requests - the board will reply to UDP requests on any port :



returns the request in upper char with a header made of remote host IP & port number - the board will reply to HTTP requests on port 80, GET method with pathnames : / will return the HTML main page /s will return board status as text string /t0 ... /t7 will toggle RD0 to RD7 bit and return HTML main page all other requests return also HTML main page. // duplex config flags #define Spi_Ethernet_HALFDUPLEX #define Spi_Ethernet_FULLDUPLEX



0x00 0x01



// half duplex // full duplex



// mE ehternet NIC pinout sfr sbit SPI_Ethernet_Rst at RC0_bit; sfr sbit SPI_Ethernet_CS at RC1_bit; sfr sbit SPI_Ethernet_Rst_Direction at TRISC0_bit; sfr sbit SPI_Ethernet_CS_Direction at TRISC1_bit; // end ethernet NIC definitions /************************************************************ * ROM constant strings */ const unsigned char httpHeader[] = "HTTP/1.1 200 OKnContent-type: " ; // HTTP header const unsigned char httpMimeTypeHTML[] = "text/htmlnn" ; // HTML MIME type const unsigned char httpMimeTypeScript[] = "text/plainnn" ; // TEXT MIME type unsigned char httpMethod[] = "GET /"; /* * web page, splited into 2 parts : * when coming short of ROM, fragmented data is handled more efficiently by linker * * this HTML page calls the boards to get its status, and builds itself with javascript */ const char *indexPage = // Change the IP address of the page to be refreshed "<meta http-equiv="refresh" content="3;url=http://192.168.20.60">
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PIC + ENC28J60 Mini Web Server
 Reload <script src=/s> 		ADC
	AN2	<script>document.write(AN2)
	AN3	<script>document.write(AN3)

		PORTB

<script> var str,i; str=""; for(i=0;i var str,i; str=""; for(i=0;idocument.write(REQ) " ; /*********************************** * RAM variables */ unsigned char myMacAddr[6] = {0x00, 0x14, 0xA5, 0x76, 0x19, 0x3f}; // my MAC address unsigned char myIpAddr[4] = {192, 168, 20, 60}; // my IP address unsigned char getRequest[15]; // HTTP request buffer
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Libraries unsigned char unsigned long



dyna[30]; // buffer for dynamic response httpCounter = 0; // counter of HTTP requests



/******************************************* * functions */ /* * put the constant string pointed to by s to the ENC transmit buffer. */ /*unsigned int putConstString(const char *s) { unsigned int ctr = 0; while(*s) { Spi_Ethernet_putByte(*s++); ctr++; } return(ctr); }*/ /* * it will be much faster to use library Spi_Ethernet_putConstString routine * instead of putConstString routine above. However, the code will be a little * bit bigger. User should choose between size and speed and pick the implementation that * suites him best. If you choose to go with the putConstString definition above * the #define line below should be commented out. * */ #define putConstString SPI_Ethernet_putConstString /* * put the string pointed to by s to the ENC transmit buffer */ /*unsigned int putString(char *s) { unsigned int ctr = 0; while(*s) { Spi_Ethernet_putByte(*s++); ctr++; } return(ctr); }*/
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/* * it will be much faster to use library Spi_Ethernet_putString routine * instead of putString routine above. However, the code will be a little * bit bigger. User should choose between size and speed and pick the implementation that * suites him best. If you choose to go with the putString definition above * the #define line below should be commented out. * */ #define putString SPI_Ethernet_putString /* * this function is called by the library * the user accesses to the HTTP request by successive calls to Spi_Ethernet_getByte() * the user puts data in the transmit buffer by successive calls to Spi_Ethernet_putByte() * the function must return the length in bytes of the HTTP reply, or 0 if nothing to transmit * * if you don't need to reply to HTTP requests, * just define this function with a return(0) as single statement * */ unsigned int SPI_Ethernet_UserTCP(unsigned char *remoteHost, unsigned int remotePort, unsigned int localPort, unsigned int reqLength) { unsigned int len = 0; // my reply length unsigned int i; // general purpose integer if(localPort != 80) // I listen only to web request on port 80 { return(0); } // get 10 first bytes only of the request, the rest does not matter here for(i = 0; i < 10; i++) { getRequest[i] = SPI_Ethernet_getByte(); } getRequest[i] = 0; if(memcmp(getRequest, httpMethod, 5)) method is supported here {



// only GET
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Libraries return(0); } httpCounter++;



// one more request done



if(getRequest[5] == 's') // if request path name starts with s, store dynamic data in transmit buffer { // the text string replied by this request can be interpreted as javascript statements // by browsers len = putConstString(httpHeader); // HTTP header len += putConstString(httpMimeTypeScript); // with text MIME type // add AN2 value to reply IntToStr(ADC_Read(2), dyna); len += putConstString("var AN2="); len += putString(dyna); len += putConstString(";"); // add AN3 value to reply IntToStr(ADC_Read(3), dyna); len += putConstString("var AN3="); len += putString(dyna); len += putConstString(";"); // add PORTB value (buttons) to reply len += putConstString("var PORTB="); IntToStr(PORTB, dyna); len += putString(dyna); len += putConstString(";"); // add PORTD value (LEDs) to reply len += putConstString("var PORTD="); IntToStr(PORTD, dyna); len += putString(dyna); len += putConstString(";"); // add HTTP requests counter to reply IntToStr(httpCounter, dyna); len += putConstString("var REQ="); len += putString(dyna); len += putConstString(";"); } else if(getRequest[5] == 't') // if request path name starts with t, toggle PORTD (LED) bit number that comes after { unsigned char bitMask = 0; // for bit mask
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if(isdigit(getRequest[6])) // if 0 | // //



}
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The mikroC PRO for PIC provides the standard ANSI C Sprintf function for easy data formatting. Note: In addition to ANSI C standard, the Sprint Library also includes two limited versions of the sprintf function (sprinti and sprintl). These functions take less ROM and RAM and may be



more convenient for use in some cases.



Functions - sprintf - sprintl - sprinti



sprintf Prototype



sprintf(char *wh, const char *f,...);



Returns



The function returns the number of characters actually written to destination string. sprintf is used to format data and print them into destination string.



Parameters: - wh: destination string - f: format string The f argument is a format string and may be composed of characters, escape sequences, and format specifications. Ordinary characters and escape sequences are copied to the destination string in the order in which they are interpreted. Format specifications always begin with a percent sign (%) and require Description additional arguments to be included in the function call. The format string is read from left to right. The first format specification encountered refers to the first argument after f and then converts and outputs it using the format specification. The second format specification accesses the second argument after f, and so on. If there are more arguments than format specifications, then these extra arguments are ignored. Results are unpredictable if there are not enough arguments for the format specifications. The format specifications have the following format: % [flags] [width] [.precision]
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[{ l | L }]



conversion_type
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Each field in the format specification can be a single character or a number which specifies a particular format option. The conversion_type field is where a single character specifies that the argument is interpreted as a character, string, number, or pointer, as shown in the following table: conversion_type Argument Type



Description



Output Format



d



int



Signed decimal number



u



unsigned int



Unsigned decimal number



o



unsigned int



Unsigned octal number



x



unsigned int



X



unsigned int



f



double



e



double



Floating-point number using the format []d.dddde[-]dd



E



double



Floating-point number using the format []d.ddddE[-]dd



g



double



Floating-point number using either e or f format, whichever is more compact for the specified value and precision



c



int



int is converted to an unsigned char, and the resulting character is written



s



char *



String with a terminating null character



p



void *



Pointer value, the X format is used



%







A % is written. No argument is converted. The complete conversion specification shall be %%.



Unsigned hexadecimal number using 0123456789abcdef Unsigned hexadecimal number using 0123456789ABCEDF Floating-point number using the format []dddd.dddd
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The flags field is where a single character is used to justify the output and to print +/- signs and blanks, decimal points, and octal and hexadecimal prefixes, as shown in the following table. flags Meaning + Left justify the output in the specified field width. Prefix the output value with + or - sign if the output is a signed type. space Prefix the output value with a blank if it is a signed positive value. (' ') Otherwise, no blank is prefixed. Prefix a non-zero output value with 0, 0x, or 0X when used with o, x, and X field types, respectively. When used with the e, E, f, g, and G # field types, the # flag forces the output value to include a decimal point. In any other case the # flag is ignored. * Ignore format specifier. The width field is a non-negative number that specifies a minimum number of printed characters. If a number of characters in the output value is less than width, blanks are added on the left or right (when the - flag is specified) in order to pad to the minimum width. If the width is prefixed with 0, then zeros are padded instead of blanks. The width field never truncates a field. If the length of the output value exceeds the specified width, all characters are output. Description The precision field is a non-negative number that specifies the number of characters to print, number of significant digits, or number of decimal places. The precision field can cause truncation or rounding of the output value in the case of a floating-point number as specified in the following table. flags



d, u, o, x, X



f e, E g c, C s
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MeaningMeaning of the precision field The precision field is where you specify the minimum number of digits that will be included in the output value. Digits are not truncated if the number of digits in an argument exceeds that defined in the precision field. If the number of digits in the argument is less than the precision field, the output value is padded on the left with zeros. The precision field is where you specify the number of digits to the right of the decimal point. The last digit is rounded. The precision field is where you specify the number of digits to the right of the decimal point. The last digit is rounded. The precision field is where you specify the maximum number of significant digits in the output value. The precision field has no effect on these field types. The precision field is where you specify the maximum number of characters in the output value. Excess characters are not output.
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The optional characters l or L may immediately precede conversion_type to respectively specify long versions of the integer types d, i, u, o, x, and X. Description You must ensure that the argument type matches that of the format specification. You can use type casts to ensure that the proper type is passed to sprintf.



sprintl Prototype



sprintl(char



Returns



The function returns the number of characters actually written to destination string.



*wh, const char *f,...);



Description The same as sprintf, except it doesn't support float-type numbers.



sprinti Prototype



sprinti(char



Returns



The function returns the number of characters actually written to destination string.



Description



The same as sprintf, except it doesn't support long integers and float-type numbers.



*wh, const char *f,...);
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This is a demonstration of the standard C library sprintf routine usage. Three different representations of the same floating poing number obtained by using the sprintf routine are sent via UART. double ww = -1.2587538e+1; char buffer[15]; // Function for sending string to UART void UartWriteText(char *txt) { while(*txt) UART1_Write(*txt++); } // Function for sending const string to UART void UartWriteConstText(const char *txt) { while(*txt) UART1_Write(*txt++); } void main(){ UART1_Init(4800); Delay_ms(10);



// Initialize UART module at 4800 bps



UartWriteConstText("Floating Write message on UART



point



number



representation");



//



sprintf(buffer, "%12e", ww); // Format ww and store it to buffer UartWriteConstText("\r\ne format:"); // Write message on UART UartWriteText(buffer); // Write buffer on UART sprintf(buffer, "%12f", ww); // Format ww and store it to buffer UartWriteConstText("\r\nf format:"); // Write message on UART UartWriteText(buffer); // Write buffer on UART sprintf(buffer, "%12g", ww); // Format ww and store it to buffer UartWriteConstText("\r\ng format:"); // Write message on UART UartWriteText(buffer); // Write buffer on UART }
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TIME LIBRARY The Time Library contains functions and type definitions for time calculations in the UNIX time format which counts the number of seconds since the "epoch". This is very convenient for programs that work with time intervals: the difference between two UNIX time values is a real-time difference measured in seconds. What is the epoch? Originally it was defined as the beginning of 1970 GMT. ( January 1, 1970 Julian day ) GMT, Greenwich Mean Time, is a traditional term for the time zone in England. The TimeStruct type is a structure type suitable for time and date storage. Type declaration is contained in timelib.h which can be found in the mikroC PRO for PIC Time Library Demo example folder.



Library Routines - Time_dateToEpoch - Time_epochToDate - Time_dateDiff
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Libraries Time_dateToEpoch Prototype



long Time_dateToEpoch(TimeStruct *ts);



Returns



Number of seconds since January 1, 1970 0h00mn00s. This function returns the unix time : number of seconds since January 1, 1970 0h00mn00s.



Description



Parameters: - ts: time and date value for calculating unix time.



Requires



Nothing.



Example



#include "timelib.h" ... TimeStruct ts1; long epoch; ... /* * what is the epoch of the date in ts ? */ epoch = Time_dateToEpoch(&ts1);



Time_epochToDate Prototype



void Time_epochToDate(long e, TimeStruct *ts);



Returns



Nothing. Converts the unix time to time and date.



Description



Parameters: - e: unix time (seconds since unix epoch) - ts: time and date structure for storing conversion output
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Requires



Nothing.



Example



#include "timelib.h" ... TimeStruct ts2; long epoch; ... /* * what date is epoch 1234567890 ? */ epoch = 1234567890; Time_epochToDate(epoch, &ts2);
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Time_dateDiff Prototype



long Time_dateDiff(TimeStruct *t1, TimeStruct *t2);



Returns



Time difference in seconds as a signed long. This function compares two dates and returns time difference in seconds as a signed long. Result is positive if t1 is before t2, result is null if t1 is the same as t2 and result is negative if t1 is after t2. Parameters:



Description - t1: time and date structure (the first comparison parameter) - t2: time and date structure (the second comparison parameter) Note: This function is implemented as macro in the timelib.h header file which can be found in the mikroC PRO for PIC Time Library Demo example folder. Requires



Nothing.



Example



#include "timelib.h" ... TimeStruct ts1, ts2; long diff; ... /* * how many seconds between these two dates contained in ts1 and ts2 buffers? */ diff = Time_dateDiff(&ts1, &ts2);
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"timelib.h"



TimeStruct ts1, ts2; long epoch; long diff; void main() { ts1.ss = 0; ts1.mn = 7; ts1.hh = 17; ts1.md = 23; ts1.mo = 5; ts1.yy = 2006; /* * What is the epoch of the date in ts ? */ epoch = Time_dateToEpoch(&ts1);



/* * What date is epoch 1234567890 ? */ epoch = 1234567890; Time_epochToDate(epoch, &ts2); /* * How much seconds between this two dates ? */ diff = Time_dateDiff(&ts1, &ts2); }
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TRIGONOMETRY LIBRARY The mikroC PRO for PIC implements fundamental trigonometry functions. These functions are implemented as look-up tables. Trigonometry functions are implemented in integer format in order to save memory.



Library Routines - sinE3 - cosE3



sinE3 Prototype



int sinE3(unsigned angle_deg);



Returns



The function returns the sine of input parameter. The function calculates sine multiplied by 1000 and rounded to the nearest integer: result := round(sin(angle_deg)*1000)



Description Parameters: - angle_deg: input angle in degrees Note: Return value range: -1000..1000. Requires



Nothing.



Example



int res; ... res = sinE3(45);



// result is 707
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int cosE3(unsigned angle_deg);



Returns



The function returns the cosine of input parameter. The function calculates cosine multiplied by 1000 and rounded to the nearest integer: result := round(cos(angle_deg)*1000)



Description



Parameters: - angle_deg: input angle in degrees Note: Return value range: -1000..1000.



606



Requires



Nothing.



Example



int res; ... res = cosE3(196);



// result is -193
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owners manual for the thesis - Pro Design 

Jan 26, 2005 - For flying more comfortably we recommend the use of a harness out of ... If you still have any questions when reading this manual, call us, we'll be pleased to help you. We wish ... summer it can get very cold at high altitudes).










 


[image: alt]





mikroC Users Manual - SITE WEB UPS Thierry Perisse 

The PDF-edition of the ... Projects. 22. Source Files. 24. Search Paths. 24. Managing Source Files. 25 ..... Consult the Error Messages for more information about errors recognized by the ... If there is a new user code to be downloaded, the ... mikr










 


[image: alt]





User Manual for Android 

plus en haut du smartphone ou de la tablette, et la main droite celle la plus en bas. • Dans le cas .... Vous pouvez régler la vitesse de balayage de l'ECG dans le.
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